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Chapter One: 
 

Welcome to Microsoft Expression Media 
 

Microsoft® Expression® Media is the fast and easy way to view, organize, and present the 

growing number of images, movies, sounds, fonts, and other media files that reside on your 

various disks. Whether you are a student, journalist, multimedia enthusiast, or creative 

professional, it is important to be able to organize and browse your images, movies, documents. 

Then you can modify and professionally present them in nearly any multimedia or document 

format that you want. 

System requirements 
This section lists the minimum system requirements for Expression Media (with the 

recommended ones in parentheses). It is important to have the most recent version of Apple® 

QuickTime®. This will improve the performance and functionality of Expression Media. 

 

Microsoft Windows 

 Intel® Pentium® III 500 MHz processor or equivalent (Intel Pentium 4) 

 1 GB of RAM 

 1024 x 768 display with 24-bit color 

 100 MB of hard disk space for installation  

 Microsoft® Windows® XP (XP SP2) or Windows Vista™ 

 Apple QuickTime 7.1.5 or higher 

 Microsoft® Internet Explorer® 5.5 (6.0) and higher  

 DirectX 9.0c  

 Adobe® Reader® 7.0 or higher for PDF file support 

Apple Macintosh 

 Expression Media supports Intel®-based Macintosh  

PowerPC® or Intel Core Processor 

 DVD-ROM drive 

 Apple® Macintosh® OS X (10.4.8 or later) 

 Apple QuickTime 7.1.5 or later 

 Monitor set to Millions of Colors 

 100 MB of hard disk space for installation 

 512 MB of RAM or more 
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Installing Expression Media 
There are slightly different methods for installation, depending on the operating system you are 

using. After installation, you will need to type in the product key. 

 
To install Expression Media on Windows 

1. Insert the Expression Media CD or DVD.  

2. Click Install Expression Media, and then follow the instructions. 

Note: If this menu does not appear, your PC might not support AutoPlay. In this case, 

open the CD or DVD and run Media.xx.exe, where xx is the country code.  

To install Expression Media on the Macintosh 

1. Insert Expression Media. 

2. Double-click the Install Expression Media icon, and then follow the instructions.  

To change languages on the Macintosh  

1. Open the application. 

2. Click the Expression Media icon. 

3. On the File menu, click Welcome Screen.  

4. Expand the Languages menu. On installation, Expression Media defaults to the operating 

system language. To run in a different language, clear all languages except the one you 

want to use.  

To change languages in Windows 

When you install Expression Media, you select a language. To change languages, reinstall 

Expression Media, and then select an alternate language from the menu. 

 
To enter the license key 

1. After you have installed Expression Media, start the application.  

2. On the Help menu, click Welcome Screen.  

3. On the Edit menu (Macintosh: Application menu), click Preferences.  

4. Type your product key from the back cover of the package.  

Installing plug-ins 

The installation creates a Plug-ins folder that contains files that are important to the application’s 

functionality. Knowing the location of this folder is important so that you can customize or 

install additional functionality, such as HTML themes, print templates, importers, and scripts. 

Location of the Plug-ins folder on Windows 

The user-defined Plug-ins folder is located in one of two locations: 

 C:\Documents and Settings\username\Application Data\Expression Media\Plug-ins (XP) 

 C:\Documents and Settings\username\Application Data\Roaming\Expression 

Media\Plug-ins (Windows Vista) 
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Note: On some Windows operating systems, the Application Data folder might be hidden. If so, 

consult your operating system Help for assistance in showing hidden folders. 

Location of the Plug-ins folder in Macintosh  

On the Macintosh, there is a folder that is split between built-in plug-ins, which are located 

inside the application package, and user-installed plug-ins, which can be in any of the following 

three locations: 

 ~/Library/Application Support/Expression Media/Plug-ins 

 ~/Network/Library/Application Support/Expression Media/Plug-ins 

Language support 

By default, Expression Media uses the language of the operating system or remembers the last 

language used. For information about how to change the language used by Expression Media, 

see ―Installing Expression Media‖ on page 2. 

Web resources 

You can access additional resources for learning Expression Media on the Expression Web site. 

Tutorials, customer support, forums, and application updates are available online. Go to the Web 

site at http://go.microsoft.com/fwlink/?LinkID=82546 

Adding media importers  
Expression Media can use any QuickTime-based media importer. Download and install the 

importer. You can download additional importers from third-party sources on the Web.  

Scripting  

Expression Media is scriptable and can be easily integrated with third-party applications to 

perform workflow automation.  

Scripting on Windows  

Expression Media supports Visual Basic® Script and JavaScript automation. Once you create 

scripts, you can attach them to the application for access through the Scripts menu. For 

instructions about creating scripts with Expression Media (at the Expression Media AppleScript 

dictionary from within Script Editor), refer to the Expression Media Web site. 

Scripting on the Macintosh 

Expression Media supports AppleScript®, and the scripts are attachable to the application 

(accessible from the AppleScript menu). To get started with scripting in Expression Media, visit 

the Expression Media Web site, and then refer to the AppleScript examples. 
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Chapter Two: 
 

Microsoft Expression Media Basics 
 

 

Before you get started with Expression Media, there are some basic concepts that you need to 

know about how Expression Media imports, lists, and categorizes files. This chapter reviews the 

tasks necessary to create and work with your first catalog. 

 

 

 
Microsoft Expression Media interface 

 

 

 
Access most of the major functions of Expression Media by clicking buttons on the toolbar  

 

How Expression Media works 

Microsoft Expression Media stores information about media files in catalogs. A catalog is a 

visual database that you can organize and search. A catalog contains information about each file 
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that is relevant to the media type (attributes). 

Tags (also called annotations or metadata) that help you organize and classify media are: 

 A thumbnail of each media file. 

 A full screen preview of each media file (if this option is selected). 

 The location (path) of the original file on a hard drive, CD, or other kind of volume. 

You can create as many catalogs as you want, depending on how you want to organize your 

media files. For example, your photos, videos, and music could each have their own catalog file. 

Or, you could create one catalog containing all your media. Each catalog can contain up to 

128,000 files with a 1.8 GB limit. 

 

Once you have created a catalog, you can store your images with digital camera information, 

captions, labels, and annotations, and then search and browse the catalog, even if your original 

files are misplaced or offline.  

 

Also within Expression Media, you can edit all of your media files, including renaming, image 

editing, managing color profiles, printing contact sheets, changing file formats, and creating slide 

shows. 

Working with catalogs 

The first time you launch Expression Media, you’ll see a Welcome Screen. This dialog box helps 

you get acquainted with the Expression Media features, and assists you with import options for 

creating new catalogs. If you have an idea of how you want to organize your catalogs, you can 

let Expression Media create your catalog for you when you select one of options in the dialog 

box. For more information about these import options, see ―Filtering imports by media type‖ on 

page 8.  

 

If you want to learn more about cataloging and the options that you have before you, create a 

catalog, close the dialog box and see ―Creating catalogs and importing media‖ on page 8 for 

more information about understanding and creating catalogs. If you want to access this dialog 

box later, you can find it in the Welcome Screen menu on Windows, and in the Expression 

Media application menu on the Macintosh.  

Understanding catalogs 

When you add files to a catalog, Expression Media stores a thumbnail version of each file, as 

well as information about the file, including its location on your disk or on the removable storage 

disk from which you might have imported the file. When you are working with your cataloged 

media, remember the following: 

 You can search and organize Expression Media catalogs, even when your original files 

are not present. For example, your original files might be stored on a CD that is not on 

the computer. However, in the catalog, you can still view the thumbnails and 

information pertaining to those files. 

 Because the original files are not embedded in the catalog, Expression Media cannot 

display them in larger sizes. You need access to the original files.  
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 If you delete a media file on the desktop or a disk, it cannot be recovered through an 

Expression Media catalog. A catalog contains only information about the file, and not 

the file itself. 

 Adding files to an Expression Media catalog does not move or modify the original 

media. 

Cataloging strategies 

A common question in digital asset management is: ―Should I put all of my media into one big 

catalog or into several smaller catalogs?‖ The number of catalogs that you create varies, 

depending on your workflow and the types of media you are tracking in catalogs. Anything that 

is logical and fits well into your specific workflow needs is acceptable. Expression Media 

catalogs are designed to contain up to 128,000 media items with a limit of 1.8-GB limit. 
 

It is possible that a single catalog will be sufficient for your needs. However, grouping files into 

a few separate catalogs creates a higher level of organization and search capabilities.  

 

Here are some ways to organize your catalogs: 

 

Organize by project  Dedicate a catalog to each of your projects or clients for easy and quick 

reference. This is also is a good method for supporting short-term deadlines and goals. 

 

Organize by chronology  Create an additional set of catalogs based on the date and time. It is a 

good monthly habit. It will help you build a searchable archive as you go. Expression Media 

features a way to import one catalog into another, so, for example, you can create a single 

catalog for July and subsequently import all of the separate catalogs from all your July projects 

into that single catalog. 

 

Organize by subject  Any logical subjects that are not likely to overlap are a good way to divide 

your media into multiple catalogs. For example, you can store your images by high-level subjects 

that describe the types of your photo assignments, such as travel, fashion, portraits, and so on. 

 

Organize by process/task  At times, there are clearly definable states for files in a workflow. 

Separating items by their state or task in your workflow can help direct users to the media item at 

the correct stage in the workflow. For example, if photographers want to track files through a 

raw workflow, they might create one catalog each for the original raw files, client selections, 

processed .tif files, and edited images. 

 

Organize by file type  You might want to group files into catalogs based on file type, such as 

music, movies, fonts, illustrations, or a .pdf file. For example, you might want to create a catalog 

of all your fonts, creating a searchable inventory of typefaces available for your design projects. 

 

Organize by search  Expression Media has special search criteria that enables searching across 

all catalogs in a particular folder. Therefore, if you store your entire job catalogs in a defined 

folder, files will be easy to locate. Higher-level chronological catalogs will also be good for 

locating media files. 
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Before creating catalogs and importing media 
There are a few options that you might want to set before creating a catalog. These options help 

you save time and improve the quality and accuracy of your imports. 

Define thumbnail creation and media preview options 

Expression Media assigns a thumbnail image to each imported media item and then stores this 

image in the catalog file. You can choose how large this thumbnail will be. Depending on your 

preferences and the media type, Expression Media assigns each media item. 

 

 The embedded thumbnail image created by a digital camera or software program 
These thumbnails are typically low quality.  

 A thumbnail created by Expression Media  Use this option for the highest quality 

thumbnails. 

 A generic media icon  Some non-image files, such as audio files, have a generic media 

icon assigned to them as a thumbnail image. 

 

You can also define media preview options. These previews are large .jpg proxy images that will 

be displayed in Media View, Slide Show, and Light Table, regardless of whether original media 

files are available for display. Media previews are particularly useful if the majority of your 

media is stored in offline storage, such as on a CD or DVD. These previews are also useful for 

distributing catalogs without including the original media files.  

 
To define thumbnail creation options 

1. Start Expression Media. 

2. On the Edit menu, click Thumbnails and Previews. 

3. Do one of the following: 

 If you want Expression Media to build a thumbnail image, select a size from the 

Thumbnail Size menu. If you select Variable size, Expression Media creates 

thumbnail images matching the thumbnail size defined in the Thumbnail View of the 

active catalog. 

 If you want Expression Media to use the embedded thumbnail images created by your 

digital camera or your digital imaging program, select Use built-in thumbnails. 

4. Select a Quality setting. 

 
To define media preview options 

1. On the Edit menu, click Thumbnails and Previews. 

2. Select Create full screen previews.  

3. Select a size. 

4. Select the .jpg compression quality to be applied to the preview images, and then  

click OK. 

Note: Catalogs with full screen previews will be considerably larger than catalogs with 

only thumbnails.  
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Filtering imports by media type 

8 control which media files are added to a catalog. Most import options are conditional to the 

type of import (From Folders, Camera, and so on) and you can select those options when you 

initially import files. However, there is a global option to limit importing just those files that 

belong to a certain media type.  

 
To define a media type filter 

1. Start Expression Media. 

2. On the File menu, click Catalog Importers.  

3. Select the box for each media group that you want to allow Expression Media to import 

or ignore in future catalogs. For example, when using Importing from Files/Folders, 

you might select only the Images option to import images such as .jpgs, .tifs, and so on, 

and skip all other files in the same folder. If you are not familiar with which types of 

media files belong to each group, you can select the box for a particular media group to 

see a comprehensive list of all supported media types.  

Supported file formats 

Expression Media can organize more than 100 media file formats. The capacity to import certain 

file types is dependent on having the most current version of Apple QuickTime installed on your 

computer. You can download QuickTime for no cost at the Apple Web site. 

 

There are variations of file format support between the Windows and Macintosh platforms. For a 

complete list of supported formats, see ―Appendix B: Supported File Formats.‖ 

Creating catalogs and importing media 
There are several ways to import or add media files to an Expression Media catalog, each one 

tailored for a particular circumstance. The basic method is to create a catalog from any file or 

folder that you can access from your computer, including networked folders and removable 

media. However, you can import by dragging and dropping files, as well as using other methods. 

Importing items from files and folders  

This method is the most direct way to import entire folders or drives into catalogs.  

 
To create a catalog from files or folders 

1. Start Expression Media. 

2. Do one of the following and navigate to the files you want to import: 

 On the File menu, point to Import Items, and then click From Files/Folders. 

 On the Help menu, point to Welcome Screen, and then click Import from a folder 

you choose.  

3.  If you want to limit the files that you import, refine the Import criteria.  

4. In the File name box, type a file name.  

5. Select Size or Modified to select options that limit the import according to your chosen 

criteria. Selecting the Flat folder search option will constrain folder imports to only the 
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folder level selected and ignore all subfolders (Macintosh).  

6. While your media is being imported, Expression Media will temporarily display a 

progress indicator panel. To stop an import, click the Cancel icon next to the progress 

bar. To hide or show the progress indicator panel, click the Show/Hide Progress icon , 

which is located in the lower-right corner of the catalog window. 

7. Save the catalog. Project catalogs are named chronologically to maintain proper order on 

the desktop. They are stored in a single folder for cross-catalog searches. 

Importing Items by dragging and dropping 

You can drag any file, folder, hard disk, CD, or other volume onto an open Expression Media 

catalog. You can also drop files onto the Expression Media icon or shortcut icon. And you can 

use the drag-and-drop operation on a folder that contains some files already cataloged and a few 

new files. Expression Media ignores the files already in the catalog and adds only the new files 

to the catalog.  

Importing items from pictures/movies folders 

Expression Media automatically finds the Pictures and Movies folders for the active operating 

system user and imports all media into a new catalog. This importing feature works only on the 

operating systems Macintosh OS X, Windows XP, and Windows Vista. 

 
To import items from the pictures/movies folders 

1. On the Help menu, click Welcome Screen. 

2. Select Import Pictures/Movies Folders, and then click Continue.  

Note: Expression Media ignores media in folders dedicated to certain applications, such as 

Apple® iPhoto®. 

Importing items from Spotlight Query (Macintosh) 

Expression Media can import items from your computer using Apple® Spotlight®. When you 

search by using Spotlight, you’re accessing a comprehensive, constantly updated index that sees 

all of the metadata inside supported files on your hard drive, including the kind of content, the 

author, edit history, format, size, and much more.  

 

Most documents, including Microsoft Word documents, Adobe PDF documents, MP3 audio files 

and digital camera images already contain rich metadata. And because Spotlight indexes contents 

of the file as well, your search results include what appears inside a file or document, not just its 

title. 

 
To import items from a Spotlight Query 

1. From Spotlight Query, choose Import Items.  

2. Type a word or phrase to search for, and Expression Media will import all related media 

files.  

3. You can also type a Spotlight Query, using a special Spotlight syntax, to specify complex 

search criteria. 

4. By default, Spotlight imports are appended to the open catalog.  
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5. To place all imported items in a new catalog, select Add results in new catalog. 

Importing items from contextual menus 

You can add items to an Expression Media catalog by selecting an item stored anywhere on your 

computer.  

 
To import items by using contextual menus 

1. Locate an item on your desktop or anywhere on your hard drive and then right-click 

(Windows) or CTRL-click (Macintosh). 

2. Click Expression Media Import from the contextual menu. Items will be added to the 

open catalog or a new catalog, if one is not currently open. 

 

Importing items from Apple iPhoto (Macintosh) 
 

You can transfer all of your files from Apple® iPhoto® to a catalog in Expression Media. The 

new catalog will initially contain references to the photography files that are still inside the 

iPhoto library folders, but you can move those files from iPhoto. The new Expression Media 

catalog also contains your iPhoto albums as Expression Media catalog sets (for more 

information about catalog sets, see ―Catalog sets‖ on page 66). In addition, your catalog includes 

any metadata (such as EXIF digital camera data, comments, or keywords) that were assigned to 

your images in iPhoto. The following table shows how iPhoto annotations map to Expression 

Media annotation fields. 

 

iPhoto* Expression Media 

File name File name 

Title Title 

Keyword Keyword 

Checkmark (keyword) Does not map at this time 

Star ratings* Do not map at this time 

Albums Catalog sets 

Smart Albums* Catalog sets  

Comments  Description (Caption) 

Date Event Date 

Date (modified in iPhoto) Event Date 

 

* Apple iPhoto 4.0, 5.0 

 

To import items from iPhoto 

1. On the Help menu, click Welcome Screen. 

2. Click Import iPhoto Library.  

Expression Media automatically finds the iPhoto library for the active operating system 

user. 

3.  Launch iPhoto in the background and import all original photos into a new catalog.  

Note: This feature only works with iPhoto versions 2.0, 4.0, 5.0, and 6.0. 

4. If you want to move the newly imported files out of the iPhoto library, select all of the 
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images in the new catalog, and then, on the Action menu, click Transfer to Folder.  

5. In the Transfer to Folder dialog box, select Move files, reset paths, delete originals.  

This moves your original images to a folder of your choice, sets the paths to the new 

location, and deletes the images from the iPhoto library.  

6. To free up additional hard-drive space, you can delete all the thumbnails created by 

iPhoto. To do this, delete the iPhoto Library folder from the Pictures folder.  

Make sure you do this after you have transferred all original images to a new location on 

your hard drive. Alternately, you could leave the original images where they are and have 

media in both iPhoto and Expression Media.  

Importing from a catalog file (merging catalogs) 

Expression Media can combine the contents of one catalog with the contents of another. You can 

do this by either using a menu command, or by using a drag-and-drop operation. If an item’s 

thumbnail in an older catalog is smaller than the catalog being appended, then you will need to 

rebuild the thumbnail to match the new size.  
 

To merge catalogs 

1. Open an existing catalog. 

2. On the File menu, point to Import Items, and then click From Catalog File. 

3. Navigate to and select a catalog created by an Expression product.  

Note: This function will not work with catalogs created by other programs. 

4. New media items will be appended to the end of the existing catalog. Also added are each 

item’s related annotations, label, and thumbnail. Catalog Sets are merged into the open 

catalog. 

Note: If the open catalog already contains files that are part of the selection of files that are 

being merged, Expression Media will ignore these files and will not replicate them. 

 
To merge catalogs using drag and drop 

1. Open at least two catalogs. 

2. Select one or more items in one catalog, and then drag them to the other catalog. If you 

are in List View or Thumbnail View, Expression Media appends the dragged files at the 

location you place the cursor. If you are in Media View, Expression Media appends the 

dragged files to the end of the current catalog. 

3. Using this method does not remove a file from a catalog and add it to another. This 

function only copies the item and its related information. If you want to move the file 

from one catalog to another, hold down the CTRL key (Windows) or the  key 

(Macintosh) while dragging.  

Note: If the open catalog already contains files that are part of the selection of files that 

you are dragging, Expression Media will ignore these files and will not replicate them. 

 

To match thumbnail sizes in appended catalogs 

1. After merging the catalogs, select the appended files. 
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2. On the Action menu, click Rebuild Item. 

Importing from a digital camera (Windows) 

Depending on the USB transfer settings of your camera, there are two ways to import images 

from digital cameras. Some digital cameras support a standard called Picture Transfer Protocol 

(PTP). Refer to your digital camera’s documentation to find out if it supports PTP and how to 

properly define PTP settings for the camera.  

 
To import images using Picture Transfer Protocol 

1. Plug your camera into your computer.  

2. When the dialog box for your camera appears, click the Cancel button.   

3. Launch Expression Media and open an existing catalog, or create a new one. On the File 

menu, point to Import Items, and then click From Disk/Camera.  

4. On the Source menu, select the camera or media card from which you want to import 

media.  

5. Click the Destination folder icon. In the dialog box, select or create a folder to place files 

that are downloaded from your camera. 

6. Select an option according to the following descriptions. 

 

 Place in  The option Download folder places downloaded files in the destination 

folder. Today’s folder places downloaded files in a folder named with today’s date in 

the destination folder. Original folder hierarchy places downloaded files in a copy 

of the folder directory hierarchy on the camera. 

 Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media will rename all downloaded files with sequential numbers following this 

string. Leave this field blank to maintain the existing file names.   

 Actions  Select the option Skip files with same name to prevent you from writing 

over existing files with the same name. Set file creation date to capture date sets 

the image file’s creation date to match the date when you took the picture (Capture 

Date). This option is useful because some applications, as well as the operating 

system, cannot read the capture date. This way, your media will be better organized 

on the desktop. Delete originals after downloading deletes original files off of your 

camera’s media card after they have been downloaded to the destination folder.   

 Annotate  Choose a metadata template from this menu to apply a group of pre-

defined annotations to all downloaded files. If there are no templates available, you 

can create one by selecting New Metadata Template. Clicking the text button next 

to the menu displays the template content and some additional options for applying 

metadata. 

7. Click the Download button. Expression Media will import each image into the open 

catalog after it has been downloaded from the camera to the destination folder you 

defined. After the import is complete, dismount the camera from the desktop (eject), and 

then you can safely unplug your camera. 
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To import without Picture Transfer Protocol  

These procedures also apply to digital media card readers that do not support PTP.  

1. Plug your camera into your computer, or insert your digital media card (Compact Flash 

card, Memory Stick) into your card reader. 

2. When the Device Action dialog box appears, choose Copy pictures to a folder on My 

Computer using Microsoft Scanner and Camera Wizard.  

3. Follow the directions of the Camera Wizard to locate an existing folder or to create a new 

folder for your pictures. On the last screen of the wizard, select Nothing. I’m finished 

working with these pictures. 

4. Start Expression Media and open an existing catalog, or create a new catalog, into which 

you can import the new images. On the File menu, point to Import Items, and then click 

From Files/Folders. Navigate to and select the folder on your desktop where your 

images were placed with the Camera Wizard.  

5. Click Import. 

Importing from a digital camera (Macintosh) 

The OS X Image Capture application lets Macintosh users automatically download images when 

a camera is attached to the computer. Expression Media has integrated this functionality to make 

cataloging images during download from your camera as easy as possible. 

 
To import from a digital camera on the Macintosh 

1. Start the Image Capture application.  

The application is located in the OS X Applications folder.  

2. Set Image Capture preferences according to your operating system version.  

3. If you are running OS X, open the Image Capture Preferences command. On the 

Camera Preferences menu, select Other. Navigate to and choose Expression Media. 

Quit the Image Capture application.  

4. Plug your camera into your computer. From this point, whenever you plug a camera into 

your computer, Image Capture launches Expression Media.  

5. On the File menu, point to Import Items, and then click From Disk/Camera.  

6. Choose a source from the Source menu, and then select the camera or media card from 

which you want to import media.  

7. Click the Destination folder icon. In the dialog box, select or create a folder to place in 

files that are downloaded from your camera. 

8. Set the options according to the following descriptions: 

 Place in  The Download folder places downloaded files in the destination folder. 

Today’s folder will place downloaded files in a folder named with today’s date in the 

destination folder.   

 Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. 
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Leave this field blank to maintain the existing file names.  

 Actions  The option Skip files with same name prevents you from writing over 

existing files with the same name. The option Lock downloaded files turns on the 

desktop’s lock status for all downloaded files. The option Set file creation date to 

capture date sets the image file’s creation date to match the date you took the picture 

(Capture Date). This option is useful because some applications, as well as the 

operating system, cannot read the capture date. This way, your media is better 

organized on the desktop. Delete the originals after downloading deletes original files 

from your camera’s media card when they have been downloaded to the destination 

folder.   

 Annotate  Select a metadata template from this menu to apply a group of predefined 

annotations to all downloaded files. If there are no templates available, you can create 

one by selecting New Metadata Template. Clicking the text button next to the menu 

will display the template content and some additional options for applying metadata. 

For more information about creating templates, see ―Custom HTML galleries‖ on 

page 97. 

 Download  After you have set the options you want, click the Download button. 

Expression Media imports each image into the open catalog after it has been 

downloaded from the camera to the destination folder you defined. After import is 

complete, dismount the camera from the desktop (eject), and then you can safely 

unplug your camera. 

Importing from a CD or DVD 

Use this option to import files from removable storage.  

 
To import from CD or DVD 

1. Open an existing catalog or create a new one.  

2. On the File menu, point to Import Items, and then click From Disk/Camera.  

3. On the Source menu, select the disk from which you want to import media. 

4. Click the Destination folder icon. In the dialog box, select or create a folder for files that 

are downloaded from the disk. 

5. (Optional) To constrain an import to only image file formats, click the Media Importers 

button and select only the Images box. This will prevent non-image files from being 

imported into the catalog. Imports can be filtered by any of eight different media file type 

groups. 

6. Set the options according to the following descriptions. 

 Place in  The Download folder places downloaded files into the Destination folder. 

Today’s folder will place downloaded files in a folder named after today’s date in the 

destination folder. Original folder hierarchy places downloaded files in a copy of the 

folder directory hierarchy on the Web server in the destination folder. 

 Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. To 

maintain the existing file names, leave this field blank.  
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 Actions  The option Skip files with same name prevents you from writing over 

existing files with the same name. Lock downloaded files selects the desktop lock 

status for all downloaded files. Delete originals after downloading moves original 

files to the Recycle Bin (Trash) after they have been downloaded to the destination 

folder. This option will only work on rewritable storage media.  

 Annotate  Choose a metadata template from this menu to apply a group of pre-

defined annotations to all downloaded files. If there are no templates available, you 

can create one by selecting New Metadata Template. Clicking the text button next 

to the menu displays the template content and some additional options for applying 

metadata. 

 Download  Click the Download button, and Expression Media downloads all files 

from the disk and stores them in the destination you define.  

Importing from the Internet 

You can import any Internet image into your catalog by using one of two methods. You can 

import by entering a URL, or you can use the drag-and-drop operation. To import by entering a 

URL, you must know the exact location of the image file. For example, if there is a site home 

page that contains images that you want to download, just entering the home page URL of that 

site will not download those images. To locate and download specific images from a site, you 

need to know the exact folder where that image resides in the site file structure. 

 
To import a file from the Internet 

1. Open an existing catalog or create a new one. 

2. Do one of the following: 

 On the File menu, point to Import Items, and then click From URL. 

 Drag the image from the Internet to the Expression Media catalog. 

3. Click the Destination folder icon. In the dialog box, select or create a folder for files that 

are downloaded from the Internet. If you used the drag-and-drop operation, skip to Step 

5. 

4. Type a Web address in the text field at the top of the dialog box. It must be a completely 

formed URL, such as http://www.photo.com/img1.jpg 

5. If applicable, type a cURL command. cURL is a powerful syntax for transferring files 

online.  

Set the options according to the following instructions. 

 Place in  Selecting the Download folder places downloaded files in the destination 

folder. Today’s folder places downloaded files in a folder named after today’s date in 

the destination folder. Original folder hierarchy places downloaded files as copies of 

the folder directory hierarchy on the Web server into the destination folder. 

 Rename  Type a text string (such as the date or subject) in this field, and Expression 

Media renames all downloaded files with sequential numbers following this string. To 

maintain the existing file names, leave this field blank. 

 Actions  Skip files with same name prevents you from writing over existing files 

http://www.photo.com/img1.jpg
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with the same name. Lock downloaded files selects the lock status for all 

downloaded files.  

 Annotate  Choose a metadata template from this menu to apply a group of predefined 

annotations to all downloaded files. If there are no templates available, you can create 

one by selecting New Metadata Template. Clicking the text button next to the menu 

displays the template content and some additional options for applying metadata. 

 Click the Download button. In addition to downloading the Web image, Expression 

Media downloads all files from the Internet, and stores them in the destination you 

defined. Expression Media will also store the file’s Web address in the Source URL 

annotation field. 

Using folder watching 

Expression Media offers advanced folder watching to monitor all folders that contain cataloged 

media, either on a hard drive or a local network. When new media appears in a watched folder, it 

can be manually or automatically imported to the catalog. 

 

Folder watching is useful for a workflow in which: 

 Images are being scanned by batch and saved to a particular folder. 

 A ―folder action‖ is automatically downloading images from other computers or the 

Internet. 

 Several users are contributing images to a shared network folder. 

 

To import files using folder watching 

1. Click the Organize button. 

2. Select an option from the catalog Folder Watching menu .  

3. Expression Media alerts you when new images have been added to any folder by 

displaying a blue arrow on the folder icon. To import these new images directly to your 

catalog, choose Update Folder Now from the individual folder’s contextual menu. 

4. To enable automatic updating, choose Switch Auto-Update On on the contextual menu 

of the individual folder that you want to be updated automatically. When new images are 

added to that folder or any sub-folder, Expression Media automatically imports those 

images to your catalog. Expression Media adds the new images to the end of the catalog. 

Auto-update folders are colored green. To clear the auto-update feature, but maintain 

folder watching, select Switch Auto-Update Off. 

5. To turn off catalog-wide folder watching, choose Never from the catalog Folder 

Watching menu.  

Protecting your catalogs  

Once you have created a catalog, you might want to prevent others from viewing or accessing it. 

You do this by setting a password. When opening the catalog in the future, you will be asked to 

provide the password before you can view the catalog’s contents. Expression Media does not 

provide a way to recover catalog passwords. 
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Important: Expression Media catalogs do not use encryption for password protection. For 

optimal security, store private catalogs in a secure location, such as your personal documents 

folder. 

 
To set password protection for a catalog 

1. On the File menu, click Catalog Info. 

2. Click the Set Password button.  

This button is only available if you have saved your catalog. 

3. Type a password, and then save the catalog.  

4. To remove password protection, click the Set Password button and delete the password 

in the field. Save your catalog to remove password protection.  

Finding catalogs 

The Catalog Finder lets you quickly locate and preview all Expression catalogs on a storage 

volume (hard drive, CD, DVD, and so on).  

 
To find a catalog 

1. On the File menu, click Recent Catalogs, and then click Catalog Finder. 

2. Select a storage volume from the menu, and Expression Media will locate all catalogs on 

that volume.  

3. To refresh the search, click the Find button.  

4. To preview the found catalog, click a catalog name in the search results list.  

5. To open the catalog, click Open. 

Setting Expression Media preferences 

You can define additional setup and program options in the Preferences dialog box. The 

preferences are divided into several categories. You can access the preferences by clicking the 

Edit menu, and then pointing to Preferences. Setting some of these preferences requires that you 

have a working knowledge of the features that they control. Use the following indicated 

references to learn about and set the corresponding preferences. 

 

 General  These preferences define some of the global display and general behavior 

characteristics of the program. 



 18 

 
General preferences 

 

 Media Rendering  These preferences define how Expression Media processes and 

displays images within its views.  

 The Vocabulary Editor preferences define the terms you use to add annotations to your 

media files. For more information about annotations and about setting these preferences, 

see ―Metadata vocabularies‖ on page 43. 

 Labels and Colors  These preferences enable you to customize the colors and names of 

labels globally. Color labels provide a method of a visual identification and classification 

of media files in your catalogs. For more information about labels and setting these 

preferences, see ―Labeling your files‖ on page 56. 

 Helper Applications  These preferences define other applications outside of Expression 

Media that you can use to perform extensive edits on your catalog files. For more 

information about Helper applications and setting these preferences, see ―Helper 

applications‖ on page 116. 

To set general preferences 

1. On the Edit menu, point to Preferences, and then click General.  

2. Set the options according to the following descriptions. 

 At Startup  Choose whether you want to open a new catalog, open the last catalog 

you used, or do nothing every time you start the application. 

 Double-click  Choose how Expression Media interprets double-clicking a media item 

in a catalog. 
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 Options  Select how to display tool tips to sort media based on natural numerical 

order (1, 2, 3…), to show warning dialog boxes when batch processing or removing 

media, and to auto-save catalogs on a timed schedule. 

 Field Names  Define the field names to use for describing IPTC annotations. For 

more information about field names, see ―Configuring the Info panel list‖ on page 38. 

 Dimensions  Define which unit of measure that Expression Media uses. 

 Resolution  Set the default resolution. 

 Dates  Determine how the date displays in the views. If you choose Long, the date 

format will be Friday, April 16, 2006. If you choose Short, the format will read 

4/16/06. If you choose Abbreviated, the format will read Fri, Apr 16, 2006 

(Macintosh). 

 Inspector Key  Type a key that you can press to get more information about a media 

item or Organizer term when you have the cursor positioned over the item or term. 

 

To set media rendering preferences 

1. On the Edit menu, point to Preferences, and then click Media Rendering. 

2. Click the Images tab, and then set the options according to the following descriptions: 

For the Rendering option, choose the rendering method that Expression Media uses to 

process the images displayed in the views. Nearest Neighbor renders faster but produces 

a less precise preview image. Bilinear creates a medium-quality image. Bicubic renders 

slower than the other two methods, but creates a better quality image.   

 Color match  Enables color profile matching in all views. If an image has an embedded 

ICC color profile, Expression Media uses it to create thumbnails and display images. 

Otherwise, Expression Media uses default document profiles chosen in the system’s 

Control Panel.  

 Use alpha channel  Enables Expression Media to render thumbnails and media images 

using the alpha channel as a mask. Alpha channels are grayscale images that are 

embedded into a file and used to define the transparent and opaque portions of an image. 

In Adobe Photoshop, masks are stored in alpha channels. 

 Skip images with size greater than  Enables you to place a limit on the size of images 

(from 1 to 100 MB) that the application will display in Media View and Slide Show 

mode. If an image is larger than the defined value, then Expression Media will not render 

it. This option will accelerate importing large images when viewed in Media View. 

 Transparency  Selects the background color used for transparent spaces in various 

image file types, such as .gif and Adobe Photoshop. Click the color swatch to define a 

color. 

 Light Table Warnings  Adjusts the sensitivity of exposure warnings in the Light Table. 

Click the up or down arrows to adjust the under and over exposure values that trigger red 

and blue onscreen warnings. You should leave this at the default value until you are 

experienced in working with the Light Table. For more information about the Light Table 

and exposure warnings, see ―Light Table mode‖ on page 57 . 
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3. Click the Raw tab, and then set the options according to the following descriptions: 

 Rendering  Select Use embedded preview to use the preview image contained with 

most raw-image files. This image renders much faster than decoding the raw data. If 

you select this option, it will speed up import and media rendering of Raw files. On 

Windows and Macintosh platforms, Expression Media can decode and display Canon, 

Nikon, and Kodak Raw files. 

On the Macintosh, there are two rendering engines to select from when you have 

Expression Media set to decode and display Raw image data. You can select between 

the camera Manufacturer engine or the Apple engine. You must have Macintosh OS 

10.4.2 or greater to enable the Apple decoding engine. By selecting Manufacturer, 

you can decode and display Canon, Nikon, and Kodak Raw files. By selecting the 

Apple engine, you can decode and display Canon, Nikon, Minolta, Sony, Olympus, 

and Adobe .dng Raw files. In most cases, the Apple rendering engine is much faster 

at the decoding and displaying of Raw files.  

 

In the future, the Apple engine might support other Raw formats. For a list of 

supported cameras that create Raw files, visit the Macintosh OS X digital camera 

support page on the Apple Web site. For more information about the Expression 

Media support of Raw formats, see Appendix D. 

 Photo CD Size  Imports from Kodak Photo CDs, which contain images that have a 

variety of dimensions and file sizes. Smaller sizes will import much faster into 

Expression Media. 

 DCR Look Profile  Adjusts the color tone of Kodak DCR images when rendered by 

Expression Media. 

4. Click the Fonts tab and set the options according to the following descriptions: 

 Thumbnail View  Select an option from the Display drop-down menu. You can 

display thumbnails of fonts as either the font name or as two characters of sample text 

that you define. If you change this option after importing fonts into a catalog, you will 

need to select all thumbnails, and, on the Action menu, click Rebuild Item to have 

Expression Media recreate the font thumbnail with the new settings. Thumbnail View 

settings also apply to List View. 

 Media View  Type the size at which you want fonts to display, and select an option 

from the Display drop-down menu. You can display fonts as a standard character set, 

a full character set, or as sample text that you define. The Font Size option applies 

only to TrueType fonts. Expression Media displays bitmap fonts at the size defined 

by the font. These options also define how Expression Media displays fonts in Slide 

Shows. For more information about Slide Shows, see ―Slide show basics‖ on page 84. 

If you change the font display preference for Media View while your catalog is 

currently displaying Media View, you will have to switch to Thumbnail View and 

then go back to Media View in order for the new preferences to be displayed. 
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Chapter Three: 
 

Viewing files in catalogs 
 

 

 

The Microsoft Expression Media interface displays information in three different views: List, 

Thumbnail, and Media. To switch views, click the appropriate tab. 

 

 
View tabs in Expression Media 

 

All three views offer features that resemble the way you work with your files on the desktop. 

 

To find a file  Type the first letters of the file name. 

 

To change a file name  Click the name and type a new one. 

 

To use functions from the  menu  (Windows)  Right-click the thumbnail representative of the 

media item (Macintosh: CTRL+click), or anywhere inside the Expression Media window. 

 

To rearrange items  Drag the items to where you want them, and then drop them. You can drag 

single items or multiple selections. 

 

To copy or move items to another catalog  Drag the items from one catalog to the other. 

 

To move the original files  Drag the relevant catalog items to a folder or to the desktop. This 

will move the file from its current location to the desktop. 

 

To copy files from the catalog to the desktop  Hold down the CTRL key (Windows) Option 

key (Macintosh) while dragging files to the desktop. 

 

To launch items with another drag-and-drop application  Drag the items onto the application 

shortcut (Windows) or alias (Macintosh). 

 

To invert the order of media in any catalog view  Click the Invert button  in the upper-left 

corner of the media viewing area.  

 

To change views  CTRL + 1, 2, and 3, respectively (Microsoft Windows XP and Microsoft 

Windows Vista) or  1, 2, and 3, respectively (Macintosh OS X). In this way, you can view the 

tabs.
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Selecting multiple images 

If you want to batch process your images, Expression Media offers several ways to quickly select 

a group of items. 

 Following are the selection commands:  

a) Choose Edit. 

b) Choose Select All. 

c) Select Clear All or Invert Selection. 

 A continuous block of items  Click the first item and, hold down the SHIFT key, and 

then click the last item of your selection. 

 A selection of non-adjacent items  Hold down the CTRL key (Windows) or the  key 

(Macintosh) while selecting individual items. 

 A selection of non-adjacent blocks  For example, to select items 1 through 10 and 20 

through 30, click 1, press SHIFT+click 10, press CTRL+click 20 (Windows), or +click 

(Macintosh), or press SHIFT+click 30. 

 Expanding a selection  Select an item or block of items and expand the selection by 

pressing the SHIFT key and one of the arrow keys. The LEFT and RIGHT ARROW keys 

increase the selection by one item. The UP and DOWN ARROW keys increase the 

selection by a row of items. 

 Selection scripts  On the Scripts menu, point to Select, and then click Landscape, 

Portrait, or Square.  The command Landscape selects all items in the catalog that are 

horizontal. Portrait selects all items that are vertical. Square selects all items that are 

perfectly square items. 

 Selecting based on criteria  To select items that match a particular attribute (Capture 

Date, File Type, Label) or annotation (Event, Location, Categories, Keyword), click the 

dot next to a field term in the Organize panel’s Catalog Fields index, and the 

corresponding items will appear in the active view. This will hide all images that do not 

match that annotation or attribute. Once the appropriate images are shown in the active 

view, on the Edit menu, click Select All.  

You are now ready to perform a number of functions by selecting them at the same time. As an 

alternative, you can choose Select Media Items from the individual field menu. This selects all 

items associated with that attribute in the active view.  

Thumbnails and Previews 

Expression Media has the Thumbnails and Previews command on the Edit menu. In the 

Thumbnails and Previews dialog box, you can define thumbnail preferences, as well as choose 

to create and store media previews, images that are displayed in Media View, Slide Shows, and 

Light Table mode, regardless of whether or not the original media files are not available for 

display.  
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Using built-in thumbnails 

Some applications, such as Adobe® Photoshop®, embed a thumbnail into the media file. Digital 

cameras do this as well. These thumbnails are typically of low quality.  

 

During import, Expression Media extracts and displays that embedded thumbnail if the box is 

selected. Clearing this option will instruct Expression Media to create its own thumbnails, which 

are generally higher in quality, at the cost of a slower import process. If you want to improve the 

quality of the thumbnails at any time, then, on the Action menu, click Rebuild Item. For more 

information about improving the quality of thumbnails, see ―Improving thumbnail quality in 

Expression Media‖ on page 27. 

Media previews 

Expression Media enables you to view each item in your catalog by dynamically opening the 

original file and displaying it in Media View, Slide Shows, and Light Table mode.  

 

In Expression Media, you can also have the option of creating media previews–large .jpg proxy 

images that Expression Media displays in Media View, Slide Shows, and Light Table mode.  

 

Media Previews are particularly useful if the majority of your media is stored as offline storage 

volumes, such as a CD or DVD. These previews are also useful for distributing catalogs without 

having to include the original media files.  

To create a catalog with Media Previews 

1. Create a new catalog. 

2. On the Edit menu, click Thumbnails and Previews. 

3. Select the Create full screen previews box. This enables the creation of Media 

Previews. 

4. Select the size of previews to be created (for example, 800, 1024, and 1280 pixels). 

5. Select the .jpg compression quality to be applied to the preview images, and then  

click OK. 

6. Import the media items and save the catalog. 

Setting a default for a new catalog 

If you want your settings to apply to all new catalogs created by Expression Media, click the 

Save as Default button in the lower-left corner of the Thumbnails and Previews dialog box. 

Media previews and catalog file size 

The file size of catalogs with Media Previews can be considerably larger than catalogs with only 

thumbnails. To create a Media Preview, in the Thumbnails and Previews dialog box, select the 

Create full screen previews check box. The size and compression quality of media previews 

will also greatly impact the file size of Expression Media catalogs. Because Expression Media 

has to render the entire image in order to create a full screen preview, this can slow down the 

import process.  
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The time it will take to organize media will vary based on your computer’s operating system and 

overall speed. It will also vary depending on the size of the original media files.  

Previews in Media View  

In the Header bar, Expression Media displays the file name, the word ―Preview,‖ and the 

preview dimensions, rather than the path location. 

Catalog file size 

The effect of the size and quality of Media Previews on the file size of Expression Media 

catalogs. If you select Large Previews, you might reach the 1.8-GB catalog maximum file size. 

List View  

 
List View 

 

In this view of a catalog, your media appears in a list of small icons beside information fields of 

your choice, such as file name, size, type, duration, and so on. Movie Thumbnails show a small 

video icon to help differentiate them from still images. The path for the location of the file and a 

media-related description appears in the header. For files that are on unmounted drives or 

removable media, such as CDs or DVDs, this file path text displays in red. 

 

To sort the list according to a field, click the corresponding field label in the Header bar above 

the list area. To rearrange the order of header fields, click and drag the field name to a new 

location. Notice that some information is dependent on the file type. For example, the Duration 

field applies only to movies and sounds.  

 

To rename a file, click its name and start typing, the same way as you would on the desktop. 

Expression Media will not rename the item if the original file is offline, locked, or set to read-

only. Similarly, to edit annotations, click the field and start typing in the space provided. 

By default, the width and height fields are displayed in pixels. You can change the unit of 

measure in the Dimensions setting of the Options dialog box (on the Edit menu, point to 

Preferences, and then click the General tab).  

 

Though the icons are small, movies and music will play in List View. To change the view, select 

a file and press the SPACEBAR. You can also change views while the file is playing. 
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Thumbnail View  

 
The Thumbnail View 

 

Click the Thumbnail tab to select this view. This view displays the catalog as a table of 

thumbnails in adjustable sizes. When you select an item in the table, the Header bar presents data 

about the item, for example, whether or not the file is loaded on the hard drive, the last path 

name for the location of the file, and a description. If the original file is not on the hard drive, 

then the header text is red.  

 

To change the position of items in the catalog, select one or more items in that catalog, and then 

drag them to the desired location. Or, after you made your selection, select any of the move item 

commands on the View menu. If you click Move to Location, a special mouse cursor displays, 

indicating that you can now choose the destination by clicking somewhere in the catalog (you 

can scroll if you want). To cancel this mode, press ESC. 

 

If an imported image appears much smaller than the thumbnail box containing it, Expression 

Media has read an existing thumbnail rather than created its own (this is common with digital 

camera files). If you want Expression Media to create its own thumbnails for every file imported, 

make sure that the command Use Built-in Thumbnails is not selected in the Thumbnails and 

Previews dialog box.  

 

If Expression Media creates its own thumbnail, the size of the thumbnail is defined in the 

Thumbnails and Previews dialog box from the Edit menu. 

 

Altering thumbnails  If a thumbnail of an animation or movie file is black, or not what you 

want, select the item and play it to a frame you like. Then, pause the playback and, on the Action 

menu, click Rebuild Item.  
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For multi-page or multi-layer files, switch to Media View, and then use the Pager tool to 

advance to the page or layer you want to be the thumbnail. Then, on the Action menu, click 

Rebuild Item. When you return to Thumbnail View, the thumbnail will be updated to the new 

layer or page.  

 

  
The pager tool 

 

To update the thumbnail of a media file that has been modified since it was cataloged, select the 

item, and then, on the Action menu, click Rebuild Item. 

Rotating thumbnails 

Some images will not appear in the proper orientation when imported into Expression Media. 

This is often the case with portrait (vertical) film images that have been scanned, or portrait 

images taken with digital cameras that do not record the camera’s orientation in the EXIF 

metadata. 

 

Most new digital cameras record the orientation in the EXIF metadata. Expression Media 

respects this image orientation and automatically rotates the image thumbnail accordingly during 

the import process. 

 

For those files that need to be rotated, Expression Media offers three methods of rotating your 

files to the proper viewing orientation.  

 

Rotating thumbnails or “soft rotation”  A soft rotation means that the viewing angle of an 

item is rotated, but not the file itself. To soft rotate an item, select the thumbnail and use the 

Rotate buttons in the far-right side of the Header bar. Each rotation represents 90 degrees. 

A soft rotation applies to how Expression Media displays the file in all views (List, Thumbnail, 

or Media View, Light Table mode, and Slide Shows) and how it will export the media, such as 

file conversions and Web galleries. However, if you open the file with an external application, 

such as Photoshop, the media might appear with its original orientation. 

 

Lossless .jpg rotation  Lossless rotation means that the original image is rotated and saved 

without a recompression of the .jpg image data. Using this method will prevent images from 

getting more .jpg compression artifacts. On the Action menu, click JPEG Rotate to perform 

lossless rotations of 90, -90 and 180 degrees. Before applying a batch lossless .jpg rotation, be 

sure that all images selected are .jpgs and need the same orientation correction. All original 

annotations are maintained with this function. The Default lossless .jpg rotation function rotates 

.jpgs based on their soft rotation state. Selecting this option saves you time because you will be 

able to perform several different rotations at the same time.  

 

Precision rotation  Use the Rotate tool in Expression Media’s Image Editor to adjust the angle 

of images in increments as small as 1/10th of a degree. To rotate an image 90 degrees clockwise, 

type 90 in the Angle field. To rotate counter clockwise, place a negative sign (-) in front of the 

number in the Angle field. When you are finished, click the Save button in the Image Editor 
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panel. Depending on your options (particularly format), some metadata might be lost when 

saving the file.  

 

For instructions about how to rotate files with the Image Editor, see ―Image editor‖ on page 128. 

Improving thumbnail quality in Expression Media 

Some applications, such as Adobe® Photoshop®, embed a small, low-quality thumbnail into the 

media file. Digital cameras do this as well. During import, Expression Media renders that pre-

existing ―built-in‖ thumbnail and stores it in the catalog file. Maintaining this default setting 

makes importing fast, but it also results in low-quality thumbnails. 

 

To improve the thumbnail quality, set Expression Media to render its own thumbnails on import. 

Alternatively, you can rebuild thumbnails individually. These thumbnails will be superior in 

quality and take up much less catalog space than the built-in thumbnails. 

Rebuild thumbnails on import   

Expression Media can render new thumbnails during the import process, providing you a choice 

to create thumbnails of a different quality. Choosing to rebuild thumbnails slows down the 

import process because Expression Media needs to render the entire image to create a thumbnail, 

however, you might have a higher-quality thumbnail.  

 
To rebuild thumbnails on import 

1. On the Edit menu, click Thumbnails and Previews. 

2. Clear the Use Built-in Thumbnails check box. 

Rebuild thumbnails individually   

Use this option if you have an existing catalog that was created with built-in thumbnails. 

 

To rebuild thumbnails individually 

1. Select the thumbnails. 

2. On the Action menu, click Rebuild Item. 

Improving digital camera thumbnails   

Digital cameras might have poor quality thumbnail files because they often allow users to take 

pictures with a 3:2 ratio. When the camera creates a thumbnail for this type of image, it places 

black bars above and below the image to make the thumbnail size conform to the standard 4:3 

ratio. To improve poor quality thumbnails, or remove these bars and improve the thumbnail 

quality, choose one or more images, and then, on the Action menu, click Rebuild Item. 

Improving thumbnail quality in other applications 

Depending on the graphic application that created or edited a particular file, you can improve the 

quality of thumbnails that display in Expression Media by setting options in the original 

program. Follow the suggestions in the following sections according to the application that you 

use to create or edit your files.  
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Adobe Illustrator 

This information applies to version 8.0 only. 

Adobe® Illustrator® does not offer any options for modifying thumbnails in its native format 

(.ai).  

For the best catalogs, we recommend that you save files with the Create PDF Compatible File 

option selected. This option makes the file you save into a PDF file. The option is in the 

Illustrator Options dialog box, which appears when you save an Illustrator file by clicking Save 

As on the File menu. 

Adobe Photoshop 

This information applies to version 7.0, Creative Suite, and Creative Suite 2.  

The image-editing program, Adobe Photoshop, embeds sharpened thumbnails and saves files. 

This option is controlled in the Photoshop program’s Preferences: File Handling dialog box. 

When you select a Macintosh or Windows Thumbnail, Photoshop CS2 creates thumbnails at 160 

pixels. There are no options for controlling the size of thumbnails. 

If you have selected the Use built-in thumbnails option, thumbnails for Photoshop files might 

appear smaller than the thumbnail cell container. When you rebuild it, the thumbnail size will 

match the rest of your catalog. 

In the event that a Photoshop file does not have a built-in thumbnail, Expression Media will 

automatically create its own at 320 pixels. The default thumbnail size for Adobe Photoshop 7.0 

files is 128 pixels; for 6.0 files it is 112 pixels.  

Adobe ImageReady 

Adobe’s optimization program, Adobe® ImageReady®, does not embed thumbnails in 

optimized files. Expression Media automatically creates its own thumbnail for these files.  

Macromedia FreeHand 

This information applies to versions 9.0, 10, and MX (11). 

Macromedia® FreeHand® (the illustration program) embeds a small thumbnail when it saves 

files. These thumbnails are 112x112 pixels, in the color Bitmap PICT format.  

Some FreeHand files might have been saved without a thumbnail or preview. As a result, these 

files will display a generic icon. 

However, FreeHand has the option Export Preferences that enables you to make sure a 

thumbnail is added. You can find these options in Expression Media by clicking Preferences on 

the Edit menu or on the Application menu (Macintosh). 

To get the best thumbnails, we recommend selecting the following options. 

 FreeHand file preview  When selected, FreeHand documents are saved with a preview 

embedded. The default is a 112x112 JPEG thumbnail. You can increase the width and 

height of this preview to ensure a larger image to display in Media View. 



Microsoft Expression Media User Guide 

 

29 

 

 Include Portfolio preview  When selected, FreeHand documents include a thumbnail 

bitmap preview used by Extensis™ Portfolio for browsing (font manager). Expression 

Media uses this preview for display in Thumbnail View. 

 Selecting the Bitmap PICT  This preview dialog box might cause a color shift and 

gradient banding to occur on CMYK (color mode) documents. The benefit of checking 

this option is that you are able to scale the size of your preview, which is valuable for 

very large documents. 

Note: Using the Rebuild Item command will not improve the quality of these thumbnails.  

For more information about these export options, refer to the Macromedia FreeHand Help 

documentation.  

Adobe InDesign 

This information applies to versions 2.0, Creative Suite (CS), and Creative Suite 2 (CS2). 

Files created with the page layout program, Adobe® InDesign® CS2, will have thumbnails if 

you select the Save Document Preview Image option in the InDesign File Handling dialog box 

on the Preferences menu. 

This dialog box also enables you to define the size of preview images that you use to create 

thumbnails in Expression Media. The size you choose limits the size of thumbnails that can be 

created by Expression Media. Expression Media also fully displays this preview in Media View.  

In versions 2.0 and CS, InDesign files contain a 128x128 pixel, color bitmap PICT thumbnail of 

the first page of InDesign documents.  

Select a preview size for InDesign files in the File Handling dialog box on the Preferences menu. 

Media View  

 
Media View 
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This view displays media files at full size, one file at a time. Unlike other views, Media View is a 

real-time presentation of the original media files onscreen. This means that Expression Media 

needs to have access to the file; otherwise, you will get an error message such as ―File Not 

Found.‖ 

In Media View, you can play animations, movies, and sounds, or navigate inside a QTVR image. 

Use the onscreen QuickTime controls to interact with movies, music and QTVR. You can also 

flip through the pages of a PDF or view the various layers of a Photoshop document using the 

Pager tool that appears in the Header bar. 

When an image does not fit entirely inside the window, the cursor changes to a hand. Use the 

hand tool to move the image. Use the RIGHT ARROW key to advance to the next image. Use 

the LEFT ARROW key to go to the previous image in the catalog. 

You can use the Zoom buttons in the upper-right side of the Header bar to zoom in and out. To 

adjust the size of media display in this view, you can use the Size menu. Options include Actual 

Size, Scale to Fit, Fit Width, Fit Height, Pin Larger Side, Pin Smaller Side, Tile, and a selection 

of percentages. 

For large media files (for example, 30 MB), there can be a slight delay before the media appears 

onscreen. The more powerful the computer, the less likelihood there is of a delay. 

To print a particular layer or page within a composite file, go to the page or layer you want to 

print, and then, on the Action menu, click Rebuild Item before printing. For movies and multi-

page items, Expression Media prints only the frame assigned as an item’s thumbnail. 

Playback of media 

Expression Media can play a wide variety of music, video, and multimedia files. They can be 

played in any view, including slide shows.  

 
Playing back an audio file 

To start playback, select the file you want to play, and then click the Play Media button  on 

the toolbar. Or, you can press the SPACEBAR. To stop the playback, press the toolbar’s Play 

Media icon or press the SPACEBAR. 

In Media View, media files such as video, music, Flash, and QTVR are displayed with 

QuickTime controls. You can use these controls to regulate playback and control volume. Or, 

you can click the toolbar’s Play Media icon and press the SPACEBAR to start and stop 

playback. 

One unique feature of Expression Media is that you can switch between List View, Thumbnail 

View, and Media View while playing a file, without altering playback quality. To change views, 

click the appropriate tab. 



Microsoft Expression Media User Guide 

 

31 

 

If Expression Media cannot play your file, define a media player application that is capable of 

playing the file and use it as a Helper application. To learn more about defining Helpers and 

launching files with them, see ―Helper applications‖ on page 116. 

Playlist mode 

Playlist mode enables you to play the files of a catalog in a continuous sequence. This feature is 

not selected by default. If you want to select it, on the Play menu, click Playlist Mode. 

This feature is useful when you have a catalog of MP3 files that you want to listen to, or a 

sequence of video or still images that you want to watch. Expression Media will continuously 

play the files in your catalog in a loop until you tell it to stop. 

To start a playlist, select the file you want to begin with, and click the Play Media button in the 

toolbar. Or, you can press the SPACEBAR. To stop the playback, press the toolbar’s Play 

Media icon or the SPACEBAR. 

Playlist mode also automatically advances through a catalog of images, which is particularly 

useful in Media View. This feature simulates a slide show, while allowing you to see information 

panels open alongside the images. You can adjust the delay (short, medium, or long) between 

images in the Stills Pause command of the Play Media menu. 

When Playlist mode is turned off, media can still be played, however Expression Media will not 

advance to the next media item on playback completion of a selected item. 

Customizing the Expression Media workspace 

A good way to increase your efficiency and productivity with Expression Media is to customize 

the workspace and tailor it to your workflow needs. Each view of Expression Media (List, 

Thumbnail, and Media) can be customized by using the View Options panel. You can select 

which metadata to display, the background color, as well as the font, size, and color of display 

text. In addition to the display, View Options also applies to some export functions, such as 

printing, contact sheets, and the default HTML gallery theme.  

Each view has its own options. For example, changing the text and display options in List View 

will not change the options in Media View. 

To customize the views 

1. Click the tab corresponding to the view that you want to customize. 

2. Do one of the following: 

 On the Window menu, click View Options. 

 Click the View Options icon on the toolbar. 

3. Adjust the options according to the guidelines in the following section. 

4. If you want to save your visual preferences as a theme, then, on the AutoFill menu , 

click Save. If you want to save your settings as the default settings for all new catalogs, 

click Set as Default (Windows) or Save as Default (Macintosh). 
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Font and color options 

The following options apply to font settings. 

Font and Size  Use the menus to select a font and a preset point size. 

Background  Defines the background color of the media viewing area. 

Text Foreground  Defines the color of text, field labels, and the media frame. 

Text Background  Defines the color bar that appears behind text. To make this bar appear 

transparent, make this color the same as the background color in order. 

List View options 

The following options apply to List View. 

Frame media  Adds a one-pixel border around thumbnails. The color of this frame is defined by 

the Text Foreground color option. 

Use generic icons  Change a rendered icon to a generic icon. 

Thumbnail View options 

The following options apply to Thumbnail View. 

Field labels  Puts the name of the field next to the displayed text of that field. 

Frame media  Adds a one-pixel border around thumbnails. The color of this frame is defined by 

the Text Foreground color option. 

Center text  Aligns centered the field text.  

Show scale  Displays the thumbnail size as a percentage of the original media size.  

Aspect ratio  Adjusts the proportion of all thumbnail containers. These options are valuable for 

saving space in the media viewing area, depending on the shape of most media in your catalog 

(Normal [Square], 3:4 Landscape, 4:3 Portrait).  

Margin  Offers options for a stylized border around all thumbnails. Blank adds a small amount 

of white space around thumbnails; Shadow adds a drop-shadow to thumbnails; Frame adds a 

recessed frame around thumbnails. 

Media View options 

The following options apply to Media View. 

Field labels  Displays the name of the field next to the displayed text of that field. 

Center text  Aligns field text centered.  

Histogram  Displays a graph showing the relative distribution of Red, Green and Blue pixel 

densities in an image. It shows the number of pixels with high density on the left (darker colors) 

and low density on the right (lighter colors).  

Field options 

The following options apply to the Fields section in the View Options panel. 
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 To add a field to a view, click its name in the field list area. This produces a check mark 

next to the name. To remove a field, click it again and the check mark disappears. 

 The order in which fields are displayed is determined by the order in which they are 

selected in the View Options panel. 

 Change the number of lines displayed for each field by clicking the UP or DOWN arrows 

on any active field. This method is useful for fields with longer amounts of text, such as 

Description or Paths. 

 Font styles, such as Bold, Italic, and Underline, are optional for each field and can be 

selected in the Style menu for each field name. Multiple styles can be applied at the same 

time. 

Adjust media size in views 

Use the Size menu to define the display size of previews in List View and Thumbnail View. You 

can also define the size of media in the Display Options section of the View Options panel. 

To adjust media size in the views 

On the Size  menu, select the option that applies to the view that you want to adjust. Use the 

following descriptions as a guide. For thumbnails, if you increase the size beyond the size of 

thumbnails stored in the catalog (as might be the case if you are using built-in thumbnails), then, 

on the Action menu, click Rebuild Item on all the files in the catalog to render the thumbnails at 

sizes up to 640 pixels. 

List View  Select from Small (16 pixel) and Large (32 pixel) options. The View Options panel 

has an option to switch from rendered icons to generic. 

Thumbnail View  Select from a range of thumbnail sizes, from 80 to 640 pixels.  

Media View  Options include Actual Size, Scale to Fit, Fit Width, Fit Height, Pin Larger 

Side, Pin Smaller Side, Tile, and a selection of percentages. If an image does not fit entirely 

inside the window, the cursor changes to a hand. Use the hand to drag the image. 

In all views, the Zoom buttons  increase or reduce the size of the thumbnails or media. 
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Chapter Four: 
 

Media Metadata 
 

 

Microsoft Expression Media provides a powerful solution for categorizing and describing your 

files. You can add your annotations to industry-standard metadata fields as well as custom 

annotation fields. 

The Info panel 
When a media file is created by a computer or digital device, information is embedded into the 

file to describe it. This information is called metadata, and it is used by software programs to 

accurately understand the media file.  

 

Expression Media uses the Info panel to provide an instant look at the combined properties and 

metadata of a media file, such as file type, size, dimensions, resolution, caption, capture date, and 

duration. This information might change, based on the media type. 

 

You can edit and check the accuracy of information within this single user-configurable list with 

no need to remember to open multiple dialogs. The data inside the Info panel is split into various 

sections. To show the data from one of these groups, click the arrow next to the section name.  

 

Some files have large amounts of information. To view all of the metadata for these files, you 

can scroll down the panel, or you can hide various sections using the Configure List menu (for 

more information, see ―Configuring the Info panel list‖ on page 38). 
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The Info panel 

To show or hide the Info panel 

Click the Info button. 

 

Below are the sections that you can display in the Info panel. 

 



 36 

 
Media Info section 

 

Media Info  This field displays embedded media-related metadata that cannot be edited. It 

includes some data that your computer assigns to a file, such as type, size, creation date, and 

modification date. 

Other fields display information based on the media type. For example, image files display 

dimensions, resolution, bit-depth, color space, and profile. Audio files display the type of 

encoding, length of the music, audio channels, and data about the quality of the sound. 

Expression Media also displays the size of text annotations, audio annotations, and thumbnail 

associated with an item in this section. 

Special, extended media-related metadata are displayed in their own section. They are as 

follows: 

 

 

Photo EXIF section 
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Photo EXIF  For images created by digital cameras, the Info panel displays special data (EXIF) 

that has been captured and embedded in the photo file. This metadata includes the date and time 

a photo was taken (Capture Date), as well as camera-related information, such as shutter speed, 

aperture, and exposure. Global Positioning System (GPS) information can also be displayed in 

this section. Different cameras record different amounts of EXIF data. Only the EXIF data 

captured by your digital camera will be displayed here. 

 

Cue Points (Audio and Video)  Some audio or video media files contain markers, or cue points 

that define special time stamps in the file. For example, an audio file might have cue points that 

mark the chorus, bridge, and solos of a song. Expression Media lists the name and time stamp for 

all cue points of an item in this section. 

 

Movie Tracks (Audio and Video)  Movie files typically contain two tracks of digital 

information, one for video and one for audio. However, movies can contain multiple video and 

audio tracks. This field displays the type of encoding, start time, duration, data size, data rate, 

and frame rate for each video track of the movie file. For audio files that only contain one track, 

this section displays the type of encoding, start time, duration, data size, and data rate. 

 

Annotations  Expression Media supports a set of pre-defined fields for annotating media. This 

set (also known as the IPTC Core) includes fields that enable you to define the author, event 

date, event information, copyright, labels, ratings, and more. 

IPTC stands for the International Press and Telecommunications Council. Since the late 1970s, 

the ITPC has focused on developing industry standards for the interchange of news data. The 

IPTC annotation fields used by Expression Media comply with the standards set by this 

organization. 

These fields are also part of Adobe’s metadata standard called XMP (Extensible Metadata 

Platform). Expression Media can read XMP metadata in four image file types: .jpg, .tif, .dng, 

.png, and Adobe Photoshop. 

Creating or editing annotations in an Expression Media catalog does not affect the original files, 

unless you choose to synchronize the catalog items with the original files.  

 

Description  The Info panel also provides an area to write descriptions of media, which is useful 

for additional details or thoughts about the files. Descriptions embedded into files are 

automatically shown in this field. 

 

QuickTime equivalent mapping  Some files, such as MP3s or movies, have QuickTime 

annotations embedded. These are mapped to annotation fields. For example, the Author 

annotation field is mapped to the Artist field of an MP3, Product to the Album name, and Title to 

a song’s Full Name. For more information about mapping, see ―Appendix C: Annotation 

Mapping.‖ 

 

People, Keywords, Categories, Scenes, and Subject Codes  Metadata groups that are useful 

for describing and organizing the content of your media. These groups are part of the IPTC and 

XMP annotation standards. 
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Catalog Sets  Display all of the associated Expression Media sets in the Organize panel to which 

an item belongs. Catalog sets are a free form, hierarchical method of organizing media files.  
 

To add a group to the annotation groups Categories, Keywords, and People, double-click the 

empty field and type the name of the new field.  

Configuring the Info panel list 

Some images in your catalogs will have large amounts of metadata displayed in the Info panel. 

To view all of this information, you can scroll up and down in the Info panel. However, this task 

might become too cumbersome or repetitive, especially when scrolling past empty fields or 

metadata groups that are irrelevant to your workflow. 

The same is true of the Catalog Index in the Organize panel, which is used for sorting and 

annotating images. 

As a solution, you can selectively display the most relevant fields or groups of metadata in the 

Info panel and Catalog Index by choosing from the Configure List menu.  

The state of the Info panel and Catalog Field index lists is unique for each catalog and is 

maintained when saving and closing a catalog. 

The Configure List menu also has the option of storing a default state of hidden and shown 

fields, which you can define.  

This default can be useful for workflows that focus on a specific subset of metadata. For 

example, your annotation workflow might only require data entry in eight of the IPTC annotation 

fields, as well as Keywords. In this case, you can store a default that shows only these fields in 

the Info panel. 

 
To configure the Info panel list 

1. Click the Configure List  button.  

2. Click one of the following options: 

 Show/Hide Fields  Creates a custom display of the field sections. Select or clear the 

check box according to the field you want to show or hide.  

 Save as Default  Stores the current Info panel configuration as the default, which can 

be loaded into existing or new catalogs. 

 Load Default  Applies your default configuration to the current catalog. 

Field names 

Some software programs use different names for the various IPTC/XMP field names. For 

example, Photoshop CS calls the IPTC Job Identifier field, Transmission Reference. Expression 

Media provides you with the option of selecting which field names to display—the official IPTC 

Core names, those names used in Expression Media, or those used in Photoshop CS.  
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To change the displayed field names  

 On the Edit menu, point to Preferences, and then click General. 

Field names do not affect how annotations are written (synchronized) into media files. It is 

merely a visual preference designed to help you choose the appropriate field when annotating 

files. 

Annotating media in the Info panel 
The Info panel allows in-line editing of annotations, captions, keywords, and categories. To add 

information or edit a field, double-click the text box next to the field label and type in the 

annotation information. 

Adding or editing annotations in an Expression Media catalog does not affect the original files, 

unless you choose to synchronize the annotations in catalog items with the original files.  

Expression Media lets you assign and edit annotations individually or annotate by batch multiple 

media items, providing you with a quick method of organization. There are five ways to assign 

annotations: 

 During import  

 Applying Metadata templates 

 Data entry in the Info panel 

 Data entry directly in any view 

 Drag and drop to the Catalog Fields index 

Annotating on import 

Use metadata templates to apply annotations as you import a media item from disk or camera. 

Metadata templates are useful for saving and applying a group of frequently used annotations, 

such as creator information (author, copyright, contact information, and so on). For information 

on creating and applying metadata templates, see ―Annotating using metadata templates‖ on 

page 40. 

Annotating in the Info panel 

Expression Media uses the Info panel to provide you with an easy way to quickly review the 

aggregate properties and metadata of an image. You can also use the Info panel to assign 

annotations to a single item or to a batch selection of media items.  

Expression Media has an auto-completion feature that assists you in typing annotation terms. For 

example, if you type ―S‖, Expression Media completes the term with the nearest term from the 

field’s vocabulary starting with ―S‖. 

If a word is auto-completed, press the ENTER or RETURN key to assign it as the term. Or, you 

can click the TAB key to apply the existing term and advance to the next field.  
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Annotating in the Info panel 

 
To annotate in the Info panel 

1. Select the item(s) you want to annotate.  

2. Open the Info panel. Click the Info toolbar button  

-or- 

On the Window menu, click Info panel. 

3. Type information into the Annotations fields (for example, Description, Date Created, 

Keywords, or Categories).  

4. Click the Save Changes icon  at the top of the Info panel to confirm changes (or the 

Discard changes icon  to discard changes to the Recycle Bin or Trash). 

5. To apply the annotation to multiple items, select Apply to All items in the Confirmation 

dialog box.  

All selected items should now have the annotations you typed. 

Annotating using metadata templates 

Expression Media provides metadata templates—a tool for saving a set of frequently used 

annotations—and applying them to media items. 

A metadata template applies Annotations, People, Keywords, Scenes, Subject Codes, Categories, 

and Descriptions to each item selected in the catalog. 

To create a metadata template 

1. Select an item and type information into all of the annotation fields you want to save. 

2. In the menu at the top of the Info panel (pencil icon), select Save Metadata Template. 

In the dialog box, give the template a name. 

Alternatively, you can select Create Metadata Template in the menu at the top of the Info 

panel (the pencil icon). Metadata templates can also be created when you choose Import Items 

from the File menu, and then click either the From Disk/Camera or From URL commands. 

To apply a metadata template to existing media items 

1. Select a group of media items. 

2. In the menu at the top of the Info panel , select a metadata template. 

3. In the dialog box that appears showing the metadata that will be assigned by the template, 
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select or clear fields to keep them from being applied to media items.  

4. Click the Apply button. 

5. Click the check mark icon to save the annotations. In the confirmation dialog box, select 

Apply to All items. Now all selected items will have the annotations assigned by the 

template. 

Note: To remove templates from the menu, choose Remove Metadata Template to provide you 

with a dialog box from which you can remove a template.  

To apply a metadata template to an item on import 

1. On the File menu, point to Import Items, and then click From Disk/Camera. 

Note: Make sure you have your camera or disk open. 

2. Click the Options tab.  

3. In the Annotate menu, select a metadata template from the menu to apply a group of pre-

defined annotations to all imported items. If there are no templates available, you can 

create one by clicking New Metadata Template.  

Annotating in views 

 

 
Annotating in a view 

 

You can edit any displayed IPTC annotation directly in List, Thumbnail and Media Views.  

To annotate in a view 

1. On the Window menu, click View Options. 

2. In the Annotations section, click any field name to display it in the active view.  

3. Click the field in the active view and type the annotation. 

4. If you want to type several terms, and have them each display individually, then type the 

terms as a comma-separated string and press the ENTER or RETURN key. Expression 

Media automatically splits multiple terms into separate keywords. This is a good idea if 

you cut and paste a comma-separated string of terms into one field. 
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Removing annotations 

You can remove annotation fields from selected items by using two methods. You can either use 

a menu command or you can delete the item directly in the panel.  

To remove annotations in a view 

1. Display a view by clicking the List, Thumbnail, or Media tabs.  

2. On the Action menu, click Clear Annotations.  

3. In the dialog box, you can select Clear All annotations or Choose Fields that you want to 

remove. The latter reveals a list of annotations associated with all items, allowing you to 

select the fields to remove. 

 
To remove annotations in the Info panel 

To remove an annotation, you must change focus to another media item or, click on the check 

mark icon on the toolbar to commit your changes to a catalog. 

Annotating using the Catalog Fields index in the Organize panel 

You can type annotations directly into the Organize panel. Some fields, such as Sample Color, 

File Type, or Color Profile cannot be edited or appended to because the corresponding data refers 

to file states that are either permanent, or that will require editing the image in order to alter. 

 
To add terms to the Organize panel 

1. Click the Organize toolbar button, or on the Window menu, click Organize panel. 

2. Locate the annotation category. If the category you want to edit is not visible, click the 

Catalog Fields index in the menu in the upper-right corner of the panel. 

3. Expand the annotation group by clicking on the group name (for example, Date Finder, 

Keywords) to show available terms for that annotation.  

4. If there is no annotation value, click the plus sign (+) icon at the top of the Catalog 

Fields pane.  

5. Type the name of the term, and then click OK. 

6. Select an item or group of items. Use the drag-and-drop operation to move the items onto 

the new term. Associating an item with an annotation in a catalog does not affect the 

original file. 

Dragging to the Catalog Fields index 

The Catalog Fields index is an alternative way to add metadata organization to your media, as 

opposed to typing annotations in the Info panel.  

 

All IPTC, XMP, and QuickTime standard fields in the Catalog Fields index support the drag-

and-drop operation. Supported fields include Catalog Sets, Date Finder, and Sample Color. 

Expression Media displays custom annotation fields at the bottom of the Annotations group, and 

these fields also support the drag-and-drop operation. 
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Instead of assigning annotations in the Info panel, you can create an annotation field term in any 

of the Catalog Field groups. Use the drag-and-drop operation for images on the annotation field 

value to assign it to an item. This significantly speeds up and simplifies the annotating process. If 

you switch to the Info panel, you will notice the same annotation is represented in the 

corresponding annotation field. Conversely, if you add metadata to an annotation in the Info 

panel, it will also appear in the corresponding group in the Catalog Fields index. 

Creating custom annotation fields 

Expression Media supports up to 16 custom annotation fields. These fields are useful for creating 

additional metadata associated with a specific project, client, or storage location.  

Once defined, you can use custom annotation fields and metadata fields in various sorting and 

searching functions of Expression Media, such as the Info panel’s Annotations data entry fields, 

the Catalog Fields index’s Annotation Organizer, the Sort toolbar menu (on the toolbar), View 

Options displayed in List View, Thumbnail View, and Media View, and as fields to be searched 

in the Find dialog box. 

When you move images between catalogs, custom fields are automatically adjusted between the 

catalogs. If two catalogs contain more than 16 unique custom fields, the first 16 fields will be 

retained alphabetically. 

To add or remove custom fields  

1. On the Edit menu, click Custom Fields.  

2. Type a name in the Field Name box.  

3. Click Add. If these custom fields are necessary for all of your catalogs, click the Save as 

Default button in the lower-left corner. These custom fields will appear in new catalogs. 

Metadata vocabularies 
In Expression Media, a vocabulary is a set of annotations. When you annotate a media item in an 

IPTC annotation field in the Info or Organize panel, a menu of available annotation terms 

displays. This list of terms is the vocabulary. Each editable category of annotations can have its 

own list. For example, you can have one list for keywords, and a separate list for people, and so 

on. 

 

To create the list of possible annotations, you can either manually add terms using an Info or 

Organize panel option, or use the Vocabulary Editor. By default, Media Expression includes an 

empty default vocabulary, but you can create as many vocabularies as you need. However, for 

most users, only one vocabulary will be necessary.  

Vocabulary terms are saved globally and are accessible by every catalog you create.  

Entering annotation terms in the Vocabulary Editor 

Use the Vocabulary Editor for a more flexible and robust way to enter terms. In addition to 

entering terms there, you can also set up annotation terms that are associated with each other; 

create multiple sets of annotations (vocabularies) for different purposes; and lock the vocabulary 

so that you can select only specific annotation terms. 
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To enter terms in the Vocabulary Editor 

1. On the Edit menu (Windows) or the Expression Media menu (Macintosh), point to 

Preferences, and then click Vocabulary Editor. 

2. In the Field menu, select the field that you want to modify. 

3. Click Add. 

4. In the Terms section, type any annotations that you want to associate with the field you 

chose. You can type a single term, or type several terms separated by commas. You can 

also use quotes to separate phrases. 

5. If you want to enter a description of your annotation term, type it in the Terms 

description box. When you select a term in the Info or Organize panel, this description 

will appear to the right of the annotation in gray. 

6. Click OK. 

7. To add more fields, repeat steps 2-6.  

8. When you are finished adding terms, click OK.  

 

  
Adding terms 

 

 
Terms in the Info panel 

 

9. If you want to lock the vocabulary so that no one can annotate items with any other terms 

besides the terms that you have entered, select Constrain editing to defined terms. 

When you select this option, you can only add terms in the Vocabulary Editor. A locked 

vocabulary is also called a controlled vocabulary. A controlled vocabulary is generally 

much easier to search because the terms used to annotate are exclusive.  

Set up annotation associations 

For a field that can contain more than one annotation term per field (Keywords, Categories, 
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People, Scenes, and Subject Codes) you can save time by associating multiple annotation terms. 

This way, when you type one of the terms, you have the option of applying all of the associated 

annotation terms at the same time.   

 

Enter all of the annotations, separated by a comma, in the terms section of the Vocabulary 

Editor. An example of this would be a stock photographer who wants to use many keywords in 

an image so that it can be found easily. For a photographer who regularly shoots landscapes, it 

might be worth setting up the associations of penguin, mountain, sea, and midday. When sea is 

typed in as a keyword, you can optionally apply all four of these keywords at the same time. 

 

Create multiple vocabularies 

Expression Media can have multiple vocabularies. This is useful if you have different uses for 

Expression Media. You might regularly take photos for clients in the fashion industry, stock 

travel agencies, and also take personal photos.  

 

You can create a vocabulary named Personal, and this would contain, among other annotations, 

the names of your family and friends in your photos. You can select this vocabulary when 

annotating personal photos, and then switch to another vocabulary for photos for your clients. 

This way, by switching between the two vocabularies, you will see annotation terms appropriate 

to the current catalog. 

 

A vocabulary can contain a very large number of terms, take a long time to create, or might need 

to be backed up or copied from one computer to another.   

 
To create a new vocabulary 

1. On the Edit menu (Windows) or the Expression Media menu (Macintosh), point to 

Preferences, and then click Vocabulary Editor. 

2. In the Vocabulary Editor, click the Add  button. 

3. In the New Vocabulary Set Name box, type the name of the new vocabulary. 

Each vocabulary is created in a separate folder. The name of the folder is the name of the 

vocabulary. You can show the location of these folders by using the desktop icon in the upper-

right corner. For the default vocabulary, click the desktop icon button and make a copy of the 

Default folder on the desktop. 

Modify vocabularies using a text editor 

Each field’s list of terms is stored as a separate text file inside the Expression Media Vocabulary 

folder. You can use any text editor to edit these files. You must follow each item in the list by 

pressing the ENTER (Windows) key or the RETURN (Macintosh) key. 

Annotation scripts 

On the Scripts menu, Expression Media has special annotation scripts. 

 On the Annotate menu, click PTC Date from Capture Date to copy the EXIF Capture 

Date into the IPTC Date Created field of the Annotations pane.  
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Available annotation scripts 

 Copy from Head of Selection  Copies all annotations from the first selected item and 

apply them to all other selected items. 

 Copy from Items with Same Name  Copies metadata from selected items to items of the 

same name but with a different suffix (such as Raw+.jpg), or has the same full name in 

other folders. 

 Import From PhotoDISC™  Annotates images in your front catalog, using text files 

located in your PhotoDISC CD. 

 Make Description from Text Files  Searches for .txt files in the same folder as the 

original, and then copies the contents into the caption field. 

 Make Description from Text Lines  Opens a text file and uses each line of the file as 

the caption for the selected items. 

 Make Keywords from Folders  Enables you to add keywords to media files from folder 

names. The dialog box provides the option of defining the level of folders in the path you 

want to use for keywords.  

 Make Product from EXIF Data  Copies the EXIF Maker and Model fields and puts 

them into the Product field of the Annotations pane. 

You can modify existing scripts or create and attach your own annotation scripts at any time. 

Write the script, and then place it in the user-defined Scripts folder in Plug-ins. 
 

Modifying digital camera metadata 

For photographs taken with digital cameras, the Info panel displays special data (EXIF) that was 

captured and embedded in the image. This data is not editable, with one exception, and that is 

Capture Date. Digital cameras record the date and time a photograph is captured based on the 

internal clock of the camera. If this clock is not correct, you can reassign the date and time using 

this function. You cannot undo this action and it and applies only to images taken with digital 

cameras. You can batch this operation by selecting multiple images.  

 

To set the capture date 

1. On the Action menu, click Set Capture Date. 

2. Set the following options according to the directions: 

 Replace with  Enables you to set a new date and time, as well as define the time 

increment between photographs. 

 Adjust relative  Applies the new date and time, maintaining the time difference 

between selected photographs. 

 Apply time difference  Enables you to shift the time based in hours and minutes. 

This feature is helpful for adjusting time-zone differences. 

The Preview window at the bottom of the Set Capture Date dialog box shows a list of the dates 

before and after the correction. 
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EXIF orientation 

The function Correct EXIF orientation rotates the thumbnails of all selected items to correct 

any values of the Orientation field written by your digital camera. This function is done 

automatically during import.  

Sync annotations  

Adding annotation information to media items in an Expression Media catalog does not embed 

annotations into the original file. The annotations only exist in the catalog. 

To write or embed annotations into a file, on the Action menu, click Sync Annotations. This 

command lets you embed annotation information from the catalog into the original files. It also 

lets you import annotations, by rescanning files for metadata added outside Expression Media 

with another application.  

The synchronizing function applies only to annotations that are part of the IPTC, QuickTime, or 

XMP metadata standards. Custom metadata fields and Catalog Sets are now written to files as 

part of the XMP standard. 

This function is particularly useful, because Expression Media lets you view, classify, and batch 

annotate a large number of media items and then exports the changes to the original files, saving 

hours of time opening and editing individual files. It is also useful for updating annotations that 

have been modified by applications outside of Expression Media. 

Annotations that have been written into the file can be read by other applications that can read 

the IPTC, QuickTime, or XMP metadata standards, such as Photoshop or Graphic Converter. 

Expression Media supports only the export of XMP metadata to .jpg, .tif and Photoshop formats.  

Expression Media supports synchronizing annotations in the following Raw formats: Nikon, 

Kodak and Adobe Digital Negative (DNG) and Canon CR2 files. For more information,  

Note: Synchronizing cannot be undone. 

 

To import annotations from files (sync annotations) 

This feature is useful if you have edited annotations in a file outside of Expression Media. Using 

this function instructs Expression Media to import the annotations for that file again. 

1. Select an item or group of items. 

2. On the Action menu, click Sync Annotations. 

3. Select the option Import annotations from original files. 

4. Select one of three options for importing annotations.  

5. Replace Current clears any current annotations and replaces them with all annotations 

from the original file. With the Merge options, you need to define which set of 

annotations take precedence over another when there is a conflict on single-value 

annotations. For example, suppose both the original file and the catalog item contain 

Title annotation. Because there is only one Title annotation per item, you need to decide 

which one to use. Multi-value annotations, such as keywords and categories, are always 

merged together. 
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To export (write) annotations to files 

1. Select an item or group of items. 

2. Type all of your annotations. 

3. On the Action menu, click Sync Annotations. 

4. Select the option for Export annotations to original files. The amount of time it takes to 

write annotations back to files depends on the number of files selected.  

Special annotations plug-in for Adobe Creative Suite  

The Status, Event, and People IPTC fields are not supported by Adobe Creative Suite®. To 

extend support of these fields to Adobe Photoshop CS, Expression Media provides a custom 

plug-in so that you can view and edit these annotations in the File Info dialog box of Photoshop. 

This plug-in also extends support of Expression Media Catalog Sets and any custom metadata 

fields created in Expression Media. 

Plug-in installation 

During the installation of Expression Media, a file named iviewPanel3.txt is automatically 

installed on your computer. 

The file is placed in one of these locations: 

Mac OS X 

 Library/Application Support/Adobe/XMP/Custom File Info panels or {User Directory} 

 ~/Library/Application Support/Adobe/XMP/Custom File Info panels 

 
Windows 

 \Program Files\Common Files\Adobe\XMP\Custom File Info panels  

 \Documents and Settings\<user›\Application Data\Adobe\XMP\Custom File Info panels 

(Windows XP) 

 \<user›\Application Data\Roaming\Adobe\XMP\Custom File Info panels (Windows 

Vista) 

Color profile management  

Expression Media supports ICC color profiles for image files in the .jpg, .tif, .pict, .pdf, and 

Adobe Photoshop formats. This enables Expression Media to provide color profile management 

from input source and catalog through to proof and final printing.   

Expression Media provides you with color accurate display in all views–List, Thumbnail, Media, 

Light Table, and Slide Shows by using your operating system’s color management technology 

(ICM on Windows; ColorSync on the Macintosh). 

To turn off color profile matching 

1. On the Edit menu (Macintosh: Application menu), point to Preferences, and then click 

Media Rendering. 
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2.  Click the Images tab, and then select the Color match check box. 

Manage color profiles 

On the Action menu, the Manage Color Profiles command enables you to embed RGB and 

CMYK color profiles for individual files using profiles defined by your operating system’s color 

management technology (Windows: ICM; Macintosh: ColorSync).  

When the dialog box displays, Expression Media displays the image in Media View, letting you 

preview the application of various color profiles. You can also remove profiles in this dialog 

box. 

If this menu option is not available, it means you need to do the following: 

1. On the Edit menu (Macintosh: Application menu), click Preferences, and then click 

Media Rendering.  

2. On the Images tab, select the Color match check box. 

 

To batch assign profiles 

1. On the Images tab, select the color profile matching preference by selecting the Color 

match check box. 

2. Select a group of images and, on the Action menu, click Manage Color Profiles. If this 

menu command is not available, it means you need to select the color profile matching 

preference. 

3. Select a color profile to embed for each type of image color space, such as RGB, CMYK, 

or Grayscale. This prevents you from embedding an inappropriate profile that could 

potentially ruin the image. The options in each menu are defined by the operating 

system’s color management technology (ICM on Windows; ColorSync on the 

Macintosh).   

4. Click OK. While embedding the profiles into the original files, Expression Media will 

create a new thumbnail for each image according to the new embedded color profile. 

5. You can also batch remove profiles in this dialog box by selecting Remove Embedded 

Profile for each image color space. 

Note: For Expression Media catalogs that contain thumbnails that are not color managed, select 

all items in the catalog, and then, on the Action menu, click Rebuild Item. This will create new 

thumbnails for all images according to the new embedded color profile and the settings of the 

Size menu. 

Extract metadata 

On the Action menu, the Extract Metadata command exports text, image, or sound files 

corresponding to the selected media items. Expression Media creates new files in a single folder 

that you can later use as data that you can import to one or more files.  

To extract (export) metadata: 

1. On the Action menu, click Extract Data. 
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2. Set the following options according to the directions: 

 Editable annotations  Extracts all editable ITPC/XMP annotations for each file and 

saves them as an Adobe Photoshop .xmp sidecar template file. This feature applies 

only to selected items. 

 Image thumbnails  Saves thumbnails of a catalog as a high-quality .jpg image files. 

The dimensions of the extracted file matches the dimensions of the thumbnail defined 

in Thumbnail View. This feature applies only to selected items. 

 Voice recordings  Saves an embedded voice annotation as a separate Sound, .aiff, or 

.wav audio file. This feature applies only to selected items. 

3. Click the Extract in Folder button, locate a folder to hold the extracted data, and then 

click OK. 

Sample colors 

Expression Media offers the ability to identify media (images, movies, and so on) by a single 

color, called a Sample Color. This is useful when searching for images of a specific color or 

tone. Expression Media automatically generates a sample color upon import of an image. The 

sample color is based on the dominant color of the image. However, you can set the sample color 

of the selected media items.  

 

 

Sample colors 

 
To set a sample color 

1. On the toolbar, click Organize. 

2. Select one or more images. 

3. Do one of the following: 

 On the Action menu, click Set Sample Color, and then select a sample color. 

 Drag your selected files from the view and onto an existing sample color in the 

Catalog Fields panel. 
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Voice annotations  

 

Voice annotation recorder 

 

Voice annotations are short audio recordings embedded in media files. Some digital cameras and 

other image capturing devices enable you to save voice comments with a picture. In Expression 

Media, you can record your own annotation, import a sound file, or hear an annotation originally 

saved with the file. If you decide to record your own annotation, you can set the compression 

options for the audio. You can also use voice annotations in slide show presentations. The slide 

show feature is enabled by default, but you can disable it. 

 

Voice annotation menu 

 
To listen to audio annotations  

Do one of the following: 

 Select an item in your catalog, and then press the SPACEBAR. 

 On the Voice Annotation menu, click Listen.  

 
To set compression options 

1. Select the media item that you want to annotate. 

2. On the Voice Annotation menu, click Compression. 

3. Select a compression method from the Compressor menu in the Sound Settings dialog 

box. 

4. Depending on the compression option you choose, you might need to set the Rate, Size, 

and Use parameters.  

You might also have additional code-specific options to set, which you can do by 

clicking the Options button. 

5. Click OK. 

 
To record a voice annotation 

1. Make sure that your system is set up to record from a microphone. 

2. Select the media item that you want to annotate. 

3. On the Voice Annotation menu, click Record.  
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You can record up to 30 seconds of voice annotation. 

4. To end the recording, click Stop, and to play it back, click Play. 

5. If you are satisfied with the recording, click Save.  

Expression Media saves the voice annotation in an Expression Media catalog. 

 
To remove or attach a voice annotation 

1. Select the media item that you want to modify. 

2. On the Voice Annotation menu, do one of the following: 

 To attach an annotation, click Import to navigate to the file you want to attach, and 

then click Open. 

 To delete an attachment, click Remove. 

 
To disable voice annotations  

1. On the Make menu, click Slide Show Options.  

2. Clear the Play voice annotations check mark. 
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Chapter Five: 
 

Reviewing and Marking Media 
 

Once you have imported a collection of media files into a catalog, you will probably want to 

review and classify the media. For example, after importing images from a photo shoot, 

photographers typically edit images, marking their favorites and unusable ones.  

To assist in this process, Expression Media provides two methods of classifying and ranking 

media: star ratings and color labels. Using keyboard commands, labels and ratings can be easily 

assigned in any view, the light table and during slide shows. 

Rating media 
Star ratings provide a ranking system for items in your catalogs. You can now rank your media 

from one to five stars, or mark them with no stars. 

 

 

 

Ratings in the Info panel 

 

 

 

 

 

 
Ratings in a thumbnail 

To assign a rating 

Once you have selected one or more items, you can add a rating in three ways.  

 Select a star rating from the Rate Media drop-down menu on the toolbar, or right-click to 

get a contextual menu. 

 Press ALT + 1-5 (CTRL+1-5). This applies the associated rating (for example, 3 equals 

three stars). 

 Use the drag-and-drop operation to move items onto the Rating section of the Catalog 

Fields index of the Organize panel.  

 

To remove ratings 

Select one or more of the following items:  

 Click None on the Rate Media drop-down menu on the toolbar, or right-click the file in 

any view.  
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 Select an item and press ALT+ the number zero (0). (Macintosh: CTRL+0.) 

 

To show files associated with a rating 

Select one or more items.  

 Click a rating in the Rating section of the Catalog Fields index of the Organize panel.  

 On the Find menu, click Show Rated, and then select a rating value of items you want to 

be displayed.  

Ratings as annotations 

In Expression Media, ratings are mapped to Adobe’s XMP standard for ratings. When 

annotations for images in a catalog are synchronized (written) to the original files, all ratings will 

be written into the files. If you open an image in Adobe® Bridge® (a file management program), 

the star ratings will be displayed. If you have assigned a rating to a file in Bridge, the rating will 

be displayed when you import that file into an Expression Media catalog.  

Color labels  

Labels provide a visual identification and classification system for items in your catalogs. 

 

 

Labels in the Info panel 

 

 

 

 

 

 

 

 

 
A label in a thumbnail 

For example, you can use a color label to mark favorite items, mark items to delete, archive, or 

convert, or you can track items that are in different stages of a workflow. You can adjust the 

colors for aesthetic preference or to better match the tone or contrast of a particular view 

background color. You can also match colors to a labeling scheme in another application or 

environment. 

After you label your items, you can quickly sort the catalog by using the labels in the Catalog 

Fields section. 
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Label options 

To accommodate your desired method of marking items, you can customize the colors and 

names of labels as a global application preference. Because this customization is global, shared 

catalogs inherit the label names and colors of the user that is opening the catalog, and not the 

preferences of the person who created the catalog. 

 

Label options window 

To customize labels 

1. On the Edit menu, point to Preferences, and then click Labels and Colors (Windows) 

or Labels (Macintosh). 

2. Click the color swatch you want to change.  

3. Select any label text and type a new name. Customizing a label name helps to remember 

the label’s purpose or definition. 

4.  (Macintosh) If you select the Apply to original media file option, then labels assigned 

to items in your catalog will also be applied to the original file. For example, if you 

assign a label #1 in a catalog, then label #1 will be assigned to the file on the desktop. 

However, though the label numbers may match, it is possible that the colors will not 

match. 

5. To restore the default label colors and names, on the Options menu, click Reset All.  

6. On the Options menu, to save a group of label preferences, click Export to File. Once 

you have saved the labels to a file, these label preferences can be loaded into other 

installations of Expression Media using the Import from File option.  
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Note: Custom names that you use for labels become indexed as search terms for associated items 

in Expression Media. For example, if a label is named ―Client Picks,‖ then any free-form text 

search in the Expression Media toolbar for the word ―client‖ will return images assigned with 

that color label. 

Labeling your files 

You can assign and remove labels in any view. 

To assign a label 

1. Select or display one or more items. 

2. Do one of the following: 

 Select a color from the Assign Label drop-down menu  on the toolbar, or right-

click (Windows) or CTRL-click (Macintosh), point to Label, and then select a color 

from the list. 

 Press a number key (1 through 9). This applies the associated color (for example, 1 = 

Red). 

 Drag the items from the view to one of the colors in the Label sections of the 

Catalog Fields index.  

To remove labels 

In any view, select or display one or more items, and then do one of the following:  

 In the Catalog Fields section, select None from the Assign Label menu on the 

toolbar.  

 Press the number zero (0). 

To show files associated with a label 

Do one of the following: 

 Click a color label in the Labels sections of the Catalog Index.  

 On the Find menu, click Show Labeled, and then select a label value of items you 

want to be displayed.  

Note: Labeled files can also be sorted during slide shows. To create a slide show, use the Show 

Labeled menu from the Slide Show controller. 

Labels as annotations 

Labels in Expression Media are mapped to the IPTC standard’s Urgency annotation field. When 

annotations for images in a catalog are synchronized (written) to the original files, all images 

tagged with a label will have the corresponding label number (1 through 9) written into the 

Urgency field. For Photoshop CS users, these are the same values used in the Urgency field, 

which you can access on the File menu by clicking File Info, and then selecting Origin.  

Even if you have customized the colors and names of labels, the values 1 through 9 are written 

into the Urgency field in order to comply with the IPTC annotation standards. If the Urgency 

field is important to your workflow, you might customize the label names to match the standard.  
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Light Table mode 

Light Table mode is the best way to view an image or compare up to six different images at one 

time. 

The default display of the Light Table is the chosen number of images shown in a Grid layout 

(2x2) with a toolbar for each image. The toolbar shows the color label, file name, dimensions 

and scaling percentage of each image. The toolbar also displays buttons for trashing or removing 

images, rotation, and display size. 

When you have more than one image showing in the Light Table, try using the Landscape, 

Portrait, or Grid layouts (shortcut keys are L, P and G, respectively) to use your monitor space as 

efficiently as possible. The layout that works best for you depends on the orientation of your 

images, how many images you want to view at one time, and whether you want to see the toolbar 

and/or the histogram. You might want to hide the toolbar to maximize the viewing area for each 

image (shortcut key is T). 

 

 

Images in the Light Table 

 
To enter Light Table mode  

1. Select between one and four images in List View or Thumbnail View. 

2. On the View menu, click Light Table. 

Note: When you first launch the Light Table, the Help menu appears, showing the 

navigation and keyboard shortcuts. Click the menu to close it. If you need to open it again 

to view shortcuts, right-click (Windows) or CTRL-click (Macintosh) anywhere in the 
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window and, in the context menu, click Shortcuts. For a list of all Light Table keyboard 

shortcuts, see ―Appendix A: Keyboard Shortcuts.‖ 

 
To remove an image in Light Table mode 

Click the Trash/Remove menu at the bottom-right of the Light Table, or right-click 

(Windows) or CTRL-click (Macintosh) and do one of the following: 

 

 To delete the image from the catalog and move the original file to the trash or recycle 

bin, click Move to Recycle Bin (Windows) or Move to Trash (Macintosh).  

 To delete only the image from the catalog but have it still remain in its original 

location on your hard drive, click Remove from Catalog.  

 
To mark an image in Light Table mode 

Position the cursor over the image that you want to rate (if you have more than one image in the 

Light Table) and press numbers 1 through 9 to set a label (or 0 [zero] to remove a label).   

 

To adjust the image size  

In the Size menu at the bottom-right corner of the images, click a display size option. To zoom in 

or out on an image, press the PLUS (+) or MINUS (-) keys. With the Scroll Lock key on, all 

images will increase and decrease by the same magnification. With the Scroll Lock key off, only 

the scale of the active image will be adjusted. 

Scroll, Scroll Lock, and Zoom 

When an image is bigger than the window it is in, the cursor will turn into a hand, which you can 

use to move the image by dragging.   

When more than one image displays in the Light Table, all images will be moved simultaneously 

while Scroll Lock (keyboard shortcut: S) is on. If any of the images do not move when scrolling 

in this way, it is probably because they fit the current window and there is no more of the image 

to show. 

With Scroll Lock off, you can move only the image under the cursor by dragging. The Scroll 

Lock key is useful when examining an important area of similar images. 

By zooming in and scrolling to the part of an image you are interested in, the other displayed 

images will show the same portion of the image. 

If the images are not absolutely identical, you might need to turn Scroll Lock off and move the 

image individually. Remembering the keyboard shortcut (S) for the Scroll Lock makes viewing 

similar images much faster. 

Next and Previous images 

The RIGHT or DOWN ARROW key changes the image in the Light Table to the next one in the 

catalog. Use the UP or LEFT ARROW key to change to the previous image in the catalog.   
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When there is more than one image on the screen, the image that is changed is the one your 

cursor is hovering over. When changing the image using the cursor keys, the current zoom and 

scroll positions are maintained to make it easier to examine the same point on similar images. 

Pixel magnifier 

The pixel magnifier is a floating panel that shows a close up of the image area underneath the 

cursor. To select the pixel magnifier, use the M keyboard shortcut. The pixel magnifier can be 

quicker than zooming and scrolling, particularly when there is more than one area in any 

particular image that you need to examine closely. 

The slider controls how far the magnifier zooms in. There are four settings from the least 

magnified at the bottom, to the most magnified at the top. The slider snaps to one of these four 

settings.  

The pixel magnifier also shows the X/Y coordinates of the cursor (highlighted by a green 

square), as well as the RGB color values. 

Using the Histogram and Exposure warnings  

A histogram is a graph showing the relative distribution of Red, Green and Blue pixel densities 

in an image. It shows the number of pixels with high density on the left (darker colors) and low 

density on the right (lighter colors). Its purpose is to show the distribution of tone throughout an 

image.  

 
The histogram 

 

When viewing images, you might want to view the Histogram and Exposure warnings for each 

image. 

For example, an image with no shadows will have a histogram with a valley on the left, while a 

histogram with no highlights will have a valley on the right. You can see dark shadows as a peak 

of all three colors to the left and bright highlights a peak of all three colors of the right.  

In the image, the exposure warnings show areas of potential overexposure as solid red and show 

under exposed areas in solid blue. Those over exposed and under exposed areas of an image 

generally lack detail due to too much or too little light being captured.  

In some cases, the areas indicated as being over or underexposed might appear exactly as you 

want them to, so you may not want to edit them. Use the histogram and exposure warnings only 

as a guideline to help you make a decision about whether an image is good or can be improved. 
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You can adjust the sensitivity of the exposure warnings to account for your own photographic 

techniques or preferences. 

Knowledge of digital image editing techniques will help you know what to look for when using 

both of these tools. For more information, read the documentation provided with your image-

editing software. 

To launch the histogram and exposure warnings 

While you are in the Light Table view, press H to show/hide the histogram; press W to show the 

exposure warnings. 

 
To adjust Light Table exposure warnings 

1. On the Edit menu, point to Preferences, and then click Media Rendering.  

2. Click the Images tab.  

3. In the Media Rendering dialog box, select the exposure you want in the Light Table 

Warnings section.  
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Chapter Six: 
 

Organizing Catalogs 
 

 

Expression Media gives you many options for categorizing and optimizing your catalog. Your 

catalog functions as a window to all of your files. Expression Media gives you the power to 

organize your files any way you like so that your view of your files is completely customized 

according your workflow or storage needs. 

Moving media in catalogs  
To rearrange items in a catalog, you can drag and drop and them, singly or in groups, or you can 

use other move options available on the View menu. 

 
To move media in catalogs 

1. In List View or Thumbnail View, select the file or files that you want to move. 

2. You can either drag the files to a new location in the catalog, or you can choose one of 

the following commands in the View menu: 

 Move to Location  Moves your selected files to a different location in the catalog. 

When you choose this command, the cursor becomes a crosshair. Place the crosshair 

at the location where you want to move the files, and then click. 

 Move Again  Repeats the last move you made in a catalog, whether it’s to the top or 

bottom location. Alternatively, you can drag the item to move it. 

 Move to New Catalog  Creates a new Expression Media catalog with the selected 

files. This command will not remove selected items from the current catalog.  

The Organize panel 
The Organize panel has two windows: Catalog Fields and Catalog Folders. To show or hide the 

Organize panel, click the Organize button on the toolbar. Drag the divider to adjust the size of 

the two windows.  
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The Organize panel 

Catalog Fields index 

The Catalog Fields index is useful for global searches or groupings, allowing a quick comparison 

across hundreds of files, often revealing annotation inconsistencies among a large number of 

files. By viewing your media from a global rather than an individual perspective, you can make 

sure of the standardization and accuracy of annotations across your media.  

 

To expand a field, click the arrow next to its name. 

 

The Catalog Fields index lists all annotations or tags present in the catalog. By dragging media 

items and dropping them on the existing data values, you can assign these values to the multiple 

media items. This significantly speeds up and simplifies the annotation process. 

 

The Catalog Fields index has two types of groups. Read-only groups, such as File Type and 

Import Device, are attributes that are automatically read by Expression Media and cannot be 

reassigned. Annotation groups, such as Date Finder or Keywords, are used to categorize the 

media and can be changed at any time. 
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To show or hide fields in the Catalog Fields index list 

1. On the upper-right corner of the Catalog Fields pane, click the Configure List  

button. 

2. Select or clear the accompanying check box for each field that you want to show or hide. 

See the following sections for definitions of each of the fields. 

The Catalog Fields index has three sections, as described below. 

Basic Fields section 

The following categories are in the Basic Fields section: 

 

Label and Rating  Use this group to show files with a color label or star rating. 

 

Sets  Catalog Sets are a free form, hierarchical method of organizing media files. You can use 

sets to organize play lists, photo albums, projects, or work assignments. 

 

Date Finder  When you add files to your catalog, Expression Media searches for dates already 

embedded in the media. It looks in the following order: 

 

1. IPTC Date Created  

2. Digital camera Capture Date (EXIF)  

3. The File Creation Date 

 

Note: If a file has all three dates, Expression Media uses the IPTC Date Created as the primary 

date for display in this list. 

 

You can adjust the date assigned to a file by dragging a file onto a different date field. This 

assigns the new date to the IPTC Date Created and does not alter the Capture Date or File 

Creation Date for the media file. 

 

You can reassign the digital camera (EXIF) Capture Date by using the Set Capture Date 

command on the Action menu. This operation applies only to images taken with digital cameras. 

If the date you want isn’t available in the list, use the annotation field drop-down menu to add a 

new date. This menu also provides you with the option to remove a date from the list. Removing 

a date will not only delete the date, but will delete all associated files from the catalog.  

 

Place Finder  A hierarchical display of the IPTC City, State, Country, and Location fields.  
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Media Fields section 

 
The Media fields 

 

The following categories are in the Media Fields section: 

File Type (read-only)  Shows a list of all media sorted by the file format, such as .tif, .jpg, .mpg, 

MP3, and so on.  

Import/Source Devices (read-only)  This list categorizes media by the digital device that created 

the file. Digital cameras and some scanners record this information in every image they capture 

(EXIF metadata). Media items that do not have a device assigned will not be represented in this 

list. 

Color Profiles (read-only)  Displays media that is based on the color profile (ICC) embedded in 

the media file. Media items that do not have a color profile assigned will not be represented in 

this list. Color profiles can only be assigned to files using the Manage Color Profile command 

on the Action menu, and cannot be assigned by dragging to the Catalog Fields index.  

Sample Color  A sample color is generated when a media file is imported, based on the 

dominant color of the image. To change a media item’s sample color, you can click Set Sample 

Color on the Action menu, or you can drag the item onto any sample color in this list.  
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Annotation fields section 

 

 
Annotation fields 

 

These fields give you an alternative way to assign metadata organization to your media files, as 

opposed to entering this data into the Info panel.  

 

The fields in the Catalog Fields index are all part of the IPTC/XMP and QuickTime standards. 

The standards are Title, Event, Date Created, Status, Creator, Provider, Source, Keywords, 

Categories, Scenes, Subject Codes, and Intellectual Genre. Custom annotation fields also appear 

here. 

 

Instead of assigning these annotations in the Info panel, you can create an annotation field in any 

of these groups, and then drag media files onto the field name. The annotation will be assigned to 

the item. This significantly speeds up and simplifies the annotation process. 

 

If you switch over to the Info panel, you will notice that same annotation is represented in the 

corresponding annotation field. 

 

Conversely, if you add metadata to an annotation in the Info panel, it will also appear in the 

corresponding group in the Catalog Fields index. 

Working with annotations 

Use the following options to work with annotations. 

Open/close an annotation group  Click the field label of the group.  

Add an annotation term  Select an annotation group, such as Events, and then press the plus 

sign (+) at the top of the Catalog Fields index. Type the name of your annotation term. All new 

terms are stored in the vocabulary for the respective field. 

Add an item to an annotation term  Select an item, or group of items, and then drag them onto 

an annotation term. Associating an item with an annotation term in a catalog does not affect the 

original file. 

Remove an item from an annotation  Click the dot next to an annotation term, showing only 

those files associated with it. Select an item, or group of items, and then press the DELETE key. 
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A dialog box will ask if you want to remove this item from the annotation term or from the entire 

catalog. If you switch over to the Info panel, you will notice that the same annotation has been 

removed from the corresponding annotation field. 

Locating media by fields 

Once you have assigned media to various annotation terms, you can now filter the catalog using 

the Catalog Field index.  

 

To find files that match an attribute (Date, File Type) or annotation (Events, Locations, and so 

on), click the dot next to term in the Catalog Fields index, and the corresponding files will appear 

in the active view. This hides all files that do not match the annotation or attribute, which is 

useful for finding a particular group of files that can now be batch processed, exported, 

reorganized, or printed.  

 

After you have found the files you want, on the Find menu, click Show All to reveal all the 

hidden files in your catalog. To show all files, you can also click Show All Items on the toolbar. 

Catalog sets  

Catalog sets are a free form, hierarchical method of organizing media files. You can use sets to 

organize play lists, photo albums, work assignments, or to create a complex system of 

categorization. You can also create capture sets, which display a group of images or bracketed 

exposures based on time intervals between shots.  

You can use sets to quickly display subgroups of items in a catalog, and to maintain their order, 

even after items within the sets have been moved or sorted. You can use these catalog subgroups 

in export functions, such as slide show presentations, quick searches, classifications, printing, 

and Web pages. 

Any media item can belong to more than one set, allowing catalogs to be logically organized into 

sets for different projects, clients or themes, without confusing the overall annotation or 

classification of files in the catalog. You can reorder sets to change the hierarchy of an individual 

set within the group of sets. Media items retain their set associations when you copy them from 

one catalog to another, or when you merge catalogs. Also, when you are synchronizing 

annotations, Expression Media adds a file’s set affiliation to the metadata in a custom XMP 

annotation field. For more information about syncing annotations, see ―Sync annotations‖ on 

page 47. 

 
To view sets  

Open the Organize panel by clicking the Organize toolbar button. Sets are located in the Catalog 

Fields index. 

 
To create a set  

1. Click the plus sign  at the top of the Catalog Fields index.  

2. In the dialog box, type the name of the set.  

3. Make sure that the Field menu has Catalog Sets selected before pressing OK. 
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To add media items to a set 

There are two ways to add items to a set.  

 Drag one or more media items from the catalog’s active window to the set name.  

 Select an item, and select Add Term to Selected Media Items from the set’s menu. 

When you add media items to, or remove them from a set, the set counter to the right of the set 

name updates automatically.  

 
To remove items from sets  

1. Click the dot next to the set name to show only associated set items in the active view. 

2. Select the items you want to remove from the set, and then press DELETE. A dialog box 

will prompt you to choose whether you want to remove the item from the set or the 

catalog. If you remove the item from the set, it will still remain in the main catalog.   

You can also remove items from sets by selecting Remove Term from Selected Media Items 

from each set’s menu. 

 
To display a set in a view 

1. In the Organize panel, click the dot next to the set name.  

2. On the Find menu, select the Show All command to reverse this feature, revealing all 

hidden files.  

3. You can also use the Show All Items toolbar icon to reveal hidden files. 

Once you have displayed a set in the active view, you can perform batch commands or export 

functions without affecting the rest of the catalog. 

 
To display a group of sets  

Click the higher level set in a hierarchy of sets. This will display all items associated with all 

subsets. You can also display a group of sets by clicking the dot next to each set name and 

holding down the CTRL key (Macintosh:  key). 

 
Select set items  

To select all media items associated with a set, click Select Media Items from a set’s menu. This 

is useful for selecting items without having to first display the set. 

 
To restore the catalog 

 After you sort a catalog with sets, click Show All on the Find menu. This will show all of the 

items in the catalog. You can also click the Show All Items icon on the toolbar to show all 

items. 

To create capture sets 
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1. On the Make menu, click Create Capture Sets.  

2. In the Options box, define the interval by entering the number of seconds between shots, 

and then click OK.  

Expression Media creates your Capture Sets in the Catalog Sets section of the Organize 

panel’s Catalog Fields index. To create a new set, click the plus sign (+) at the top of the 

Catalog Fields index. To add files to the set, select a file, or group of media files, and 

then drag them from the catalog’s active window to the name of the set. You can also 

reorder the sets by dragging them within the window. 

File renaming 
Good digital asset management strategy starts with having unique, meaningful file names. For 

creative professionals—who can easily produce huge volumes of media in a relatively short 

amount of time—this is particularly important. 

 

When an image collection grows past a thousand files, it is easy to have file name problems, 

such as having two images with the same name. Most digital cameras have a sequential photo- 

numbering option. With this option selected, every image will have a unique file name, such as 

DSC0211.jpg, DSC0212.jpg, DSC0213.jpg, and so on. 

 

Sequential numbers let you move files around easily without having to rename them to avoid 

duplication. Sequential numbers are also useful when you must find other photos that were taken 

at the same time or in the same place.  

 

File-naming conventions 

A well-named file includes additional information, such as the date, author, client name, project 

name, or subject of a photo shoot. It also might contain business-related information, such as 

product or part numbers.  

 

Standardizing on a particular file naming convention offers the following advantages for photo 

management workflows: 

 It is difficult to create two files with the same file name. This makes them easier to 

identify and reduces problems with duplication.  

 If you always include a standardized date in the file name, such as the Capture Date, you 

can easily locate a file.  

 With sequentially numbered files, a folder of images on your desktop is sorted 

automatically into chronological order.  

 Workgroups use the same conventions, therefore promoting consistency across the 

organization and facilitating file retrieval. 

 By looking at just the file name, you will know a lot about the image (that is, the date 

created, person who took the image, subject or client, and the order in which it was 

created).  
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 If you decide to switch image-management applications, or are running several database 

applications, important metadata can be derived from the file name. 

 

Your file-naming convention should be specific to your business and archiving needs. For a large 

catalog of stock images, you could use the Dewey Decimal or U.S. Library of Congress system 

to identify the subject of the photographs. The key is to integrate the naming system into your 

workflow so that every file is named properly before it ends up in an archive. 

 

Ultimately, if you create specific guidelines for file naming and stick to them, you and everyone 

you work with will be able to easily identify, locate, and share files.  

 

File name examples Name components 

lexus_newsletter_0904_001.tif Client name, project, publication date, and sequential 

numbering 

wegatv_KDF42WE655_012.jpg Product name, product ID, and sequential numbering 

hourmedia_040623_066.pdf Client name, 6-digit date (YYMMDD), and sequential 

numbering 

hollywood_040721_0457.jpg Subject, 6-digit date (YYMMDD), slide ID (for scanned 

images) 

smith_jones_040721_sb_0215.jpg Bride, groom, 6-digit date (YYMMDD), creator’s initials, 

sequential numbering 

job314_040727_0013.jpg Job number, 6-digit date (YYMMDD), sequential 

numbering 

20040721_P_0525.jpg 8-digit date (YYYYMMDD), subject code (Portrait) and 

sequential numbering 

 

To rename items, you can use the Date field because it uses the IPTC Date Created, the EXIF 

Capture Date, or the file Creation Date.  

 

You can adjust the date using various tags: 

MM = Month 

DD = Day 

YYYY = 4-digit year 

YY = 2-digit year 

hh = Hours 

mm = Minutes 

ss = Seconds 

For repeat use of your settings, you can save them by using the Option Sets menu. Adjust the 

zero padding by defining the number of digits for sequential numbering. 

File names are case sensitive. Change case to lowercase, UPPERCASE, or Title Case. 
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The preview window shows a list of your files before and after you rename them. 

Batch renaming in Expression Media 
To rename all selected catalog items, as well as the corresponding original files, use the Batch 

Rename function. The Batch Rename function provides four options for renaming files: Date, 

Text, Sequential Numbering, and File name. You can combine up to three options in various 

ways to create unique batch renaming instructions. 

 

You cannot rename offline catalog items, such as those on CD, DVD or removable drives. Files 

that are locked by the operating system cannot be renamed. 

 

Below are two examples of batch renaming that you might use. You can rename files 

incrementally using the date, a string of text and numbering sequence. You can also rename files 

by using search and replace. In this method, you search for text and replace it with more relevant 

information. This function is good for turning sequential digital camera file names into ones that 

match your file-naming convention, while maintaining the sequential numbers created by your 

camera. 

 

 
The Batch Rename dialog box 

 
Example 1: To batch rename incrementally 

1. Select a group of items, and then, on the Action menu, select Batch Rename.  

If you select a single image, this function will be not be available. 

2. On the Rename Options menu, select Date. This function will automatically insert the 

IPTC Date Created, the EXIF Capture Date, or the file Creation Date—in that order. 

Expression Media will display date tags, such as MM-DD-YYYY, which you can reorder 

and use different separators, such as YY_DD_MM. 
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3. Click the plus sign (+) button to add another rename option. Type a string of text. For 

example, a string might be a subject, location, or the photographer’s initials. Use text that 

will be meaningful to all files being renamed. 

4. Click the plus sign (+) button to add another rename option. On the Rename Options 

menu, click Number From.  

5. Define starting increment: An increment is the numeric value that is used to start 

sequential numbering. For example, if you type ―10‖, files will enumerate; for example, 

sb10.jpg, sb11.jpg, sb12.jpg, and so on. Incremental renaming ignores file types and will 

continue to incrementally enumerate regardless of the file type. This means that if your 

first two files are .tif files and the next two are .jpg, then they would be named 1.tif, 2.tif, 

3.jpg, 4.jpg. 

6. In the field next to the increment, define the number of digits for the sequential numbers. 

For example, if you choose a file starting increment of 8 and 3 digits, files will be named 

008, 009, 010. 

7. On the Format menu, select an option for case. 

8. Click the Rename button. File renaming should be relatively instantaneous, but might 

take a few seconds if you are renaming more than a thousand files.  

Note: Expression Media remembers the last increment used in batch renaming and automatically 

provides you with the next increment for additional batches. For example, if you renamed 50 

files, then later added more files that you wanted to rename, the Number From field would 

automatically show 51 as starting value for your next batch rename. 

 
Example 2: To rename files using Search and Replace 

1. Select a group of files, and then, on the Action menu, select Batch Rename.  

Note: If you select a single image, this function will be not be available. 

2. On the Rename Options menu, select Date.  

3. To add Rename Options, click the plus sign (+). On the Rename Options menu, select 

File name.  

4. In the Search for field, type a text string that you want to replace. In this case, type the 

string ―DSC‖ (common to digital cameras).  

5. Replace the string with a string that follows your file-naming convention, such as the 

subject’s initials or photographer’s initials.   

6. The file names are case sensitive: Select this option to restrain your search based on the 

case of the text.  

7. On the Format menu, select an option for case. 

8. Click the Rename button. Now you will have changed DSC09851.jpg into a more usable 

file name, such as 20051020_sb_nyc_09851.jpg. 

(Macintosh) There are also options to strip diacritical marks, such as accents. For example, you 

could change ―déjà vu‖ to ―deja vu‖. Stripping diacritical marks from file names is important for 

increasing file name compatibility across platforms. 
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Renaming file scripts 

You can rename a file using a script. To do this, Expression Media reads a text file that you can 

create. The script uses each line of that text file as a new name for the selected media items. 
 

To rename using a text file 

On the Scripts menu, point to Files, and then click Rename Using Text File.  

File name compatibility 

For maximum portability across Windows, Macintosh, and Unix networks and platforms, follow 

these guidelines.  

 Limit file name length to 31 characters. 

 Keep file name extensions, such as .jpg or .gif. 

 Use underscores ( _ ) to separate blocks of information, rather than using dashes or 

spaces. 

 Format dates in a 6-digit or 8-digit code. For example, July 21, 2006 should be 060721 

(YYMMDD) or 20060721 (YYYYMMDD). This will help keep files sorted in their 

proper order in the folders on your desktops and removable media. 

Batch renaming Raw + JPEG 

Expression Media does not have a specific function to batch rename Raw+JPEG simultaneously. 

However, the Expression Media batch rename feature can simultaneously rename Raw+JPEG if 

you are willing to use the original sequential numbering created by your digital camera.  

Below are two ways that you can accomplish this. 

Example 1: To rename Raw+JPEG files 

1. Import your Raw and .jpg files into an Expression Media catalog. 

2. Sort the catalog by file name. You can do this by selecting File name from the Sort 

toolbar menu. Your catalog should now have Raw and .jpg files of the same name next to 

each other. 

3. Select all items in the catalog and, on the Action menu, click Batch Rename. 

4. In the Rename Options section, select Date. This command will automatically insert the 

EXIF Capture Date for digital camera images. Expression Media displays date tags, such 

as MM-DD-YYYY- hh-mm-ss, which you can reorder and use different separators, such 

as YY_DD_MM. 

5. To add another rename option, click the plus sign (+). In the Rename Options section, 

select Text.  

6. Type a text string. For example, a string might be a subject, location, or the 

photographer’s initials. Use text that will be meaningful to all items being renamed. 

7. Click the plus sign (+) again to add another rename option. In the Rename Options 

section, select File name. This function appends the original file name to the new name. 

8. In the Search for field, in the Search and Replace Options section, type a text string 

that you want to remove. In this case, use the string ―DSC_‖ (common to digital 
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cameras). By doing this, you are maintaining the sequential numbers created by your 

camera. 

9. In the Preview window, Expression Media renames the Raw and .jpg files in the same 

manner. 

10. Optional: In the upper-right corner of the Batch Rename dialog box, there is an Option 

Set menu.  

This menu is useful for storing and recalling batch rename options. In this menu, choose 

Save as and name your Raw+JPEG renaming options. In this way, you can easily recall 

these settings with future catalogs. 

11. Click the Rename button.  

There is now a batch renamed Raw and .jpg files that use the sequential numbering 

created by the digital camera. 

Note: Expression Media remembers the last increment used in batch renaming and automatically 

provides you with the next increment for additional batches. For example, if you renamed 50 

files, then later added more files that you want to rename, the Number From field would 

automatically show 51 as the starting value for your next batch rename. 

Example 2: To rename Raw+JPEG files  

If you want to create your own sequential numbers when renaming Raw+JPEG files, you will 

need to run two batches—one for the Raw files and one for the .jpg files. 

1. Open the Organize panel. Show the File Type annotation group in the Catalog Fields 

index by clicking the arrow. 

2. Click on the dot next to the number of .jpg files. This will cause Expression Media to 

show only .jpg files in the catalog. 

3. Select all .jpg files and, on the Action menu, choose Batch Rename. 

4. Add the Date and Text strings, as needed. 

5. Click the plus sign (+) to add another rename option. In the Rename Options section, 

select Number from.  

6. Define the starting increment. An increment is the numeric value that is used to start 

sequential numbering. For example, if you type ―10‖, files will enumerate as sb10.jpg, 

sb11.jpg, sb12.jpg, and so on. 

7. In the field next to the increment, define the number of digits for the sequential numbers. 

For example, if you choose a starting increment of 8 and 3 digits, files will be named 008, 

009, and 010. 

8. Click the Rename button. File renaming should be relatively instantaneous, but might 

take a few seconds if you are renaming more than a thousand files.  

9. For Raw files, repeat steps 2 through 8. 

Organizing original files  

Use commands in Expression Media to transfer your original files to new locations on your hard 

drive, or to duplicate your original files. 
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To delete your files 

1. Select the files that you want to delete. 

2. Click the Move to Recycle Bin icon  on the toolbar. This removes selected files from 

the catalog and moves the originals to the Recycle Bin (Trash). Expression Media does 

not empty the Recycle Bin, so you can still retrieve the deleted files if you want.  

 
To transfer or duplicate your files 

Do one of the following: 

 

 Drag any file from a catalog into a folder in the Folders panel. This moves the 

location of a file to a different folder on your computer. The path to the file will be 

automatically updated in the catalog. 

 On the Action menu, click Transfer to Folder, and then click one of the following 

options: 

 To move media files to a new folder, deleting the original files, select the option 

Move files. Catalog items will refer to the new files in the new folder.  

 To copy media files to a new folder, keeping the original files, select the option 

Copy files. Catalog items will refer to the files in the new folder.  

 To copy media files to a new folder, select the option Duplicate files. Catalog 

items and referenced files remain unchanged. 

Action menu (Macintosh) 

The following options are available on the Action menu on the Macintosh. 

 

Set Creator  Changes the four-character file creator with which the media file is associated. For 

example, it’s useful for changing files with QuickTime creator to a Photoshop creator. This will 

allow you to double-click the files and open them with Photoshop.  

 

Desktop icons  Used for easy identification of files within the application or in the Finder. This 

will replace generic desktop icons with image icons of original files.  

 

Media Thumbnails  Exports and embeds a small thumbnail into original referenced files outside 

of the catalog. This preview can be read by a number of media editing applications that use built-

in thumbnails in their opening dialog for quick identification.  

 

Lock Status  Locks or unlocks files in the Finder.  

 

Delete Resource Fork  Removes the resource fork, which can contain thumbnails, icons, and 

various metadata from a media file. 

  

On the File menu, in the AppleScript command: 

The Set File Comment saves the Caption field inside the file’s comment field. The 

comment field is visible in the Finder and in the Get Info window of the original files. When 
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the operating system indexes your files, your media file captions are then included in the 

Spotlight search index. 

Catalog Folders 
Expression Media offers advanced folder management to enhance your workflow and provide 

direct control over your file system. Catalog Folders occupies the lower section of the Organize 

panel, which you can access by clicking the Organize button on the toolbar.  

 

As with the categories in the Catalog Fields section, to display the files in a folder, you can click 

the dot next to the number for each folder, or, in the contextual menu of the folder, click Select 

Media Items. 

 

 
The Catalog Folders panel 

Using folder watching 

You can enable catalog-wide folder watching to monitor folders that contain media within your 

catalog. You can either set up Expression Media to watch any number of folders and alert you 

when new media items appear in them, or you can have Expression Media automatically import 

any new items into your catalog. For more information about folder watching, see ―Using folder 

watching‖ on page 75. 

Additional folder functions 

The following options are either available on the contextual menu for any folder that you select 

in the Catalog Folders section, or are general tips for working with folders and displaying or 

manipulating content. 

Context menu options 

Following is an explanation of the options available in the contextual menu for catalog folders: 

 

 Remove from Catalog  Removes a folder and its contents from the catalog, but not 

from the hard drive. 

 Reset folder path  If you have moved a folder of files to a new location, but the 

catalog still thinks it resides in the old location. This command is much faster than the 
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Reset Paths command on the Find menu, but assumes that the contents of the folder 

in question have not been reorganized.   

 Select folder items  In the contextual menu, select all media items associated with a 

folder, and then click Select Media Items in a folder’s menu. This is useful for 

selecting items without having to first display the folder’s contents. 

 Open Folder in X  Reveals folders and its contents on the desktop. 

 Create sub-folder  Creates a new folder on the desktop. You can name it from the 

Catalog Folders section. 

 Move Folder to Trash  Removes files and folders from the catalog and hard disk. 

Moves files and folders to the desktop Recycle Bin (Trash), but does not empty it. 
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Chapter Seven: 
 

Finding and Sorting Media in Catalogs 
 

 

In open catalogs, Microsoft Expression Media offers a number of ways to find and sort media 

files, as well as related files, media, and tag attributes.  

Searching your catalog 
You can search catalogs quickly and accurately in Expression Media. You can perform a quick 

search in the active catalog directly from the search box in a catalog toolbar, or you can perform 

a more detailed search using the Find command. Searching is case insensitive and includes all 

annotations (EXIF, IPTC annotations, descriptions, and so on), media fields, and catalog set 

names.  

 

After you have searched and have found the items you want, on the Find menu, choose Show 

All to show all the items in your catalog. You can also click the Show All Items icon on the 

toolbar. 

 

 
The Find dialog box 

 
To quickly search the active catalog 

Type the word or words in the search box in the catalog toolbar, and then press the RETURN or 

ENTER key, or click the search  icon.  

 
To search catalogs using the Find command 

1. On the Find menu, click Find.  

2. In the Find items in field, select front catalog to search the active catalog, all open 

catalogs to search each any of the catalogs you have launched, recent catalogs to search 

catalogs you have opened recently, or all catalogs in a particular folder.  

3. To refine your search, use the choices in the menus to specify particular file 

characteristics to search for. Type the word or words that you want to search for in the 

search box. To add or subtract search criteria, use the plus (+) and minus (-) buttons in 

the upper-right corner of the dialog box. To use Boolean search criteria, choose and or or 

in the respective field. 
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4. To customize the results of your search, choose one of the following options from the 

menu in the lower-left corner of the Find dialog box.  

 Find next highlights the first item that meets your search criteria.  

 Select all selects items that meet your criteria.  

 Show all hides all items in the catalog that do not meet your criteria.  

 Show all in a new catalog places all matching results in new catalog.  

5. To save your search, click the icon in the upper-right corner of the Find dialog box. 

Searches can be saved for later recall on the field in the upper-right corner of the Find 

dialog box.  

6. Press the RETURN or ENTER key.  

Filtering and sorting by metadata 

Use any of the below methods to sort and display your files according to their metadata or file 

attributes. 

 
To filter files using the Organize panel   

1. On the toolbar, click Organize. 

2. Do one of the following: 

 To display items that match an attribute (date, media format) or annotation (events, 

locations), or that are all in a particular set, click the dot next to the field name in the 

Catalog Field index of the Organize panel. CTRL+click (Windows) or +click 

(Macintosh) to select multiple attributes or annotations. The dot turns green once 

Expression Media uses the filter. 

 To display files according to their location on your computer or removable disks, 

click the dot next to the appropriate folder name in the Catalog Folders section of the 

Organize panel. The dot turns green once Expression Media uses the filter.  

Note: You can also display a group of sets or folders by right-clicking (Macintosh: 

CTRL-click) each folder or set name and choosing Show Media Items from the menu. 

3. Use the Configure List button   to show or hide various media attributes and 

annotations that you can use for sorting functions in the Organize panel. 

 
To sort files according to attributes  

1. On the toolbar, click the Sort button. 

2. Choose criteria to sort the media items.  

3. To return to the organization method of the last saved version of the catalog, click 

Default. 

 
To show labeled or rated files 

On the Find menu, click either Show Labeled to show only those items that have been marked 

with a color label in your catalog, or click Show Rated to show only those items that have been 
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marked with a star rating in your catalog. The Show Labeled option is also available in the Slide 

Show controller. 

 
To sort by column in List View 

Click the corresponding label in the header bar above the media viewing area. To invert the sort 

order, click the arrow on the far left of the header bar.  

 

 
The Show Similar Items dialog box 

 
To show similar items 

1. On the Find menu click Show Similar. 

2. Drag the Matching slider to set a matching tolerance. 

3. Select any of the following options to refine your search. You can use any combination to 

refine your search. 

 Select Ignore brightness to remove image brightness as tolerance criteria. 

 Select Match items with similar names only to confine the search to items with 

similar names. 

 Select Match selected items only if, in a view, you had selected a particular set of 

media files to filter.  

4. Click Show. 

 

To show the most recently imported files 

On the Find menu, click Show Last Import. This feature is useful if you are downloading 

multiple media cards and you want to view only items from the previous import. 

 
To restore your catalog to display all files 

Do one of the following: 

 Click the Show All Items  icon. Or, you can use the state arrows to navigate back and 

forth among various states that your catalog has shown during the searching and sorting 

process in the Organize panel. 

 Click the State Arrows at the top left of the toolbar to navigate back or forward to a 

previous display state. 
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Filtering by multiple terms 

There are several ways to use the Organize panel for complex catalog filtering and sorting using 

multiple metadata terms. You can filter either by intersecting terms, which enables you to 

display media items that have both ―keyword A‖ and ―keyword B‖ attached to them, or you can 

filter by a union of terms, which enables you to display all media items that have either 

―keyword A‖ or ―keyword B‖ attached to them.  

To display files with intersecting terms  

1. Open the Organize panel, and then expand the Keywords group. 

2. In the List Configuration menu at the top-right corner of the Organize panel, make sure 

that there is not a check mark next to Union of Terms in Repeating Fields.  

3. In the area for the ―keyword A,‖ click the gray oval to right of the keyword name that 

contains the number of catalog items associated with that keyword. When you click this 

gray oval, a green dot should appear, and the items associated with that keyword should 

be displayed in the active view. 

4. Hold down the CTRL key (Macintosh: the  key) and then click the gray oval next to the 

keyword you want to ―intersect‖ with ―keyword A.‖ A green dot should appear in the 

gray oval for this keyword as well. 

5. The final display should contain only images that have both keywords, ―keyword A‖ and 

―keyword B.‖ 

Note: The Union of Terms in Repeating Fields function applies only to metadata fields that 

have multiple terms. These are Keywords, Categories, Contacts (People), Scenes, and Subject 

Codes. Otherwise, all selections in the Organize panel that span multiple metadata fields or 

groups will be intersections. For example, if you clicked the .jpg file type, the year 2006 in the 

Date Finder, and the keyword ―activities,‖ the result would be an intersection of those terms. 

Union of terms 

To display all media items that have ―keyword A‖ and all media items that have ―keyword B,‖ 

repeat the intersection instructions, but instead, select Union of Terms in Repeating Fields in 

the Organize panel’s List Configuration menu. You do this by selecting the keywords on the 

List Configuration menu. 

Handling a hierarchy of terms 
In the Organize panel, some metadata fields have terms displayed in a hierarchy. In other words, 

these terms consist of a heading, followed by the items that correspond to that heading. These 

terms include Catalog Sets, Catalog Folders, Date Finder, and the Place Finder. For example, the 

Date Finder term lists your photos in a hierarchy according to year and month. By default, you 

can only filter your photos by the lowest term in the hierarchy, which in this example, is by day. 

A key option named Union of Field Hierarchies, located in the List Configuration menu in the 

Organize panel, enables you to expand your filtering opportunities by allowing you to filter items 

according to the higher hierarchies. 
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Date Finder hierarchy, without the Union of Field Hierarchies option selected 

 

If you do not select the Union of Field Hierarchies option, the Organize panel displays only the 

number of media items associated with each sublevel of any hierarchical metadata group, 

including Catalog Sets, Catalog Folders, Date Finder, and Place Finder.  

 

For example, suppose you have 100 photos that you took on varying months in 2006 and you 

want your catalog to display only those photos. Without the Union of Field Hierarchies option 

selected, you will have no way of filtering your images according to year—you can only filter by 

the lowest term in the hierarchy, which is the date.  

 

However, if you select the Union of Field Hierarchies option, the higher levels of any 

hierarchical metadata group in the Organize panel will display the aggregate number of media 

items associated with any sub-levels of the hierarchy. Therefore, you can then filter your photos 

by year, as well as by other levels of hierarchy above date, such as month. 
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Date Finder hierarchy, with Union of Field Hierarchies option selected. Note the sum of files 

in a particular category is now in parentheses, and that you can filter files by that 
category. 

 

If you want to execute the same command from the Catalog Folders panel, then, on the 

Configure Folder Watching menu, click Union of Folders Hierarchies. 

 

In some hierarchies, such as Catalog Folders or Catalog Sets, when you set the Union of Field 

Hierarchies or Union of Folder Hierarchies options, the panel displays two numbers. The first 

number represents the number of cataloged items that are stored in that folder or set. The second 

number is in parentheses and it represents the number of cataloged items stored in all subfolders 

or subsets. 

 
To select or clear the Union of Field Hierarchies option 

Do one of the following: 

 To select the Union of Field Hierarchies option for the Catalog Fields, on the 

Configure List menu, click Union of Field Hierarchies to select or clear it.  

 To select the Union of Folder Hierarchies option for the Catalog Folders, on the Folder 

Watching menu at the top of the Catalog Folders pane, click Union of Folder 

Hierarchies to select or clear it. 

 

Finding and managing original files 

Within Expression Media, you generally use metadata and image characteristics to sort and 

display files, however there are also tools that you can use to manage your files according to file 

characteristics such as file name and file path. You can use these tools to help you locate 

duplicate files, locate missing files, or modify file paths.  
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Expression Media defines duplicate files as two or more items that reference the same file path. 

Missing files are catalog items whose stored file path doesn’t correspond to an image because 

you may have moved, renamed, or deleted the original image. In this case, the full size image in 

Media View will no longer be available and an error message appears in red text in the header 

bar, or the last available file path will be in red.   

 

Note: If you have imported two identical files that have different file paths, then Expression 

Media does not recognize these as duplicate files, but rather as similar files. To locate these types 

of files, use the Show Similar feature. For more information about this feature, see ―Filtering and 

sorting by metadata‖ on page 78. 

 
To locate duplicate items 

1. On the Find menu, click Find Duplicate Items.  

2. If you have no duplicates in your catalog, then you receive a message telling you this. 

However, if you do have duplicates, in the resulting dialog box, click Show to view the 

results of the search, or click Clear Duplicates to sync the duplicate items with the file 

path, thereby removing the duplicate from the catalog. 

 
To locate missing items 

1. On the Find menu, click Find Missing Items. 

2. If you have missing items, a dialog box appears containing the number of missing items. 

Click Search to navigate to the missing items if you know where they are now located, or 

you know what they are now named. An alternate way to do this is to use the Reset Paths 

feature, described below. Click Remove to delete them from the catalog. 

 
To reassign or modify a path 

1. On the Find menu, click Reset Paths. 

2. In the Reset Paths dialog box, reassign or modify the path, for one or more items.  

3. Navigate to and select the folder or directory where the file(s) now reside.  

Expression Media displays each file in a window for you to confirm each file’s path 

restoration.  

4. If you have a group of files, and you are certain that all the new paths are correct, you can 

choose the Accept All button to avoid having to confirm each to a new path.  

5. If you have simply moved or renamed an entire folder or disk, it is much faster to use the 

Reset folder path command in the Catalog Folders pane of the Organize panel. 
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Chapter Eight: 
 

Slide shows 
 

 

Expression Media enables you to view or project a slide show presentation with your 

photographs, movies, and audio soundtracks.  

 
The Expression Media Slide Show feature enables you to sequentially present your files using a variety of 

transitions and displays. 

Slide show basics 
The Slide Show feature in Expression Media offers a way for you to display a succession of 

images and movies, as well as play audio. You have full control over the transition between files, 

as well as which files play, how they transition, and, if applicable, the amount that displays or 

plays at one time. The slide show can function as anything from a preview tool, to a way to 

construct a complete, stylish movie of your media collection since, if you want, you can save 

your slide show as a movie file that you can distribute. 

Slide show features 

By default, the Slide Show feature is set to run with cut transitions and to cycle through your 

collection. You can run a slide show at any time. When you start a slideshow, a floating slide 

show controller appears. Use the options on this controller to adjust all the aspects of your slide 

show. 

 

Following are some of the features of a slide show: 
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Audio  Expression Media slide shows can contain a single, background audio channel. Sound 

items included in a catalog are always queued into the audio channel. If you place an audio file at 

the beginning of a slide show of images, the audio plays during the presentation. 

Video  Expression Media slide shows can display up to 16 video channels. All media types 

(including images or movies) play in one or more video channels, depending on your grid 

selection. 

Grids  These are the arrangement of video channels, in full-screen, quarter-screen, or a variety of 

other options. Unless you are using a computer with a powerful processor, using the slide show 

with more than one video channel will place considerable strain on your computer and degrade 

playback. Experiment with Half or Quarter video channel grids first before choosing more 

complex grids.  

Timing  Expression Media lets you specify how long still images will appear in the presentation, 

however, movies always appear for their full duration. To adjust the timing of images (in 

seconds), use the up or down arrows next to the green number on the right hand side of the 

controller. 

Transitions  Expression Media offers several options to adjust the transition effect between 

images. There are 10 different slide show transition effects, such as Cross Fade, Barn Horizontal, 

and Radial wipes, as well as a Random effect option.  

Effects defined in the Transitions menu of the slide show controller apply globally to all images 

of the slide show.  

Size of Media  To adjust the size of on-screen media, use the Scale menu of the slide show 

controller. You can enlarge or reduce the size of your images with the Zoom In/Zoom Out 

keyboard shortcuts, plus (+) and minus (–). This setting will apply globally to all images of the 

slide show.  

Slide show options 

You can set the Slide Show options before you run the slide show.  

 

As you run the slide show, a controller appears that you can use to set the global options for the 

slide show and, in addition, set options for each image in the slide show. For information about 

using the Slide Show controller, see ―Slide Show controller‖ on page 87.  

 
To set the Slide Show options 

1. On the Make menu, click Slide Show Options. 

2. Set the options according to the below guidelines, and then click OK. 

General options 

Below are the general options that appear in the Slide Show Options dialog box.  

 Duration  Specifies the flip speed in seconds for each slide. The duration applies only 

when the slide show is run in non-interactive mode. Movies and sounds default to their 

own duration. The duration can also be overridden by timings set for individual media 

items. 
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 Color  Changes the background color of slide shows. The default is set to black. 

 Transition  Expression Media offers a basic set of QuickTime effects that can be used 

during slide show media transitions. The duration of the transition effects (1 second) is 

currently fixed. This setting will affect all media items, unless you define them in the 

Slide Show controller.  

 Media Scaling  Choose an option from this menu to control the scale or size of media 

items. You can set this option before or during an active slide show.  

Stage options 

Choose a Stage Grid option to design the look of your slide show. 

 Stage Grid  Choose an option to run your slide show at full screen, or divide your slide 

show into several different cell arrangements.  

 Custom Grid (Macintosh) Click this button to design a custom slide show grid template. 

Playback options 

Select one of these options to control how your slide show plays back. 

 Interactive  Use this option with the LEFT and RIGHT ARROW keys of your keyboard 

to manually advance or go back in your presentation. The UP and DOWN ARROW keys 

work the same as LEFT and RIGHT ARROW keys.  

 Continuous  This is the default for Expression Media slide shows. Images will appear 

onscreen for the specified duration, and then automatically advance to the next image. 

Movies will appear onscreen for their full duration, and then automatically advance. You 

can use the SPACEBAR to Pause or Play a slide show in Continuous mode. The LEFT 

and RIGHT ARROW keys will manually override the pace of your presentation. 

 Random  Expression Media randomly chooses images and movies to present onscreen. 

Other presentation options 
Here are some additional options that you can use to create visual effects during a presentation. 

 Margin between grid cells  Adds a few pixels of background color to help separate 

items from each other in multi-file grid arrangements.  

 Play voice annotation  Plays any attached voice annotation whenever a media item is 

loaded.  

 Play sound from all movies  Plays all the available movie audio tracks simultaneously. 

This option is only useful when you intend to play multiple movies in a grid arrangement. 

If this feature is disabled, Expression Media plays only the background sound channel, as 

well as the active movie soundtrack.  

 Fade In (Macintosh)  Fades the start and end of shows.  

 Show controller  Displays the slide show controller during the slide show. To hide the 

controller, use the ESC or RETURN keys. 
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Viewing the Slide Show 
You can run the Slide Show at any time during your work. If, as it runs, you want to vary the 

playback, you can do so while you are in Slide Show mode.  

 
To run a slide slow 

1. Do one of the following: 

 Click the Run Slide Show button  on the toolbar 

 On the Make menu, click Run Slide Show 

 In the Slide Show Options dialog box, click Run Slide Show  

2. To exit during the slide show, click the ESC key or double-click on a Slide Show image. 

You can also click the Exit Slide Show button  on the Slide Show controller. 

Slide Show controller  
The Slide Show controller panel lets you adjust options during a slide show presentation. Though 

you can set the same global options that you set in the Slide Show Options dialog box, the Slide 

Show controller also enables you to set individual playback options for each of the files that 

display so that you can further customize your slide show. You can change any option even as 

the slide show plays. 

This panel is also useful for running presentations on a second screen or projector. If you use 

multiple monitors, position your catalog inside the monitor you want to use for the slide show. 

You can start the presentation on that monitor and keep the controller on the other computer.  

If you are not using two monitors, displaying the slide show controller on top of the slide show 

stage will impair viewing. 

 To show or hide the controller, press ENTER or RETURN. 
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Slide Show controller 

1) Adjust volume; 2) Exit Slide Show; 3) Slide Show options; 4) Playback controls; 5) Adjust time between 

transitions; 6) Show/Hide files; 7) Playback options; 8) Filtering options; 9) Scroll lock 

Setting Slide Show options from the controller 

The controller contains menus that enable you to set global options for your slide show. These 

options are the same as the ones that you can set in the Slide Show Options dialog box. For 

details about these options, see ―Slide show options‖ on page 85.    

 
To access the options 

Do any of the following: 

 On the Set Options menu , locate the option category that you want to set and then 

select an option 

 On either the Set Transitions menu  Set Scaling menu  or Set Grid menu , 

select an option to apply to the entire slide show 

 
To lock the scrollbar 

Click the Scroll Lock icon in the controller. This prevents the display of files from scrolling as 

the slide show plays.  

 
To adjust the volume of playback 

Click the arrows to the left of the speaker icon in the controller. 
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Setting and viewing options for individual files in the Slide Show 

Within the controller, you can set playback options for each one of the files. You can also assign 

labels and ratings, set what text appears in the slide show, and which category of files plays in 

the slide show. You can set options or view information as the slide slow plays, or you can pause 

the show. 

 

 
1)  Use these menus to set global options; 2) Use these menus to set options for this individual file;  3) Use this 

menu to set the timing options for this file. 

 
To set playback options for individual files 

1. In the list of files, click the file that you want to adjust. 

2. Click the box aligned with the option menu corresponding to the option that you want to 

adjust. For example, if you want to adjust the size of the image, click the box aligned 

underneath the Set Scaling menu, and corresponds with the file that you want to adjust.  

3. Set the option. The next time the Slide Show reaches this file, it will exhibit the 

characteristic that you specified. When you set a transition for an individual file, you are 

setting how the previous file transitions into the selected file. 

 
To set the timing for individual files 

1. In the list of files, click the file that you want to adjust. 

2. Click the Timing menu (see the above graphic) and click an option according to the 

following descriptions: 

 Default (use global timer) uses the display time between files that you set in the 

timing selector at the top of the controller. 

 Display for set duration assigns a special duration for the file to display. Once you 

click this option, use the arrows that appear to the right of the filename to designate a 

display time, in seconds. 

 Hold slide show until sound finishes pauses the slide show at this file until an audio 

file, such as an audio annotation, plays completely. 

 
To show a subset of files 
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At the bottom of the Slide Show dialog box, click the button corresponding to the type of files 

that you want to show and do any of the following: 

 On the Show Rated menu , click a rating to show only files with that rating.  

 On the Show Labeled menu , click a label color to show only files with that label. 

 On the Show Sets menu , click the name of the set that you want to display.  

 To show all of the files again, click the Show All button . 

 
To designate the text that appears in the slide show 

1. Click the Text tab. 

2. Do any of the following: 

 Select any of the Display options to display the text related to that option. Click the 

arrows to cycle through all the available information 

 To set the color of the text, click the Color swatch and choose a color. 

 To right align, center, or left align the text, click the corresponding Align button. 

 On the Font menu, click one of the font options. Drag the slider to set a font size. 

 
To set a label or rating 

Do one of the following: 

 To set a label, click the Files tab, click the banner to the left of the file name, and 

click a label color. 

 To set a rating and a label, click the Info tab and, next to the thumbnail of the file, 

click the swatch to assign a label and click the ―plus‖ marks next to swatch to set a 

rating. 

 
To view file information 

1. Click the Info tab. 

2. Click the arrows at the bottom of the dialog box to cycle through the file information. 

Keyboard shortcuts 

Expression Media offers a complete set of shortcuts for keyboard and mouse navigation of slide 

shows. For a list of these shortcuts, see Appendix A. 

Save a slide show as a QuickTime movie 

Expression Media provides the option to save a slide show as a QuickTime movie, so you can 

distribute a catalog of images as a movie (with transitions and timing) without the Expression 

Media application.  

You can play a QuickTime movie by using the Apple QuickTime Player on both Macintosh and 

Windows computers.  

Slide shows can be saved with any grid, as well as generic and individual transition effects and 

timings.  
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To create a QuickTime movie slide show 

1. On the Make menu, click Save Slide Show as Movie.  

2. In the dialog box, define the movie dimensions or select from a pre-defined set of 

industry-standard sizes.  

3. To control the background color, global slide duration (timing), and transition effects, on 

the Make menu, click Slide Show Options. 

Expression Media offers a range of playback options when running QuickTime Player. 

For example, select the box to switch on Auto-Start and Full Screen Mode options. 

These options will have your movie played back in full-screen mode automatically when 

you double-click the movie file on the desktop.  

4. If you select the Include chapter track option, QuickTime displays each file name in a 

menu below the movie. 

Making slide shows faster 

In most cases, two factors affect the speed of slides shows: grids and media file size. 

Grids  Unless you are using a computer with a powerful processor, slide shows with more than 

one video channel will place considerable strain on your computer and degrade playback. 

Experiment with Half and Quarter video channel grids first before choosing more complex grids. 

File size  On computers with slower processors, a slide show of 20-MB image files will run 

much slower than a slide show with 1-MB image files. What slows down Expression Media is 

not necessarily the file size, but the actual dimensions of the media. With larger dimensions, 

Expression Media has to dynamically shrink the image to fit the screen. If the image is the same 

shape as the screen (4:3 proportions) the delay is not too noticeable. But for portrait images 

(vertical), the delay can be a few seconds. 

Slide shows on slower computers  If you are having display or audio issues with your slide 

show, it might be asking too much of your computer’s processor or video card.  

Another solution is to create temporary copies of your images that are optimized for fast 

onscreen display. You can do this by using Convert Image Files on the Make menu. Following 

are the parameters that can help. 

 Size  Match your screen dimensions (for example, 1024x768). That way, Expression 

Media won’t have to resize the image. 

 Setting  Match your monitor’s color depth, such 16-bit or 24-bit (Macintosh: Thousands 

or Millions). This will reduce processor usage. 

 Resolution  Use 96 dpi (Macintosh: 72 dpi), the same as your screen resolution. 

 File format  Select an uncompressed format, such as bitmap (.bmp) or .pict, rather than 

.jpg. This way, the image file will not need to be decompressed on the fly during the slide 

show. 

Create a new catalog with the converted images, and your slide show will be amazingly fast. 

Adding a soundtrack to a slide show 

To add a background soundtrack, place an audio file as the first file in your catalog. 
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To add a background soundtrack to your slide shows 

1. Create a catalog of images and movies, and then organize them in the order you want 

them to appear in the slide show. 

2. Place an audio file (MP3, AIFF, and so on) as the very first file in the catalog.  

3. Make sure that the audio file is selected and then start your slide show. The music will 

continue to play throughout the slide show. 

4. When you quit the slide show by pressing the ESC key, the music will automatically fade 

out. 

5. If at any point you want the slide show to switch to a different song, just place an audio 

file at that point. Expression Media will automatically fade from the old song to the new 

one.  

If you have selected Play sound from all movies (Slide Show Options on the Make menu), 

Expression Media will also play any soundtracks in your movies, reducing the volume of the 

background soundtrack for the duration of the movie. 
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Chapter Nine: 
 

Export features 
 

 

With Microsoft Expression Media, you can export and convert your media files in a variety of 

ways by selecting options from the Make menu. 

HTML galleries  

The HTML Gallery export feature outputs an Expression Media catalog as an HTML-formatted 

Web gallery. An HTML Web gallery can look very much like a catalog displayed in Expression 

Media. The gallery can contain an index of thumbnail images which, when you click in a 

browser, will take you to a large view of the image or a QuickTime playback of your movie or 

audio file. You can use this option to create a portfolio Web site of your work. 

When you have created the gallery, you can use your own FTP software to upload the files, or 

Expression Media can upload your exported Web galleries. 

 

Important: Expression Media does not encrypt your FTP login information; therefore it doesn’t 

provide a secure method for login. To assure that you are performing a secure upload, you should 

upload your files using a third-party FTP application that is compatible with secure upload 

technologies such as SFTP (Secure FTP). If you are unsure what secure technology to use, ask 

your FTP site provider which ones they support. 

 

 
HTML gallery 

Expression Media creates all the files necessary for a Web photo gallery.  An HTML index page contains 

thumbnail images. Clicking an image opens it at full size, with the metadata displayed.  
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Expression Media offers two options for creating HTML galleries: 

 You can use a default theme to create a Web site based on the View Options of the 

Thumbnail and Media views in your catalog. Or, you can use any of the visual themes 

provided with the application. If you want to use default themes to create your HTML 

gallery, see ―HTML galleries‖ on page 93 for more information. 

 You can create your own themes. Expression Media uses a different template for the 

index and media views of your gallery, and offers a rich vocabulary that can be used to 

extract catalog information (fields, thumbnails), as well as a high-level tags for 

navigation, date, time, and so on. Creating themes requires HTML editing skills. To learn 

more about creating themes and templates, see ―Custom HTML galleries‖ on page 97. 

Create a gallery  

To create a gallery, follow these steps. 

1. Launch an Expression Media catalog of photos, illustrations, movies, or any media file 

that can be distributed on the Web.  

Expression Media will export only the visible items in the catalog. Make sure that the 

items you want to export are displayed in the media viewing area before you create the 

gallery. When you are ready, on the Make menu, click HTML Gallery. 

2. Click the Theme tab and set the options according to the below explanations. 

Site Title  This text will appear at the top of the index page in your gallery. If you do not 

want to include a title, leave this field blank. Some themes do not require a site title. 

Index Table  Customize how many thumbnails, across and down, will appear on the 

Index page in your gallery. 

Theme  Choose from a selection of preset themes, or use Default to create your Web site 

by using View Options of the Thumbnail and Media views in your catalog. If you select 

Default, make sure to choose the desired index table, Thumbnail, and Media size options. 

All other themes have pre-defined tables and media sizes that are designed for optimal 

output. You can change the options, however, some themes are written to work with 

specific defaults and altering those would produce strange results. If a produced HTML 

gallery looks incorrect, try remaking it with the default settings. 

3. Click the Settings tab, and then set the options according to the following descriptions:  

HTML Extension  Define the file extension of the HTML file names. Options include 

.htm, .html, .shtml, .asp, .php, and .xml. 

 

Output  Use numbers for HTML file names with a numerical increment (1, 2, 3) for the 

media file name.  

 

Treat captions as raw HTML  Enables you to use HTML code, such as <b></b>, in the 

Description annotation field. 

 

JPEG Quality  Select the level of compression applied to thumbnails and media images. 

Expression Media offers the option to set a custom target size for exported images. If you 
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choose a target file size, Expression Media will dynamically adjust the compression level 

in order for the exported images to meet or be less than the target size. 

 

Watermark  Expression Media exports images with a visual watermark — a secondary 

image which is overlaid on the primary image. For more information about watermarks, 

see ―Watermark HTML images‖ on page 96.  

 

Frame images  Select this option to place a 1-pixel black border around each exported 

thumbnail and media image. 

 

Embed annotations  Expression Media embeds all IPTC/XMP Core annotations into 

each exported image. 

 

Preserve color profiles  Expression Media embeds the ICC color profiles into each 

exported thumbnail and media image. 

 

Preserve EXIF/GPS metadata  Expression Media embeds the EXIF and GPS digital 

camera metadata into all exported media images. 

 

Movies  These options adjust the properties of QuickTime movies on Media pages. Auto 

Play automatically plays a movie once it’s been loaded in a browser. Continuous makes 

the movie play in a loop. Display QuickTime Controller toggles on and off the standard 

QuickTime controls for a movie. Kiosk mode hides the options to save movies and 

change QuickTime settings from within a browser window. 

 

4. Click the Server tab and set your FTP options according to the below explanations: 

Server  Type the FTP address for your server, for example, ftp.ourmedia.org. Expression 

Media stores each server that you define in a menu for quicker access in the future. 

 

User name/Password  Type the user name and password information for your FTP 

server. 

 

Folder  Type the path to the Web root folder of your account on the server. If a folder for 

your gallery does not already exist, make sure that you define the new folder in this path. 

 

Preview Settings  Type the complete URL for the exported gallery. Make sure that you 

have typed the same upload folder name that you designated in the Folder field. 

 

Skip existing image files  Select this box if you have already uploaded your gallery 

images and are simply uploading the HTML again. 

 

5. Click the Theme tab. Some themes have variables that you can type in this panel. For 

example, you might have a generic theme for your professional assignments. This theme 

might have special theme fields for you to type the client’s name, job number, and 

assignment details. This information will then appear on the exported Web pages. 

6. When you have completed creating a gallery, there are two final options to review. For 

ftp://ftp.ourmedia.org/
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Expression Media to upload an exported gallery, you must select the Upload to server 

box. Select the option Launch browser when done to have Expression Media launch the 

exported Web gallery in the system’s default Web browser. 

7. After defining your settings, click Create. The amount of time it takes for Expression 

Media to create a gallery can vary depending on the number of images, their original size, 

and the export size. The gallery will launch in your Web browser after export, if that 

option is selected. 

8. Optional. Once Expression Media has exported your gallery, a dialog box will display 

that says ―Gallery build is completed. Do you wish to upload (X) files to the server?‖ 

Click OK, and the progress bar panel will display the progress of each file as it is being 

uploaded to your server.  

Watermark HTML images 

Expression Media exports HTML images with a visual watermark — a secondary image that is 

overlaid on the primary image, and provides a means of protecting the image. This is not the 

same as digital watermarks that are implemented algorithmically and are designed to be 

invisible.  

1. Launch Adobe Photoshop (or alternate program that can create a .tif file with a 

transparent background. Expression Media will accept the .tif, .psd, .jpg, .pict, .png, 

.bmp, and .gif formats.  

Note: The .jpg format does not support transparency. Microsoft recommends using .tif 

for optimal results. 

2. Create a new file.  

For this example, it is 200-pixels wide and 50-pixels high. Make it RGB with 

Background Contents set to Transparent. 

3. Click the Type tool, and then type something with the color set to Black. 

4. Click Save. Select .tif as the format. There is no need to save alpha channel or layer info. 

5. In the next dialog box, select the compression you want, and then select Save 

Transparency. 

6. Return to Expression Media’s HTML Settings panel, and in the Set Watermark dialog 

box, select the .tif file by clicking the New Image button. 

Watermark options 

The previous instructions will create an overlay where the logo’s (or watermark’s) color is 

opaque (such as 100 percent black or white).  

 

To alter the color opacity of the logo and give it a transparent quality, adjust the layer’s 

somewhere between 50 and 90 percent. To make it a little jazzier, as in the example, add the 

following after step 3: 

1. Add a Drop Shadow filter. 

2. Set the filter color to white or black, or whichever color you want to use. 

3. For transparent quality, you can adjust the opacity in the filter dialog to 75 percent. 
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Using a drop shadow will ensure the watermark is readable, even if it falls in dark or light parts 

of an image.  

Custom HTML galleries  
By following a few guidelines, you can create custom galleries or modify existing ones so that 

your themes can better match your creativity or media. Creating or modifying theme templates 

requires that you have a good understanding of HTML. Theme templates are created from 

standard HTML and can be edited by using any HTML editor, such as Microsoft Expression 

Web or any other third-party Web design tool or text editor.  

 

The templates that make up a theme contain Expression Media HTML tags. These tags are 

placeholders and are replaced by specific text when the gallery is created. Your custom templates 

appear in the Theme menu when you restart Expression Media. An example of an HTML tag is 

iView:Catalog, which is replaced by the name of the catalog during the export process. This 

section provides an overview and guidance for creating and modifying themes, templates, and 

tags. 

  

Tip: A good way to learn to create a template is to make a copy of an existing template, rename 

it, and modify different fields or the design. 

Themes in Expression Media  

Expression Media uses themes to help organize HTML gallery templates. A theme is a folder 

containing index and media HTML templates. By storing both templates in one folder, it is much 

simpler to share a new gallery design with other users. A theme folder also contains an Assets 

folder for related HTML graphics and an image used as a preview of the theme in the HTML 

export dialog box. The preview is a 200x120 pixel JPEG named About.jpg.  

 

Expression Media stores custom themes in the user-defined plug-ins folder. On the Macintosh 

OS X, you can store themes in one of three locations:  

 ~User/Library/Application Support/Expression Media/Plug-ins/HTML Templates  

 /Library/Application Support/Expression Media/Plug-ins/HTML Templates  

 Network/Library/Application Support/Expression Media/Plug-ins/HTML Templates 

In Windows XP, you should store your themes in: C:\ ~user\Application Data\Expression 

Media\Plug-ins\HTML templates.  

In Windows Vista, you should store your themes in: C:\ ~user\ Application Data\ 

Roaming\Expression Media\Plug-ins\HTML templates.  

Within the Example HTML folder in Documentation is the All Fields theme. Copy this theme to 

one of the paths above to use it in Expression Media. 

Templates in Expression Media 

Expression Media uses templates to generate HTML galleries of your catalogs. A template is a 

basic HTML page that contains one or more Expression Media HTML tags. An Expression 

Media tag represents the part of the template that Expression Media replaces with your catalog 
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content when it generates the gallery. For more information about tags, see ―Tags in Expression 

Media‖ on page 98. 

 

Expression Media generates two types of HTML pages: index and media. The index page lists 

all, or a subset of the media in your catalog, much like the Thumbnail View. The media page is 

specific to a single catalog item and typically contains a larger image and/or information 

regarding that catalog item, much like Media View. You access the media page by clicking a 

thumbnail image in the index page. You can create templates for both index and media pages. 

Expression Media stores both templates in the same folder. The name of this folder is the name 

of the HTML gallery theme that is displayed in the HTML Gallery dialog box.  

 

Tags in Expression Media 

Tags in Expression Media control a range of functions, from media rendering and page structure, 

to navigation and extracting and repurposing metadata information. Most media tags are 

substituted by a single number or string of text that Expression Media extracts from the catalog 

data. Simply place a tag anywhere in an HTML page, and it will get substituted with content 

when the gallery is exported.  

 

For example, in the code snippet below, note the tag. When Expression Media generates this 

template, it will substitute that tag with the actual title of the Expression Media catalog file.  

 

For most tags, there are no placement rules. You can include them anywhere within your HTML 

page. There are a few exceptions, however, as described in ―Expression Media tags that should 

be placed inside HTML tags‖ on page 101. For all tags, it is imperative that the syntax and 

spelling be exactly as described in the tag tables in ―Expression Media tags by category‖ on page 

104.  

 

Two special tags to note are HTML Engine Directives and Theme Fields. These tags are called 

variable tags and they control the size of images on index and media pages and also define what 

values will display in a particular field in a dialog box. For more information about these types of 

tags, see ―HTML engine directive tags‖ on page 103.  

Custom template samples 

As mentioned earlier, the best way to learn how to create custom HTML galleries is to copy an 

existing template and modify it. However, as an introduction, use the code samples below as a 

guideline for further experimentation. 

Index page samples 

To construct an index page, you can use field phrases to mark the beginning and end of rows and 

columns that contain thumbnails of your media content. These phrases are 

(iView:IndexColStart), (iView:IndexColEnd), (iView:IndexRowStart) and 

(iView:IndexRowEnd). 

 

A simple example using the field phrases is:  
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<html> 

<head> 

<title>(iView:Catalog)</title> 

</head> 

 

<!-- iView HTML Engine Directives 

iView:InThumbSize 128 

iView:InThumbColumns 3 

iView:InThumbRows 2 

--> 

 

<body> 

<p>(iView:Catalog)<br>(iView:Index)</p> 

(iView:IndexRowStart) 

(iView:IndexColStart) (iView:Preview) (iView:IndexColEnd) <br> 

(iView:IndexRowEnd) 

</body> 

</html> 

 

When used with the defined directives—3 columns and 2 rows, this template might produce the 

following Index page: 

 
<html> 

<head> 

<title>Favorite Photos</title> 

</head> 

 

<!-- iView HTML Engine Directives 

iView:InThumbSize 128 

iView:InThumbColumns 3 

iView:InThumbRows 2 

--> 

 

<body> 

 

<p>Favorite Photos<br></p> 

<a href=”source/image1.htm”><img src=”preview/image1.jpg” 

alt=”image1” 

width=”96” height=”128” border=”0” /></a> 

<a href=”source/image2.htm”><img src=”preview/image2.jpg” 

alt=”image2” 

width=”96” height=”128” border=”0” /></a> 

<a href=”source/image3.htm”><img src=”preview/image3.jpg” 

alt=”image3” 

width=”96” height=”128” border=”0” /></a> 

<br> 
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<a href=”source/image4.htm”><img src=”preview/image4.jpg” 

alt=”image4” 

width=”128” height=”96” border=”0” /></a> 

<a href=”source/image5.htm”><img src=”preview/image5.jpg” 

alt=”image5” 

width=”128” height=”96” border=”0” /></a> 

<a href=”source/image6.htm”><img src=”preview/image6.jpg” 

alt=”image6” 

width=”96” height=”128” border=”0” /></a> 

<br> 

</body> 

</html> 

 

Media page samples 

The media page can contain the original cataloged item using (iView:OriginalURL) or a JPEG 

image converted from cataloged item using (iView:Media). When using (iView:Media), the size 

of the image generated for the Media page is controlled by the (iView:InMediaWidth) and 

(iView:InMediaHeight) directives, which need to be in the Media template. These directives, 

however, can be in any part of the media page. Below is an example of a directive code: 

 
<!-- iView HTML Engine Directives 

iView:InMediaWidth 800 

iView:InMediaHeight 600 

--> 

 

These directives would proportionally scale the images so that the maximum height of the image 

is 800 pixels and the width is 600 pixels. Also, any template that has media width and height 

directives will populate the corresponding fields in the HTML Gallery Export dialog box when 

you select the theme where the directives appear. For example, the above directives will populate 

the below corresponding fields. 

 

 
 

You can still make changes to the final size from the above dialog box without having to go back 

into the template. But be aware that changing the size might break some aspect of the Web page 

design.  

 

Here is an example of a simple HTML media template.  

 
<html> 

<head> 

<title>Catalog: (iView:Catalog)</title> 

</head> 
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<!-- iView HTML Engine Directives 

iView:InMediaWidth 800 

iView:InMediaHeight 600 

--> 

 

<body> 

<P>Simple Media Template</P> 

<P>Image:</P> 

<P>(iView:Media)</P> 

<P>File Name:</P> 

<P>(iView:Filename)</P> 

</body> 

</html> 

 

The example above contains three iView MediaPro tags, (iView:Catalog), (iView:Media) and 

(iView:Filename). During export, all three tags get replaced by the catalog name, the media 

image, and the image file name, respectively.  

Note: The media image will be a JPEG converted for the HTML gallery and is proportionally 

scaled to fit the (iView:InMediaWidth) and (iView:InMediaHeight) settings.  

Here is another example of a simple media page. The image used here will be identical to the 

original file, including format, size, annotations, and ICC profile. 

 
<html> 

<head> 

<title>Media page using an unconverted catalog image</title> 

</head> 

<body> 

<p><img src=”(iView:OriginalURL)” width=”(iView:OriginalWidth)” 

height=”(iView:OriginalHeight)”></p> 

</body> 

</html> 

Glossary of Expression Media tags 

This section contains examples of all the tags that you can use to create and modify HTML 

galleries in Expression Media.  

You can place most of the tags anywhere in the HTML code, but some special tags need to be 

placed inside HTML tags. The first set of tags below consists of those special tags. The 

subsequent tables describe the remaining tags and indicate, where applicable, if those tags are for 

media or index pages. 

Expression Media tags that should be placed inside HTML tags 

For the tags to be effective, you need to place them inside of HTML tags. 
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(iView:Running), (iView:Total)  Expression Media replaces these tags with the sequential 

number of the file being displayed and the total number of items that you exported. For example: 

Item: (iView:Running) of (iView:Total), will generate a display similar to ―Item: 5 of 10‖, where 

the numbers represent the file that you are viewing, and the total number of files available to 

view. 

(iView:Date), (iView:Time)  Expression Media replaces these tags with the date and time that 

the gallery was exported, for example: 

 
<b>Gallery Created:</b> (iView:Date), (iView:Time) 

 

(iView:Preview) (index page) Expression Media replaces these with JPEG thumbnails. In an 

Index template, this tag must be placed within a 1 row by 1 column table. For example:  

 
<table border=”10”><tr><td><p>(iView:Preview)</p></td></tr></table> 

 

Expression Media expands the table according to the number of rows and columns defined by 

the Index Table settings in the HTML Export dialog box, or by the number of rows and 

columns defined by HTML Engine Directives. 

 

(iView:Index) (index page)  The number of rows and columns in each index page is defined by 

the Index Table settings in the HTML Export dialog box. If you have an index table set at 5x4, 

and your catalog contains 100 images, Expression Media will split your index page into 5 index 

pages containing 20 images each. This tag instructs Expression Media to generate a composite 

display and links to the multiple index pages, that is, 1-20 | 21-40 | 41-60, 61-80, 81-100. This 

tag contains a blank value if only one index page is generated. This tag is optional and must be 

placed outside the table containing (iView:Preview). 

 

(iView:Media)  Expression Media replaces this tag with the media as it is displayed in the Media 

View of your catalog. If you are using the default template, this tag will export the actual media 

(image), as well as any fields you have displayed in Media View. See a media page for an 

example. 

 

 (iView:GoNext), (iView:GoPrevious)  Expression Media replaces this tag with the hyperlink 

of the next media HTML page. This tag can be placed as the link inside an HREF tag, for 

example: 

 
<a href=”(iView:GoNext)”>Next</a>  

 

 (iView:GoIndex)  Expression Media replaces this tag with the hyperlink of the referring index 

HTML page. This tag can be placed as the link inside an HREF tag, for example:  

 
<a href=”(iView:GoIndex)”>Back to Index</a>  
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HTML engine directive tags 

As mentioned earlier, Expression Media classifies Engine Directive and Theme Field tags as 

variable tags. HTML Engine Directives control the size of images on index and media pages and 

also define what values will display in a particular field in a dialog box. Theme fields are a 

variation on HTML Engine Directives. These template instructions create user-defined fields for 

text that can be typed by the gallery creator before export. 

There are two steps in employing the variable tag. In the first step you declare the ―variable 

name‖ and ―default‖ value of the variable. Expression Media uses these in the HTML Engine 

Directives section of either the index or media page. In code, the standard tag reads: 

 (iView:Variable name = “My Variable Name”  default = “Default value of 

Variable”)   

The values of this variable appear in the Theme Fields section of the HTML Gallery dialog box 

when you select the theme containing this variable. In this dialog box, the user can select the 

variable and edit the value using the Change section at the bottom of the dialog box.  

Once you have declared the variable, you can use it as a standard iView HTML tag, as in the 

following code. 

 
 (iView:My Variable Name)   

 

Expression Media replaces ―My Variable Name‖ with either the default value of the variable or 

the value that the user enters in the HTML Theme Fields dialog box.  

 

In the following table are the recognized Engine Directive tags. 

 

 

HTML engine directive Restriction Description 

iView:InThumbSize  Index only 
Defines the size of thumbnail images on 

Index pages.  

iView:InThumbColumns  Index only 
Defines the number of columns in a 

thumbnail table.  

iView:InThumbRows  Index only  
Defines the number of rows in a 

thumbnail table.  

iView:InMediaWidth  Media only 
Defines the width of media images on 

Media pages.  

iView:InMediaHeight  Media only 
Defines the height of media images on 

Media pages.  

iView:InMediaScalingMode  Media only  
Defines the scaling method for images on 

Media pages.  

iView:InThumbScalingMode  Media only 
Defines the scaling method for thumbnail 

images on Media pages.  

iView:Variable  See instructions for using this tag in the section above.  



 104 

Expression Media tags by category 

The following tables include all of the remaining tags that you can use when modifying or 

creating themes. The tags are organized by the particular element of the theme that they can 

create or modify. 

 

Expression Media tag Restriction Description 

Catalog 

(iView:Catalog)  
Title of iView MediaPro 

catalog file. 

(iView:CatalogComment)  
Comment for the active 

catalog 

Navigation 

(iView:GoIndex) Media only 
Hyperlink to referring Index 

page. 

(iView:GoPrevious)  
Link to previous Media/Index 

page. 

(iView:GoNext)  
Link to next Media/Index 

page. 

(iView:SourceURL)  URL to HTML Media page. 

(iView:PreviewURL)  
URL to thumbnail preview 

image. 

(iView:MediaURL)  URL to media image. 

(iView:OriginalURL)  
URL to an exported copy of 

the original image. 

(iView:Index)  

Composite display and linking 

to multiple Index pages, that 

is, 1-10 | 11-20 | 21-30. This 

tag contains a blank value if 

you generate only one index 

page. 

File names 

(iView:PreviewFile)  

File name of the image 

(Thumbnail) exported to the 

Preview folder. 

(iView:SourceFile)  
File name of the HTML 

Media page. 

(iView:OriginalFile)  
File name of the original file 

exported from the catalog. 

(iView:MediaFile)  
File name of the converted 

large JPEG media image. 

Counters 
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Expression Media tag Restriction Description 

(iView:Running)  
Current Index or Media page 

number. 

(iView:Total)  
Total number of Index or 

Media pages. 

Media rendering 

(iView:Media) Media only 
Replaces tag with rendering of 

media image. 

(iView:PreloadNext) Media only 

1x1 pixel rendering of next 

media item (Images only, 

suitable for preloading). 

(iView:PreloadPrevious) Media only 

1x1 pixel rendering of 

previous media item (Images 

only, suitable for preloading). 

Index page 

(iView:IndexStart) Index only 

Defines the start of a main 

index repeat loop. Can be used 

to populate JavaScript arrays. 

(iView:IndexEnd) Index only 

Defines the end of a main 

index repeat loop. Can be used 

to populate JavaScript arrays. 

(iView:IndexColStart) Index only 

When using the styles in CSS 

for a thumbnail index, this tag 

defines the beginning of a 

column. 

(iView:IndexColEnd) Index only 

When using CSS for a 

thumbnail index, this tag 

defines the end of a column. 

(iView:IndexRowStart) Index only 

When using CSS for a 

thumbnail index, this tag 

defines the beginning of a 

row. 

(iView:IndexRowEnd) Index only 

When using CSS for a 

thumbnail index, this tag 

defines the end of a row. 

Preview (Thumbnail) rendering 

(iView:PreviewSize)  
JPEG thumbnail file size in 

bytes. 

(iView:PreviewWidth)  
JPEG thumbnail width in 

pixels. 

(iView:PreviewHeight)  
JPEG thumbnail height in 

pixels. 
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Expression Media tag Restriction Description 

(iView:PreviewScale)  
JPEG thumbnail scaling 

compared to original image. 

(iView:Preview)  
Thumbnail rendering and link 

to Media page. 

(iView:PreviewNext) Media only 
Thumbnail rendering and link 

to next Media page. 

(iView:PreviewPrevious)  
Thumbnail rendering and link 

to previous Media page. 

Originals 

(iView:OriginalURL)  
Creates a URL to a copy of 

the original image. 

(iView:OriginalSize)  
Displays file size of the 

original image. 

(iView:OriginalWidth)  
Displays width in pixels of the 

original image. 

(iView:OriginalHeight)  
Displays height in pixels of 

the original image. 

Grouped Fields 

(iView:Fields) 

(iView:EXIFFields) 

(iView:IPTCFields) 

 

Supported set of fields from 

the set defined in the List, 

Thumbnail, or Media View of 

the catalog. Note that only a 

subset of Expression Media 

fields are HTML exportable. 

This is because most media is 

converted for upload (for 

example, TIFF images are 

converted to JPEG). 

Therefore, some of the 

characteristics of the original 

media become irrelevant after 

the conversion. 

Media info 

(iView:Filename)  
Displays file name of the 

original media file. 

(iView:FileSize)  

Displays file size of the 

exported/converted media file 

in bytes. 
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Tip: To reduce the loading time of your Index pages  Include less than 25 images on a single 

index page. You might also try a small size thumbnail (96 pixels), with low .jpg compression.   

Tip: To reduce the load time of your Media pages  Try a smaller size media export (such as 

480x320 pixels), or increase the amount of .jpg compression in the Settings panel. 

Tip: To use a Cascading Style Sheet (CSS) with a theme  Using embedded style sheets will 

work fine with Expression Media themes. To use a linked style sheet, place the CSS file in your 

theme’s Assets folder. This way, the style sheet will be exported as a related asset of your 

gallery. Using the HTML Engine Directives for index table rows and columns, you can use CSS 

and XHTML to control the positioning of tables. If your site already has a style sheet that you 

want to use, make sure that you write a complete URL to the existing CSS in your theme.dex t 

Create a cross-platform CD or DVD 

One way to create a catalog of images that is compatible with most operating systems (Windows, 

UNIX, Macintosh OS), is to burn an exported HTML gallery onto a CD or DVD disc. Following 

are the steps to accomplish this task. 

1. Create a catalog. Add the files; set the layout; and add keywords, annotations, and 

captions. Because some computer platforms do not accept long file names, shorten all 

your file names to 8 characters or less. You can easily do this clicking Batch Rename on 

the Action menu. Use that same command to make sure that you have the proper file 

name extensions on all images or movies, because some platforms require extensions. 

Remember, renaming files cannot be undone, so you might want to make a backup of 

your media before you rename them for this HTML gallery. 

2. Export an HTML gallery by using an Expression Media pre-defined theme or one that 

you have created. After export, HTML can be further customized with an HTML editor. 

Select the HTML Extension .htm in the Settings pane. This extension will work on all 

platforms. All links inside the gallery pages must be relative (for example, 

.../img/hello.jpg) for them to work on a CD. 

3. Burn your gallery files onto the CD. To make your CD compatible with most operating 

systems, you must burn the CD in the ISO 9660 format. 

4. To print a cover for the CD you just created, you can use the Print Template named CD 

Jewel Case. 

Sending e-mail 

This function enables you to export a copy of selected media items and attach them to a new e-

mail that’s ready to be sent.  

Expression Media can send e-mail with a copy of the original file, or it can convert images to 

create a resized, compressed, and watermarked .jpg that can be sent by e-mail. Optionally, you 

can choose to automatically include annotation information in the body of the e-mail for each 

media item. 

To e-mail media items 

1. Select an item or group of items from a view. 
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2. Click the Send E-mail button  or, on the Action menu, click Send Email. 

3. Select the options you want, and then click OK. See the next section for an explanation 

of the available options,  

4. Switch to your e-mail application.  

Your e-mail message will be in the Drafts folder.  

5. Add some text in the Subject field, and add your recipient’s e-mail address. 

6. Send the e-mail. 

E-mail options 

Email client options  On the Macintosh, you can choose from Microsoft Entourage and the 

Macintosh OS X Mail client to send e-mail.  

In Windows, Microsoft automatically uses the default e-mail client defined in the operating 

system. In Windows, Expression Media supports Microsoft Outlook, Outlook Express, and 

Mozilla Thunderbird. To send items using other e-mail applications (such as Eudora or 

PowerMail), try using the Expression Media Helper Application function. For more information 

on helper applications, see ―Helper applications‖ on page 116. 

Sent Files  (This option does not exist in Windows, because it is not necessary to save temporary 

files.) Select a folder to store the media files that you want to be attached to the e-mail you send. 

Attachments can be deleted after your e-mail has been sent.  

Resize and compress media  If you do not select JPEG Compress Media, Expression Media 

will send in e-mail a copy of the original file. Selecting this box provides you with options to 

define the JPEG compression quality, dimensions of the exported images, as well as the option to 

apply a watermark. 

 

Resize media  This slider provides five predefined sizes for the images you want to send using 

e-mail. The options are 160, 320, 640, 800, 1024, and 1280 pixels. Each image will be 

proportionally resized to fit the dimension. 

 

Compression quality  In this menu, choose the JPEG compression quality for the images that 

will be sent by e-mail. The Custom option enables you to define the maximum file size of e-

mailed images. 

 

Create multiple e-mails  If you select this option, you can create a separate e-mail for each item 

to be sent. If the box is cleared, all items will be attached to a single e-mail. 

 

Include media summary with each e-mail  If this option is selected, all IPTC/XMP annotations 

will be included in the body of the e-mail message. The amount of annotation information will 

vary for each item. 

 

Embed metadata in media attachments  If this option is selected, Expression Media will write 

(synchronize) all IPTC/XMP annotations into the exported e-mail image. This enables your e-
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mail recipient to open the image in Expression Media or Adobe Photoshop and review all of the 

associated annotations. 

 

Set watermark  As with all image export functions, Expression Media provides the option to 

apply a visual watermark, which is a secondary image that is overlaid on the primary image, and 

also provides a means of protecting the image. This is not the same as digital watermarks that are 

implemented algorithmically and are designed to be invisible.  

 

For instructions about how to create and apply a watermark, see ―Watermark HTML images‖ on 

page 96. 

Text data file  
The Text data file function enables you to export media properties and annotation fields as a text 

file. This file can be imported into third-party database or spreadsheet applications. You can save 

the text in a tab- or comma-separated format so that it can appear as a worksheet in spreadsheet 

applications such as Microsoft® Excel®. 

 

To create personalized documents such as form letters, you can export data by selecting the 

Merge option. In Microsoft Word, for example, you can combine variable data (like media 

names or properties) in a merge file with text in a main document. The Merge option is 

particularly useful when importing information in FileMaker® or Microsoft® Access® because 

it auto-detects fields to place imported data.  

 

For repeat use, save your settings by using the Options menu. Any saved options can be 

incorporated into scripts.  

 
To create a text data file 

1. On the Make menu, click Text Data File. 

2. In the Available Fields section, select the field that you want to appear in the final text 

file and click the single right arrow button in the dialog box. To add it to the export list, 

repeat this step for each field that you want to add to the final export. To remove a field, 

select it in the Fields Included section, and then click the single left arrow. To add or 

remove all the fields at once, click the Add All or Remove All double-arrow button, 

respectively. 

3. If necessary, change the order of the exported fields by clicking the up and down arrows 

to the right of the section.  

4. On the Encoding menu, choose how you want the text to be encoded.  

5. On the Format menu, choose how you want to separate your fields, or if you do not want 

them separated. 

6. If you want to save these settings as a profile that you can access later, click Save on the 

Options menu. 

7. Click Make, and then navigate to the location where you want to save the export. 
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8. Click Save. 

XML data file 
XML (Extensible Markup Language) is a flexible way to create common information formats. 

Once created, you can share both the format and the data on the Web or with other applications 

and databases.  

 

Expression Media’s XML Data File function exports an XML file containing basic file-related 

information for all media items in the catalog. The XML Data File export dialog box contains 

the options to include Media properties, Annotations, and EXIF data (digital camera 

information) into the XML data file. 

 

XML is similar to the language used for Web pages and Hypertext Markup Language (HTML). 

Both XML and HTML contain markup tags to describe the contents of a page or file. HTML 

describes how to display and interact with the content of a Web page. XML describes the content 

in terms of what data is being used.   

 

An XML file can be processed purely as data by a program or it can be stored with similar data 

on another computer or, like an HTML file, it can be interpreted and displayed.  

 

Expression Media uses a custom Document Type Definition (DTD) to define the markup of an 

exported XML file. A DTD is a specification that accompanies a document and identifies the 

markup tags. By including a DTD with an XML document, another application will be able to 

process the document and display or print it as intended.  

 

Export Catalog as XML file (File menu): This feature exports all catalog text contexts and 

attributes as an XML file, along with folders containing thumbnails, audio annotations, and 

original files. At any point, the entire XML catalog file can be imported again into Expression 

Media. 

 
<Expression MediaProperties› 
 <Width unit=”Pixels”›5325</Width› 
 <Height unit=”Pixels”›3543</Height› 
 <Resolution unit=”DPI”›300</Resolution› 
 <Depth unit=”Bits”›24</Depth› 
 <PrimaryEncoding›PhotoJPEG</PrimaryEncoding› 
 <ColorProfile›sRGB</ColorProfile› 
</Expression MediaProperties› 

Sample portion of an exported XML data file 

 
To export as an XML data file 

1. On the Make menu, click XML Data File. 
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2. Select an Include Sections option. You can include Media properties, Annotations, and 

EXIF data (digital camera information) in the XML data file. 

3. Select any Create Folders option. Expression Media will create a separate folder for each 

of the options you select. If you do not select any of these boxes, this content will not be 

exported with the XML file. 

4. Select the option Include document type definition to embed the custom DTD in the 

exported XML file. 

5. In the XSL section, click the plus sign (+) to choose an XSL style sheet. XSL defines the 

presentation of an XML document. You can use it to translate XML documents into other 

formats. 

6. Click Make and navigate to the location where you want to save the export. 

7. Click Save. 

Exporting a contact sheet  
 

 
Exporting a contact sheet from Thumbnail View 

 

This export option creates contact sheets as images files (such as JPEG or Photoshop) that can be 

printed or sent by e-mail to your clients.  

 

Expression Media automatically calculates the number of items that can fit in the designated 

contact sheet size, taking into account the View Options function of your catalog’s List View or 

Thumbnail View.  
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List View is useful for printing a table of contents of your catalog. The list view style matches 

the layout of the catalog’s List View, with icons and associated field information of each file.  

 

Thumbnail View prints a table of thumbnails, which is similar to your catalog’s Thumbnail 

View. The size of the thumbnail in your catalog determines the size of the thumbnail in the 

contact sheet. 

 

To adjust the visual settings of your contact, click View Options on the Window menu in the 

catalog, and then make any necessary changes.  

 

The size, resolution, and format of the contact sheet image file can be customized in this dialog 

box. You can also add headers and footers. If you have more media items than can appear on a 

single contact sheet, Expression Media will output as many pages as necessary to completely 

export the catalog as contact sheets. As you adjust the dimensions of the contact sheet, the 

number of exported pages will be adjusted.  

 
To export a contact sheet 

1. On the Make menu, click Contact Sheet. 

2. Select a Layout option. The layouts will resemble the view layouts in the program. 

3. Click the plus (+) or minus (-) signs to choose a header and/or footer. These can be any 

supported image file you have on your hard drive. 

4. Select the unit of measure in your exported contact sheet in pixels, inches, or centimeters, 

and then set the dimensions.  

5. Select a file format for your contact sheet. Depending on the format you select, you might 

have several other options from which to select. To set those options, click the Settings 

button. 

6. Select Zero pad increments to add zero-padding to the sequential numbers. For 

example: 001, 002, 003 instead of 1, 2, 3. This type of numbering is valuable because it 

keeps files in sequential order on your desktop and removable media. Without zero 

padding, the files would be in the order 1, 10, 11, 12, and so on. 

7. Select Append file extensions (Macintosh) to add file extensions to ensure Windows 

compatibility. 

8. Click Make, and then navigate to the location where you want to save the file. Click 

Save. 

File conversion 
The File Conversion functions on the Action menu are useful for single or batch conversion of 

images, movies, animations, or sounds.   

 

The Convert Image Files command will convert images, as well as poster frames from 

animations, into a new format such as .jpg, .tif, and so on. To convert to other formats, you will 

need to use a third-party image-editing application. 
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Existing color profiles, EXIF metadata, IPTC annotations, and associations with sets can be 

exported to the converted media files. JPEG and TIFF image conversions have the option to 

preserve EXIF metadata. JPEG, TIFF and Photoshop conversions can preserve ITPC 

annotations. 

 

When converting Camera Raw files, Expression Media uses the large embedded preview as the 

image to be converted. The actual raw data is not converted. 

 

Convert Sound File and Convert Movie File conversions will convert sound files and 

soundtracks from selected movies.  

 

For frequent use of this feature, you can save settings using the Options menu. Saved options 

can be incorporated into scripts. 

 
To convert images 

1. In any view, select the images that you want to convert. 

2. On the Action menu, click Convert Image Files. 

3. On the Format menu, click an output file format.  

4. To set the image resize options, click the Size button. Choose Use image size (Windows) 

or Use natural bounds (Macintosh) to export the image using its existing dimensions. 

Scale media to fit exports the image to the size you define. However, Expression Media 

does not distort exported images to fit these dimensions exactly. Rather, the larger 

dimension (width or height) will conform, and the smaller dimension will adjust only in 

proportion to the original image.  

5. Depending upon the format you choose, you might have additional options to set, 

accessible from the Settings and Resolution buttons. 

6. Set the conversion options according to the explanations below: 

 Select Preserve color profiles to embed the ICC color profiles into each exported 

image.  

This option is available from the dialog box when you have color matching (Macintosh: 

ColorSync) selected. To select color matching, in the Edit menu, point to Preferences, 

and then click Media Rendering.  

 Select Preserve EXIF/GPS metadata to embed the EXIF and GPS digital camera 

metadata into all exported images.  

This option is available only for JPEG and TIFF conversions.  

 Select Embed annotations to embed all IPTC/XMP Core annotations into each 

exported image.  

This option is only available for JPEG, TIFF and Photoshop format conversions. 

 Select Set Watermark to apply a visual watermark, which is a secondary image that 

is overlaid on the primary image, and provides a means of protecting the image.  

To locate an image to use, click the Set Image button. For instructions about how to 

create and apply a watermark, see ―Watermark HTML images‖ on page 96.  
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 Select Replace original files to delete the original and replace it with the converted 

image. 

7. If you want to save these settings as a profile that you can access later, click the Options 

menu, and then click Save. To use a saved profile, click Load. 

8. Click Convert to navigate to a location to save the files, and then click OK. 

 
To convert movie files 

1. Select the files that you want to convert. 

2. On the Action menu, click Convert Movie Files. 

3. On the Format menu, choose an output format. Depending on the format you choose, 

you have various settings options to set. A dialog box displays with your options. If the 

dialog box does not appear, click the Settings button. 

  

Note: If you convert to DV Stream (Macintosh), the file can be imported into Apple®’s 

iMovie® for additional editing. 

4. Select Replace original files to delete the original and replace it with the converted 

image. 

5. If you want to save these settings as a profile that you can access later, click the Options 

menu and click Save. To use a saved profile, click Load. 

6. Click Convert to navigate to a location to save the files, and then click OK. 

Note: With Windows video conversion, Expression Media can only convert the following video 

file formats to a still image sequence: .asf, .wmv, .wmp, .wma, .wm, .avi, .mpeg, .mpe, .mpg, 

.mlv, .mp2, .mp2v, .mpv2, and .divx.  
 

To convert sound files 

1. Select the files that you want to convert. 

2. On the Action menu, click Convert Sound Files. 

3. On the Format menu, choose an output format. Depending on the format you choose, 

you have various settings options to set. You can access those options by clicking the 

Settings button. 

Backup/CD-ROM 
This function (on the Make menu) enables you to prepare CDs and DVDs for burning by using 

the built-in disc burning technology in Windows and on the Macintosh OS X. Backup is also 

ideal for archiving digital files onto disk partitions, removable disks (for example, Zip) or hard 

drives on a network.  

 

Expression Media automatically scans your computer for available hard drives, partitions, and 

removable media, such as CD, DVDs, and Zip drives. It places available locations for backup 

with the Destination option in the Backup dialog box.  
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When backing up files to a CD or DVD that will be burned with the Macintosh operating 

system’s built-in disc burning technology, the CD or DVD will be named on the desktop after it 

has been inserted into the drive. 

 

Additional options enable you to back up All media files or Only visible media files in the 

catalog (for example, showing a set in the active view). You can also select the option Keep the 

folder structure for your original media, as well as selecting the Include media catalog option 

with your backup.  

 

The Reset paths option resets the paths of items in the open catalog to the location of the media 

files that have been backed up. For example, if you backed up a group of files to a CD, the 

catalog would reset paths of those items to the media on the CD.  

 

To back up your media, select the options you want, and then click the Backup button. 

Expression Media might ask you to save the catalog before burning the CD or DVD. 

 

Before burning backup files to a CD or DVD, you might also consider placing a copy of the 

Expression Media Reader application on your removable media. Using this royalty-free 

software, you can distribute and share your catalogs at no cost or restriction.  

 

To include the Expression Media Reader, copy it to your removable media before burning. If you 

need either the Macintosh or Windows version, you can download it from 

http://go.microsoft.com/fwlink/?LinkID=82546. 

 

Expression Media Reader has the same system requirements as Expression Media (see ―System 

requirements‖ on page 1) and needs QuickTime on the host computer in order to function 

properly. 

Alternative backup: transfer to folder 

The Backup function does not provide the option of selecting a particular folder. To transfer a 

folder to a backup medium, use the Expression Media Transfer to Folder feature.  

To use this feature, first select a file, group of files, or all files in the catalog, and then click 

Transfer to Folder on the Action menu. The dialog box has three options for copying and 

moving files. 

 Move files  Moves media files to a new folder, deleting the original files. Catalog items 

will refer to the new files in the new folder.  

 Copy files  Copies media files to a new folder, keeping the original files. Catalog items 

will refer to the files in the new folder. 

 Duplicate files  Copies media files to a new folder. Catalog items and referenced files 

will remain unchanged. 

http://go.microsoft.com/fwlink/?LinkID=82546
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Helper applications 

Your workflow will most likely involve performing some actions outside of the Expression 

Media working environment, such as advanced image editing with Adobe Photoshop.  

This is where the Expression Media Open With Helper Application function helps out. Select 

any file (or group of files) in the catalog and open the catalog with a Helper application directly 

from Expression Media.  

This keeps you from having to launch an application, navigate through the desktop, and locate 

the file, thereby cutting extra steps out of your workflow. 

 
To open items with a Helper Application 

1. Select a group of images. 

2. Do one of the following: 

 In the Open With menu, click a Helper application  

 Right-click (Windows) or CTRL-click (Macintosh) and, on the contextual menu, 

point to Open With and click a Helper application. 

3. The application will launch and open the batch selection of files.  

Add a Helper 

When first launched, Expression Media automatically scans your computer for Helper 

applications, however, you might want to add or remove some of these applications later. 

 

1. Do one of the following: 

 In the Open With menu , choose Helper Applications. This dialog box enables 

you to choose media editors, utilities, or viewers so that you can quickly access them 

through the toolbar, or by right-clicking (Windows) or CTRL-click (Macintosh) to 

display a contextual menu.  

 On the Edit menu, point to Preferences, and then click Helper Applications.  

2. Click Add in the Define Helper Applications dialog box.  

3. Navigate to the desired application, select it, and then click OK.  

The Helper Application will be added to the list in alphabetical order.  

 

When using Helper applications in your workflow, the possibilities are limitless. Following are 

some ways in which Helpers can assist you. 

 

Image editing  Assign an application such as Adobe Photoshop or Jasc Paint Shop Pro as a 

Helper for editing photos. Find images that you want to edit, open them in the Photoshop, make 

corrections to the images, and then save them over the existing files or as a copy to a new folder. 

When you go back to your Expression Media catalog, the edits will be reflected in updated 

thumbnails. If you saved the images as copies to a new folder, they will need to be imported into 

the catalog. 
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Edit anything  The same technique for editing images can be applied to just about anything, for 

example, desktop publishing files such as Adobe InDesign and Quark, graphics files such as 

Adobe Freehand or Illustrator, even audio, or video and text files. Assign the appropriate 

application for the file and choose the Open With command. 

 

Raw conversion  Select a batch of raw images, and open them with a Raw image converter, 

such as Capture One PRO, Adobe Camera Raw, Adobe DNG Converter, or Canon Raw 

Converter. Your images will be ready to color correct and process. 

 

Compression and packaging  Assign applications such as WinZip or Allume Systems’ StuffIt, 

DropStuff, or DropZip tools to compress items or create self-expanding files for the Macintosh 

and Windows. This method is excellent for packaging a group of media files to be sent as e-mail, 

or for backup or burning. 

 

CD/DVD Burning and Backup  Assign any CD or DVD burning application as a Helper, and 

add files to a new disc image ready for burning. This action is similar to, but not exactly the 

same as, the Expression Media Backup command. 

 

E-mail  You can add any file, direct from Expression Media, as an attachment to an e-mail. To 

do so, select the file, and then choose an e-mail client (such as Microsoft Outlook) in the Helper 

application menu and the file will automatically open as an attachment to a new e-mail. Results 

will vary depending on your e-mail client and operating system. This is a useful option if your e-

mail client is not supported by the Expression Media Send Email function.  

 

Previews and Players  While Expression Media is an excellent viewer for almost every format, 

you might want to view your files in another application such as the Macintosh OS X Preview 

application, browsers such as Internet Explorer, or Windows Media player. If you use other 

players, such as iTunes, WinAmp or Audion, set them as Helpers. This will make it easy for you 

to add a particular MP3 to a player’s database. 

 

Font management  On Macintosh OS X, you can assign Font Book as a Helper for a quick, 

efficient way to add fonts from an Expression Media catalog to the active fonts panel. This 

means that making any font active in your system is only one click away. 

 

Droplets  You can integrate droplets created by Adobe Photoshop or ImageReady into your 

workflow by assigning them as Helpers. A ―Rotate 90 Left‖ Photoshop droplet or ―Make JPEG 

(quality 60)‖ ImageReady compression droplet will save you quite a bit of time when you use it 

as an Expression Media Helper application.  

 

Applets (Macintosh)  Any AppleScript applet, scriplet, or droplet that has been saved as an 

executable file is viewed by your operating system as an application. You can define it in 

Expression Media as a Helper.  

 

Online photo printing services  While Expression Media does not have built-in functionality 

for ordering prints from an online photo service, you can make Expression Media work with 

photo services by using Helpers. Set the online photo service software as an Expression Media 
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Helper application (for more information, see ―Helper applications‖ on page 116). Then, open 

the images with this Helper application. For some photo service software, this might not work. In 

that case, you can select the images you want and drag them from the Expression Media catalog 

to the printing service software. This method also works well with Apple’s iPhoto software.  

Microsoft Expression Media Reader 
This software from Microsoft enables you to distribute and share your catalogs with anyone at no 

cost or restriction. Microsoft Expression Media Reader is free to download and distribute, and it 

works on both the Macintosh and Windows platforms. 

 

Expression Media Reader opens catalogs written by Expression Media 1.5 or higher. It has the 

same file format support as Expression Media and includes the Slide Show function. Expression 

Media Reader has the same system requirements as Expression Media (see ―System 

requirements‖ on page 1) and requires QuickTime on the host computer in order to function 

properly. 

 

To let others view your catalog, copy Expression Media Reader and your catalog to CD or DVD, 

and then send by e-mail, or send across a network. 

 

If you need either the Macintosh or Windows version, it can be downloaded from the Expression 

Media Web site (FW). You can choose not to include your original media with a catalog that you 

distribute. This lets you protect your digital assets from being copied while allowing others to 

view the List and Thumbnail Views. If you include original media, this will allow a Expression 

Media Reader user to access the media contained in a catalog. If your catalog contains Full 

Screen Previews, Expression Media Reader can view them in Media View, Slide Shows, and 

Light Table. 

 

Expression Media Reader does not allow the viewer to make any alterations to your catalog or to 

create new catalogs. You do not have to purchase Expression Media to use Expression Media 

Reader. 

Protecting distributed catalogs  

Once you have created a catalog for distribution with Expression Media Reader, you might want 

to allow only certain people to view or access it. To set password protection for a catalog, follow 

these steps. 

 

Important: Expression Media does not use password encryption. Store catalogs containing 

private information in a secure location, such as your personal documents folder. 

 
To protect distributed catalogs 

1. On the File menu, click Catalog Info. 

2. Click the Set Password button. This button is only available if you have saved your 

catalog. 

3. Type the password, and then save the catalog.  

4. When opening the catalog again, Expression Media will ask you to provide the password 
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before you can view the catalog’s contents.  

Distributing catalogs with Expression Media Reader  

When distributing catalogs with Expression Media Reader, there are two primary considerations 

that greatly impacts what the recipient can do with the catalog. These considerations are image 

settings and view options. 

 

The image settings determine the size and quality of media items that can be viewed in 

Expression Media Reader. View options determine which annotations you can view in the Info 

and Organize panels.  

 

Here are instructions for creating catalogs to be distributed with Expression Media Reader: 

 
Thumbnails & Previews 

1. Create a new catalog. 

2. On the Edit menu, click Thumbnails and Previews. 

3. Select the size of thumbnails to be created (options: 160, 320, 480, 640 pixels). If you 

select Variable size, Expression Media will match the thumbnail size defined in the 

Thumbnail View of the active catalog. If you are sharing a catalog with thumbnails only, 

you should select a large thumbnail size, such as 480 or 640. 

4. Select the JPEG compression quality to be applied to the thumbnails. 

5. To enable the creation of media previews, select the Create full screen previews box.  

This option will enable the catalog recipient to view larger image files without accessing 

the original files. 

6. Select the size of previews to be created (options: 800, 1024 and 1280 pixels). 

7. Select the JPEG compression quality to be applied to the preview images, and then  

click OK. 

8. Import your media items and save your catalog. 

Import 

1. Import media into your catalog. 

2. If you want to password-protect your catalog for distribution, see the previous section. 

3. On the File menu, click Save. 

View Options 

1. Expression Media Reader does not provide any options to change the appearance of List, 

Thumbnail, and Media View. Select the font, type size, colors, and displayed fields with 

your catalog recipient in mind.  

2. Expression Media Reader does not provide any options to configure the Info or 

Organize panels. Show or hide various annotation fields and groups with your catalog 

recipient in mind. For instructions on modifying Info panel and Organize panel, see ―The 

Info panel‖ on page 34 and ―The Organize panel‖ on page 61.  

Distribute disc 
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Burn your catalog and a copy of Expression Media Reader on a CD or DVD. Include 

both the Macintosh and Windows versions of Expression Media Reader so that you won’t 

have to worry about the recipient’s operating system. If you want your catalog recipient 

to view the highest resolution for Media View, Slide Show, and the Light Table, you 

should also burn a copy of all original media files on the same CD or DVD. 

Be aware that the file size of catalogs with full screen media previews can be considerably larger 

than catalogs with only thumbnails. However, your clients will be able to see a much larger 

version of your images.  

 

The size and compression quality of media previews will also greatly impact the file size of 

Expression Media catalogs. 

Exchange feedback using Expression Media Notepad  

The Expression Media Notepad is an easy way to share comments about media items among 

different users viewing and using the same catalog.  

 

 
Expression Media Notepad 

 

The Expression Media Notepad is a flexible tool and can be used in different ways. To explain 

how Notepad works, we are going to use an example of a photographer communicating with an 

art director about an assignment.  
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Using Expression Media Reader (or Expression Media), the art director can view and select the 

best images and send those selections with comments back to the photographer. The 

photographer can then immediately see those selections in the catalog and quickly process the 

photos according to the comments. 

 

Here’s how that exchange would work in step-by-step instructions. 

 
Photographer 

1. Create a catalog with Expression Media. 

2. Burn the catalog onto a CD or DVD, and include the Macintosh and Windows versions of 

Expression Media Reader. If your client already has Expression Media Reader, you might 

be able to send the catalog by e-mail. 

3. Send the disc to the art director.  

Art Director 

1. Copy the Expression Media Reader, the catalog, and any media files from the disc to 

your computer. You can launch Expression Media Reader from the disc and open the 

catalog. However, installing Expression Media Reader is not necessary.  

2. On the Window menu, click Expression Media Notepad.  

3. Drag a selection of images to the Notepad. This selection will make up the first page of 

the Notepad. 

4. Type your comments about this selection of images in the Comment box. Example: Print 

order: 2 copies of each image at 4x6. 

Note: Microsoft recommends that you start each comment with a short word. That way, 

when the catalog creator imports your comments into Catalog Sets, they will quickly be 

able to decipher the general meaning of the page comments.  

5. If more feedback is needed, then select a different page of the Notepad and repeat the 

process. 

6. When the Notepad is complete, click the Email button at the bottom left of the Notepad 

panel. This will launch your computer’s default e-mail client, create a new e-mail 

message, and attach the Notepad file. The Notepad file will have the same file name as 

the catalog but with an .ivn extension (iView Notepad).  

7. Send e-mail to the photographer. 

Photographer  

The photographer receives e-mail with the Notepad file attached. 

 

1. Open the e-mail and save the attachment (Notepad file) to the same folder as the original 

catalog that was sent to the art director.  

2. Open the catalog from the Window menu, and then click Notepad. The selections and 

comments that were made in Expression Media Reader by the art director now show in 

Expression Media. You can also double-click the Notepad icon, and Expression Media 

will launch and automatically open the appropriate catalog. 
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3. In the Option menu at the bottom of the Notepad panel, choose Create Sets using 

Notepad pages. This option will create five catalog sets corresponding to each page of 

the catalog’s Notepad. You can now hide the Notepad panel because the same 

information is in the Organize panel and it can be integrated with your regular 

workflow. 
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Chapter Ten: 
 

Automate tasks and workflow 
 

 

As you use Microsoft Expression Media, you will find that you perform certain tasks over and 

over again. By using scripts, you can automate some of these tasks. A script is a series of 

commands that tells Expression Media and other applications what to do. 

Expression Media can be scripted to perform basic functions, such as annotate, convert, 

organize, and print. Or, you can create a script to perform a complex series of tasks, such as 

copying images from a media card to a new folder on your computer, building an Expression 

Media catalog, assigning and embedding annotations in the images, and saving the catalog to the 

same folder. 

You can work with scripts in collaboration with other applications that are scriptable. Using 

scripts, you can integrate Expression Media with third-party applications, Web services, or 

database systems to perform your workflow automation.  

Scripting  

Windows  Expression Media supports Visual Basic Script and JavaScript automation on 

Windows operating systems. Once you create a script, you can attach it to the application for 

access through the Scripts menu.  

Macintosh  Expression Media supports AppleScript automation on OS X. Once you create a 

script, you can attach it to the application for access through the AppleScript menu.  

To create a script, use a text editor or a special application, such as the Script Editor, which is 

included with Macintosh OS X. 

Attaching scripts to Expression Media 

The Expression Media installation creates a Plug-ins folder that contains files that are important 

to the application’s functionality. Expression Media also creates a user-defined Plug-ins folder 

for you to customize or install additional functionality, such as scripts, HTML templates, print 

templates, Favorites lists, and media importers.  

The Expression Media Scripts menu displays all scripts in the Scripts folder found in the Plug-

ins folder. When installing custom scripts, place them inside the user-defined Plug-ins folder, 

and not the application Plug-ins folder. This way, you will not lose your custom settings and 

plug-ins when upgrading to future versions of Expression Media. 

Windows  The user-defined Plug-ins folder is located in one of the following locations. 

C:\Documents and Settings\username\Application Data\Expression Media\Plug-ins 

(Windows XP) 



 124 

C:\Documents and Settings\username\Application Data\Roaming\Expression 

Media\Plug-ins (Windows Vista) 

 

Macintosh  The user-defined Plug-ins folder is located in one of the following locations. 

 ~User/Library/Application Support/Expression Media/Plug-ins 

/Library/Application Support/ Expression Media /Plug-ins 

Network/Library/Application Support/ Expression Media /Plug-ins 

Scripts for importing 

Expression Media provides two scripts for importing catalogs created by other digital photo 

management applications. 

iPhoto (Macintosh)  Choose Welcome from Expression Media, and then click Import iPhoto 

Library. Expression Media automatically finds the iPhoto library and imports all original photos 

into a new catalog. This feature works with iPhoto versions 2.0, 4.0, and 5.0. 

Scripts as Helper applications 

Helper applications are programs installed on your computer that you can use to edit, play, view 

or compress catalog items. Using Helpers keeps you from having to start an application, navigate 

the desktop, or locate a file.  

Some scripts, depending on how they are created, are viewed by the operating system as an 

application and can be defined in Expression Media as a Helper. For instructions on defining 

Helpers, see ―Helper applications‖ on page 116. 

Droplets created by Photoshop or Image-Ready can be integrated into your workflow by 

assigning them as Helper Applications. When used as an Expression Media Helper, a Rotate 90-

degree clockwise Photoshop droplet or Make JPEG (quality 60) ImageReady compression 

droplet will save you quite a bit of time. Any AppleScript applet, scriplet, or droplet that has 

been saved as an executable can be defined in Expression Media as a Helper. 

Installed scripts 

The Scripts menu displays scripts that are inside the Expression Media Scripts folder, which is 

inside of the Plug-Ins folder. Because scripts can be attached to Expression Media, you can 

place additional scripts in this menu to access them while using Expression Media. To add your 

scripts to this menu, place them inside the user-defined Plug-ins folder (for the location, see 

―Installing Expression Media‖ on page 2). 

Annotate 

Here is a list of annotation functions that you can use with Expression Media. 

 Copy from Head of Selection  Copies all annotations from the first selected item, and 

then applies them to all other selected items. 

 Copy from Items with Same Name  Copies annotations from selected items to items of 

the same name but a different suffix (such as Raw+JPEG), or has the same full name in 

other folders. 
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 Import From PhotoDISC™  Annotates images in the front catalog, using text files 

located on your PhotoDISC™ CD. 

 Make Description from EXIF  Copies all EXIF photo metadata into the Caption field.  

 Make Description from Text Files  Searches for .txt files in the same folder as the 

original, and copies the contents into the caption field. 

 Make Description from Text Lines  Opens a text file and uses each line of the file as 

the caption for the selected items. 

 Make IPTC Date from Capture Date  Copies the EXIF Capture Date and puts it into 

the IPTC Date Created of the Annotations pane.  

 Make Keywords from Folders  Enables you to add keywords to media files from folder 

names. The dialog box provides the option of defining the level of folders in the path you 

want to use for keywords.  

 Make Product from EXIF Data  Copies the EXIF Maker and Model fields and puts 

them into the annotations Product field. 

 

To modify existing scripts  Attach your own annotation scripts at any time. Write the script, and 

then position it by pointing to Annotate on the Scripts menu, and then clicking Plug-ins. 

Files 

Here is a list of file functions that you can use with Expression Media: 

 Rename Using EXIF Date  Renames files by using a valid EXIF Capture Date field. 

See Media Info panel to view the Capture Date field. 

 Rename Using Text File (Macintosh) Opens a text file and uses each line of the file as 

the new name for the selected items. 

 Set Date Modified to IPTC Date  Sets the modification date of the selected media files 

to the date defined in the IPTC Date Created field.  

 Set File Comment (Macintosh)  Saves the Caption field inside the file’s comment field, 

which is visible in the Finder and the Get Info window of original files.  

 Set File Label (Macintosh)  Sets the color label of a file using label marking ID set in a 

catalog. 

 Use as Desktop Picture  Sets the desktop picture of the main monitor to the selected 

item of the front catalog.  

Select 

On the Scripts menu, point to Select, and then click Landscape, Portrait, or Square. These 

options select all images that match that proportion. 

Tools 

On the Scripts menu, point to Tools, and then click one of the following options. 

 Copy HTML Theme (Macintosh) Offers the option to choose an HTML theme and 

place a copy of it to the user-defined Plug-ins folder. 
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 Reveal Plug-ins Folder  Opens the user-defined Plug-ins folder on the desktop. 

 Import from Adobe Photoshop Album  Assists you in converting a Photoshop Album 

library to an Expression Media catalog. 

Scripts menu  You can add your own scripts to this menu by placing them in the user-defined 

Plug-ins folder on your hard disk. 

Option sets 

Several complex functions in Expression Media offer the ability to save a set of options for easy 

recall and repeat use. These settings are stored in the Options menu of a function’s dialog box. 

Saved options can be incorporated in scripts. Option sets are small custom files and are easy to 

copy, share, and install. 

The following functions can store options: 

 Find  Saves and recalls simple or complex Boolean (and/or) search strings. 

 Batch Rename  Stores combinations of settings for file renaming.  

 View Options  Stores the display options for text, color and metadata of the List, 

Thumbnail, and Media Views. A view’s Size menu options are also stored with an option 

set. 

 HTML Gallery  Stores variations on theme settings for different clients or projects. The 

Site Title is not stored with an option set. 

 File Conversion (Images)  Saves conversions with a specific purpose, such as 

compression for Web or e-mail distribution. 

 Text Table  Saves and recalls various metadata groupings that you want to export. 

 PDF Maker  Stores page layout styles for the production of high-resolution PDFs.  

To save an option set 

1. Make sure you have all the function’s dialog box options set appropriately. 

2. On the Option Set menu, click Save.  

3. Type the name of the option set, and then click OK.  

Option Set menus are listed alphabetically. If you want to force a particular option set to 

appear at the top of the list, add a blank space as the first character of the name. 

 

Tip: There are no methods for renaming an option set. If you want to change the name, 

you must save the option set a second time using a different name, then remove the old 

one from the list. 

To remove an option set 

1. On the Option Set menu, click Remove. 

2. Select an option set, and then click Remove. 
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To share an option set 

Option sets are good for saving and recalling a large group of settings. Option menus are 

typically located in the lower-left of a dialog box. 

You might want to install option sets on other computers in a workgroup or share them with 

other Expression Media users.  

1. Locate the user-defined Plug-ins folder in Option Sets. For instructions about locating 

this folder, see ―Installing Expression Media‖ on page 2. There are several folders of 

option sets:  

 CLGE = PDF Maker 

 BREN = Batch Rename 

 IMGC, SNDC and MOVC = File Conversion 

 LAY0, LAY1, LAY2 = List, Thumbnail, Media View 

 HTML = HTML Gallery 

 TEXT = Text Table. 

Find option sets cannot be shared. 

2. Copy the option set you want to the desktop and distribute it wherever you want. The 

recipient must place the option set in the correct corresponding option set folder. 

Tip: When sharing HTML Gallery option sets, your recipient will need to have the relevant 

themes installed for the option set to function properly. 
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Chapter Eleven: 
 

Image editing and version control 
 

 

Microsoft Expression Media offers powerful image editing as well as calibration tools that can 

enhance the color, sharpness, and brightness of your images.  

Image editor  
The features of this tool apply only to image file formats (such as .jpg or .tif) and will not work 

with movies or vector graphics. You can start the Image Editor from the toolbar icon , or, on 

the Window menu, by clicking Image Editor. 

 

To properly preview the filter effects of the Image Editor, Expression Media automatically 

switches to Media View when a filter is selected.  

 

To edit images 

1. Choose a filter from the Image Editor panel by clicking the filter name in this list. 

2. Make your edits in the Filter dialog box, and then click OK.  

3. Apply as many filters to the image as necessary. To discard all changes and reload the 

original image, click the Revert button. To remove the effect of the last filter applied, 

click the Undo button. 

4. Image modifications by any of the tools described in this section are not saved until you 

click the Save button in the Image Editor panel. Some effects display real-time results of 

the filter in Media View so you can see how the effect appears on a larger view of the 

image before you accept the changes. This feature is named Preview, and you can use it 

by selecting the Preview option when it is available. You can also move the area being 

shown in the Preview window by dragging the image. 

5. The Save button displays a dialog box so that you can define compression and file-type 

settings. To overwrite the existing file, click Save. This dialog box also gives you the 

option of storing a backup copy of the original file in a folder of your choice, or in the 

Version Control folder. 

Saving image files removes embedded digital photo annotations (EXIF) that might have existed 

in the original file, unless you selected the option Preserve EXIF metadata in the Save dialog 

box. IPTC and XMP metadata cannot be preserved. You must synchronize them after saving by 

clicking the Action menu and then clicking the Sync Annotations command. 

 

Note: You can use as many filters as you want before saving changes. 

Crop  
You can use the Crop tool to reduce the visible area of an image.  
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To crop an image 

1. Click the image, and then draw a box around the area you want to crop.  

Expression Media grays out the area that will be cropped.  

Before accepting the crop, you can adjust the edges of the selection to fall exactly at the 

location you want.  

2. To accept the crop, click OK. 

3. Position the cursor over one of the four sides of the image, and then drag to where you 

want the cropped area.  

4. While adjusting the cropped area, you can review the coordinates of the crop in the Area 

fields.  

To constrain the proportions of a crop 

1. Select the Constrain box, and then type the dimensions you want.  

This is useful for cropping an image for a specific print, screen, or video, such as 4x6 or 

640x480.  

2. You can adjust the unit of dimension displayed in this dialog box by selecting pixels, 

inches, or centimeters from the Units menu. 

3. To exit the Crop tool, click Cancel. 

Note: When you resize a cropped area that is not constrained, you can adjust the dimensions by 

clicking and dragging on any side of the box. You do not have to click exactly on the red control 

bars. 

Resize  
Use the Resize tool to reduce the size of an image. This tool works similarly to the Expression 

Media batch file conversion utility, but includes some options for finer adjustment. Resizing an 

image with Expression Media does not affect the original resolution of the image. 
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To resize an image 

1. Define the new width and height in the Target Size fields. 

2. Adjust how the image will fit into the target size by selecting one of the following options 

from the Scaling Mode menu.  

3. If you want the image to conform to a specific size, without stretching the image, select 

the Enable Padding box and select a Pad Color. Padding is the space created when you 

choose a target size that is wider or taller than an existing image. When you select 

Enable Padding, Expression Media fills in the extra space with a color of your choice. If 

padding is not enabled, Expression Media will resize the image according to the scaling 

mode. This usually scales the image to fit the width or height. 

 Scale to Fit  Scales the image proportionally to the Target Size. 

 Pin Larger  Scales the image with its larger side expanded or shrunk to fit the Target 

Size. 

 Pin Smaller  Scales the image with its smaller side expanded to fit the Target Size. 

This option will fill the entire area, but your image might be cropped. 

 Fit Width  Scales the image based on the horizontal parameters of the Target Size. If 

you apply this to a vertical image, some of it might be cropped. 

 Fit Height  Scales the image based on the vertical parameters of the Target Size. If 

you apply this setting to a horizontal image, some of it might not be visible. 

Transform 

The Transform tool lets you alter the shape and perspective of your images. This tool is good to 

use for correcting optical distortion, such as converging verticals or barrel distortion. 
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To transform an image 

1. Choose a setting from the Constrain menu, according to the following descriptions:  

 Perspective  This setting lets you apply a one-point perspective to an item. To apply 

a vanishing point perspective along the horizontal or vertical axis, drag a corner 

handle along that axis. The opposite corner will move in tandem.  

 Skew  This setting enables you to tilt or slant an object to one side while keeping all 

other sides fixed. Drag a corner handle to reposition just that handle. You can adjust 

all handles independent of moving others. 

 Free  This setting lets you apply skew and perspective transformations in one 

continuous operation. 

2. Drag one of the red-corner handles in the image. You can track the X and Y coordinates 

of the corresponding corners by watching the Offset value. 

3. To change the background color, click Pad Color. 

4. To remove all transformations, click Reset. 

Rotate  

Use the Rotate tool to adjust the angle of an image. You can adjust the rotation in increments as 

small as one-tenth of a degree.  
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The Rotate filter 

To rotate an image 90 degrees clockwise 

1. In the Angle field, type 90.  

2. To rotate counter clockwise, place a negative sign (-) in front of the number in the Angle 

field. 

Note: This rotation method is not the same as a lossless JPEG rotation. For lossless 

rotations of 90, -90 and 180 degrees, see the JPEG Rotate command on the Action 

menu. 

3. When rotated, select a color in Pad Color to use for the background of images. 

4. Use the arrows to rotate by increments of .1 degrees (Up rotates clockwise; Down rotates 

counter clockwise); or just type in the number of degrees to rotate (negative numbers 

rotate counter clockwise).  

Note: You can also drag the image with the mouse. 

Sharpen edges  

This filter adjusts the sharpness of your images. It works by determining the edges of elements in 

the image based upon the degree that one color in an image contrasts with another. 

To sharpen images 

1. Drag the Sharpening slider to define the number of pixels (from 1 to 10) to retouch the 

edge. 

2. The Edge Detection slider adjusts how strong the contrast of edges must be before a pixel 

is considered to be in-range to be sharpened. 

Note:  Be careful not to over-sharpen the image, as it will bring out imperfections, making JPEG 

artifacts more visible. 
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Remove grain  
This filter helps smooth out grainy images by applying a slight blur.  

To remove grain 

1. Depending on the size of the grain, select Fine, Medium, or Coarse under Grain size in 

the Remove Grain dialog box. 

2. Selecting this box will apply the filter to the image in Media View. The time it takes to 

render a preview of the filter will vary, depending on the complexity of the filter and the 

speed of your computer’s processor.  

Remove red eye  
With this filter, you can remove the ―red eye‖ effect caused by a camera flash.  

To remove red eye from images 

1. Using the Zoom slider, zoom in on the area where the eyes are located. 

2. Use the Selection tool to draw an area around the pupil of the eye. Depending on the skin 

tone, it is safe with some images to draw a box around both eyes. Be aware of reddish 

skin tone, or lips and red hair that might be affected.  

3. Adjust the level of red eye by using the Reduction slider. A setting of 5 or 6 is optimum.  

4. Click OK. To adjust the other eye, repeat these steps. 

Convert to duotone  

This filter converts color, as well as black and white images, into duotones. Duotones were 

designed to increase the tonal range of a grayscale image by using different colors to reproduce 

different gray levels.  

To create a duotone 

1. Select a light and dark color by clicking the respective color button. 

2. Adjust the brightness and contrast by using the sliders. Negative numbers reduce 

brightness and contrast. 
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The Convert to Duotone filter 

Adjust saturation  
This filter adjusts the color saturation and lightness of your images. This filter can help 

compensate for a lack of color definition, but note that Inkjet printers tend to over-saturate color, 

making the colors look unrealistic. 

To adjust saturation 

Drag the Saturation slider to define the intensity of the colors. The existing level of colors in an 

image is 100. To reduce color saturation, drag the slider to a number less than 100. Zero 

represents no color, making an image black and white. Drag the Lightness slider to brighten or 

darken the image. 

Adjust brightness and contrast  

This filter adjusts the tonal range of your images through brightness and contrast. It can help to 

correct blurry images and bring out fine details in tone.  

Dragging sliders to the left decreases brightness and contrast; dragging them to the right 

increases the levels. 

Adjust color levels  

The Color Levels histogram displays the tonal range of the entire image. Use the sliders to adjust 

highlights (right), shadows (left), and mid-tones (middle).  

The middle slider changes the intensity values of the middle range of tones without dramatically 

altering the highlights and shadows. The outer two-level sliders set the black point and white 

point of the image.  
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The Adjust Color Levels filter 

 

Adjust color balance  

The Color Balance filter changes the overall mixture of colors in an image for generalized color 

correction.  

To adjust the color balance, drag a slider toward a color that you want to increase in the image, 

or drag a slider away from a color you want to decrease in the image. Values range from -100 to 

+100.  

Invert photo negative  

The Invert Photo Negative filter inverts the colors of an image. This filter is useful for turning a 

positive image into a negative, or to make a positive from a scanned negative.  

 

 
The Invert Photo Negative filter 
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Preset enhancement  

This filter offers several one-click enhancements for your images. Select from the following: 

 

Color Cast  Images usually suffer from color casting if they have been shot using the wrong film 

type. For example, images shot under artificial light tend to have a yellow bias. This filter 

removes the yellowness of the image. 

 

Contrast/Brightness  The enhancement Backlight compensates for the effect of the subject 

being slightly backlit. The enhancement Under and Over Exposure adjusts the tonal range to 

compensate for the effect of an image being underexposed or overexposed. 

 

Subject  This category offers a set of options to adjust the skin tone of portrait photography and 

the color of objects in landscapes. 

 

Windows  Some filters are only available on the Windows version. In Windows, a filter from 

each group can be combined to provide a custom enhancement. 

Macintosh  On the Macintosh version, you can adjust the percentage of the filter that is being 

applied to the image by using the Levels slider. 

Auto Enhancement  

This filter is a one-click enhancement that combines several filters (including saturation, 

brightness, and contrast) to automatically produce an optimal image.  

 

Results vary, depending on the tonal range of the original image.  

 

 
The Auto Enhancement filter 
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Version control  

During the editing process, this feature is useful both for individuals and small workgroups to 

browse and track different versions of a file. This is useful as a backup, as well as to revert to or 

compare different versions of files.  

 

The Version Control folder maintains a log of the items added and removed from the folder, with 

the name of the original file and, the number and details of each version saved. When a catalog is 

closed, Expression Media automatically purges version control files for entries that have been 

removed from the catalog. The size of the folder will grow, depending on the size and number of 

copies of files. We recommend keeping the folder on a volume that has plenty of storage space. 

 

To use version control 

1. In the Image Editor panel (on the Window menu), click the Setup button. 

2. Navigate to the folder where you want to save backup copies of version-controlled files. 

Make sure that you use a separate folder for each catalog.  

3. Once you assign a version control folder to the catalog, you can begin to edit and back up 

media files. After you have edited an image, click the Save button in the Image Editor 

panel.  

4. In the Save dialog box, select the box Save in versions folder. Expression Media 

automatically assigns the current time and date, and then saves this data in the export log 

in the Version Control folder, together with an Expression Media-encoded backup copy 

of the file. You can examine and compare any backup version at any time by clicking the 

different versions in the list.  

5. Once you have at least one backup copy in the Version Control folder, you can choose 

whether to swap, replace, or delete backup images.  

To swap an image  

1. Select the image in the Media Versions section of the Image Editor panel, and then 

click the Exchange icon.  

2. In the subsequent dialog box, click Swap to switch places in the hierarchy with the 

current version being edited. Click Replace to delete the current version and replace it 

with the selected backup version. To delete the backup version, click the Delete icon. 

Note: If you choose Delete, this action cannot be undone. 

 

Expression Media also has version control support for image editing performed in other third-

party applications, such as Adobe Photoshop. For Expression Media to recognize these edits, you 

must have the Image Editor active and open the image file with the third-party editor by using 

the Open With Helper application menu. For more information on Helper applications, see 

―Helper applications‖ on page 116. 
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Chapter Twelve: 
 

Printing 
 

 

Expression Media provides a comprehensive solution for all of your image printing needs. In 

working with photos, you need flexibility in how you present hard copies of them for clients, for 

publication, or for storing.  

Printing modes 
Microsoft Expression Media offers three printing styles, Content List, Contact Sheet, and Media 

Sheet. These styles match the three views available in the program. The Print dialog box 

automatically defaults to match the active view of your catalog. The dialog box shows a real-

time preview of your prints. Expression Media displays each of your option changes in the 

preview window. 

 

Content List  This list is useful for printing a table of contents for a catalog. The style matches 

the layout of the catalog’s List View, with icons and associated field information of each file.  

This style also includes options for showing/hiding icons and field headers on the printout. The 

size of the icons in your catalog’s List View determines the size of the icons in the printout.  

 

 
Content List printing 

 

Contact Sheet  The contact sheet prints a table of thumbnails similar to your catalog’s 

Thumbnail View. The size of the thumbnail in your catalog determines the size of the thumbnail 

in the printout. 
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Thumbnails are imported into the catalog by using the file’s built-in thumbnail or by using 

images created by Expression Media. If your thumbnails are printing poorly, on the Action 

menu, click Rebuild Item. Then, try printing again.  

 

You can also select the Hi-Res Thumbnails option for quality printing. Selecting this option 

will send more image detail for every thumbnail to the printer, so allow extra time for printing. 

The printing speed is dependent on your computer’s processing power and the type of printer. 

 

 
Contact Sheet printing 

  

Media Sheet  Renders the full size, hi-resolution images from original files. Because some of 

these files can be quite large, allow extra time for printing. You can change the size of the 

displayed and printed media in the Scaling menu  in any view.  

 

The most useful of these options is Scale to Fit, as it automatically rescales the image to fit 

within the print area. Other useful options are Actual Size and Fit Width, but they might hide 

parts of the image when the size and shape of the original image is larger than the rendered area 

or printed cell size. 
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Media Sheet printing 

 
 

To print from Expression Media 

1. Do one of the following: 

 Select the image that you want to print.  

 If you want to print several images, select them and, on the Find menu, click Show 

Selected.  

2. On the File menu, click Print or click the Print icon on the toolbar. 

3. Select a print option from the Print menu. 

4. Depending on the options you choose, you will have varying options to choose from. See 

the following sections for explanations about each option. 

5. When you make your selections, click Print. 

 
To print a layer or page within a composite file 

1. Expression Media prints only the frame assigned as an item’s thumbnail. To print another 

layer or page, go to the page or layer you want to print in Media View.  

2. Before printing, on the Action menu, click Rebuild Item. 

3. On the File menu, click Print.  

4. Select your options, and then click Print. 

 

Global print options 

The options below are available regardless of the printing method you choose.  

 

Define the Print Area  This menu has options for full page, as well as CD and other disk cases, 

such as a Zip or Jaz disk. If you select Full Page, Expression Media uses the page size defined in 
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the Page Setup dialog box. The options will differ according to the type of the printer chosen. 

You can add custom print area templates to this menu. For more information, see ―Print 

templates‖ on page 142. 

 

Margins  Enables you to further adjust the Print Area Size on all sides. Select the Mirror 

Margins option to include spines for double-sided documents that will be bound or punch-holed. 

The border color around the preview image represents the margins that you define. 

 

Headers  Enables you to place a label on the top (header), bottom (footer), right and left sides of 

your printout, depending on which of the buttons you click on the right side of the text boxes. 

You can adjust the type and style of the labels by clicking the buttons on right side of the text 

boxes. On the Special menu, add automatic page numbers, date, and time. These are represented 

by their respective symbols in the caption’s box. You can mix the symbols with regular text. Use 

the Ampersand (&&) option to help differentiate the character from the special character 

commands. The Indent option aligns the label center or right. An Indent (&i) centers the text. 

Two indent marks makes the text flush right.  

 

Expression Media retains Header settings across all print styles. 

 

Grid (not available in Content List mode)  For contact sheets, this option defines the number of 

rows and columns for a printout. For media sheets, you can define how multiple copies of the 

same image, or different images, will be printed. The Default for view option takes into account 

the image size settings for the respective view of the catalog. The Cells option enables you to 

define the number of rows and columns. The Size option is similar to cells, but allows you to 

define the exact size of each cell. 

 

Use view colors  Mimics the style of the view corresponding to the printing mode that you 

choose. For example, if you chose to print using the Content List mode, then if you select this 

option, the dividers between the image listings will display in your printout. 

Corner crop marks  This option adds crop marks to the corners of the entire sheet. 

Page Preview Navigator If you are printing multiple pages, click the arrows to choose a page 

that will display in the preview section on the right side of the Print dialog box. 

Range  Modifies which pages will print. The default is to allow your printer’s dialog box to 

handle this function. You can also choose Current Page, or Odd or Even pages.  

Additional printing options in Contact Sheet mode 

Below are the options available if you choose Contact Sheet mode to print your photographs. 

  

Hi-Res Thumbnails  By default, Expression Media prints low resolution thumbnails. Select the 

box to print high-quality images. 

 

Print view fields  This option will enable you to print the text fields that are visible in 

Thumbnail View, in addition to the image. 
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Additional printing options in Content List mode 

Below are the options available if you choose Content List mode to print your photographs. 

 

Print label row  Prints the headers for each row. 

 

Print item icons  Prints the image icons at the size you specified in the List View options. 

Additional printing options in Media Sheet mode 

Below are the options available if you choose Media Sheet mode to print your photographs. 

Expression Media renders these prints from the original, hi-resolution images. Because these 

files might be large, allow extra time for printing. 

Margin between  Places a small amount of space between tiled images. 

Repeat media  Tile a single image in the available print area. Click the Grid button to define the 

number and size of the tiled images. 

Scaling  To define the image size, select one of the following options on the menu:  

 Actual Size  Uses 100% of the image and centers it in the Print Area. 

 Scale to Fit  Scales the image proportionally to the size of the Print Area. 

 Fit Width  Scales the image based on the horizontal parameters of the Print Area. If 

you apply this to a vertical image, some of it might not be visible. 

 Fit Height  Scales the image based on the vertical parameters of the Print Area. If 

you apply this option to a horizontal image, some of the image might not be visible. 

 Pin Smaller Side  Draws the image with its smaller side expanded to fit the screen. 

This option will fill the entire screen, but your image might be cropped. 

 Pin Larger Side  Draws the image with its larger side expanded or shrunk to fit the 

screen. 

 Tile  Tiles the image (in actual size) in the window. This option is helpful when you 

are printing patterns. 

 Percentages  Allows reduction or enlargement of the image from 25 percent to 2000 

percent. 

 Page selector  Use the UP and DOWN ARROWS to choose which page appears in 

the preview window on the right side of the dialog box.  

Print templates 
Expression Media lets you create printing templates to suit all your needs. These printing 

templates are text files and reside in the user-defined Plug-ins in the Print Templates folder. 

Printing templates allows you to define the specific size and position of the printing area on a 

page. It is made up of a line of text containing five values, each separated by a single space. 

 

Below is an example of how a line of text might read in the file, followed by explanations of 

each value: 
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Example value   -1 -1 342 339 px 

Value 1  Left margin 

Value 2  Top margin 

Value 3  Width 

Value 4  Height 

Value 5  Unit of measure. Acceptable units of measure are: in (inch), px (pixel), cm (centimeter), 

and mm (millimeter).  

 

Use a period or a comma as decimal separators. 

 

If the margin is set at -1, Expression Media centers the printing area with these margins. 

 

Example template for CD jewel case 

Following is an example of how to calculate values in order to create a template for a CD jewel 

case: 

 

The print area on the front of a standard CD jewel case is 120x120 mm. 

1. To center the image horizontally, place it (210-120) ÷ 2 = 45 mm on the right margin.  

2. To center the image vertically, place it (297-120) ÷ 2 = 88.5 mm on the left margin. For 

simplicity, we will use 80 mm. 

3. Therefore, the coordinates that you need for the CD case template are: 45 80 120 120 mm 

or -1 -1 120 120 mm. 

 
To create a template 

1. Create a text file with the proper order and number of values, as shown in the previous 

examples. Place the file in the Print Templates folder, located inside the Expression 

Media Plug-Ins folder. 

2. Select the image you want to print in Media View.  

3. Click the Print icon on the toolbar. 

4. Select the new template in the Print dialog box.  

5.  Select the options you want, and then click Print.  

PDF Maker 
This feature enables you to produce hi-resolution PDF files of any size and layout using the 

media in your catalog. The layout of the PDF can be completely customized. 

 

The high-resolution PDFs that you create are ideal for printing, but might be too large for 

distribution on the Internet. Currently, there are no options for customizing the compression of 

images in the PDF. Exported PDFs can be further customized by using a PDF editing 

application, such as Adobe Acrobat. 
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PDF Maker Layout window options 
1) X/Y coordinates; 2) Frame dimensions; 3) PDF page dimensions; 4) Use the Move tool to reposition 

frames; 5) Use the clone tool to duplicate a frame; 6) Use the create tool to add a new frame; 7) Delete tool;  8) 

Set page size menu; 9) Set page orientation menu; 10) Set display units menu; 11) Option sets menu; 12) Click 

Make to save and create the PDF. 
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PDF Maker Content window options 
1) Drag tool; 2) Zoom tool; 3) Rotate tool; 4) Clear tool 

 

To use PDF Maker 

1. On the Window menu, click PDF Maker. 

2. Define the layout by first displaying the Layout options. To display the Layout options, 

click the large button in the upper-right corner of the panel.  

3. Use the various option tools to define page size, orientation, and unit of measure. Use the 

layout tools to draw and move around boxes that will contain your media. Media 

locations are freeform and can even be overlapping. You can save various layouts for 

later recall by using the Options Sets menu. 

4. Once your layout is defined, change to the Content tool by clicking the large icon in the 

upper-right corner of the panel. Make sure that the text underneath the icon reads 

Content. 

5. Drag the media from your catalog to the PDF layout locations. When images are dropped 

into locations, they might need to be resized, rotated, or relocated using the tools in the 

dialog box. To remove an image from a box, use the Clear tool.  

6. Click Make to save and create the PDF. Larger images with higher resolution take more 

time to make. 

Printing to PDF (Macintosh OS X) 
On Macintosh OS X, you can print Expression Media catalogs to PDF format by using the 

system’s built-in printing functionality. Instead of actually printing a document, you use the 
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Print dialog box to export your catalog to a PDF. Before printing to PDF, prepare your 

document for printing. 

 
To print to PDF (Macintosh OS X)  

1. Prepare a document for printing, and then click the Print button.  

2. In the system Print dialog box, click Save As PDF. Type a name for the document, and 

then select where you want to save the PDF.  
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Appendix A: Keyboard Shortcuts 
 

Application/Edit Windows Macintosh 

Empty Trash  SHIFT+  

DELETE 

Preferences CTRL+ , (Comma ) , (comma) 

Media Rendering CTRL+SHIFT+ + ,  +SHIFT+ , 

Vocabulary Editor CTRL+ALT+,  OPTION+  , 

 
 

File menu Windows Macintosh 

New Catalog CTRL+N  N 

Close Catalog CTRL+W, CTRL+F4  W 

Open Catalog CTRL+O  O 

Catalog Finder CTRL+SHIFT+O SHIFT+  O 

Save Catalog CTRL+S   S 

Save As... CTRL+SHIFT+S SHIFT+ S 

Catalog Info CTRL+K  K 

Catalog Importers CTRL+ALT+K OPTION+ K 

Import from Files/Folders CTRL+I  I 

Import from Catalog File CTRL+ALT+I OPTION+ I 

Import from Spotlight Query  SHIFT+  I 

Import from Camera CTRL+ALT+U  U 

Import from Disk CTRL+ALT+U OPTION+ U 

Import from URL CTRL+SHIFT+U SHIFT+ U 

Print CTRL+P  P 

Page Setup CTRL+SHIFT+P SHIFT+ P 

Exit (Quit) ALT+F4, CTRL+Q  Q 

 

Edit menu Windows Macintosh 

Undo   Z 

Cut CTRL+X  X 

Copy CTRL+C  C 

Paste CTRL+V  V 

DELETE DELETE DELETE 

Select All CTRL+A  A 

Deselect All CTRL+D  D 

Custom Fields CTRL+SHIFT+D SHIFT+  D 

Add Terms CTRL+SHIFT+T SHIFT+ T 

Preferences CTRL+, (comma)  , (comma) 

Thumbnails and Previews  OPTION+  

T 
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Find menu Windows Macintosh 

Show All CTRL+E  E 

Show Hidden CTRL+ALT+E OPTION+ E 

Show Selected CTRL+SHIFT+E SHIFT+  E 

Hide Selected CTRL+ALT+SHIFT+E OPTION+SHIFT+ 

E 

Show Previous State CTRL+ALT+LEFT ARROW 

KEY 

 LEFT ARROW 

KEY 

Show Next State CTRL+ALT+RIGHT ARROW 

KEY 

 RIGHT ARROW 

KEY 

Find CTRL+F  F 

Find Next CTRL+ALT+F OPTION+ F 

Go To CTRL+G  G 

Go Again CTRL+ALT+G OPTION+ G 

 

View menu Windows Macintosh 

Light Table ALT+ENTER  / 

Actual Size/Scale to Fit CTRL+0  0 

Zoom In  CTRL+  + 

Zoom Out CTRL+–  – 

Rotate 90º CW CTRL+] ] 

Rotate 90º CCW CTRL+[  [ 

Move to Top CTRL+ALT+UP  UP ARROW 

KEY 

Move to Bottom CTRL+ALT+DOWN  DOWN ARROW 

KEY 

Move to New Catalog CTRL+ALT+N SHIFT+  N 

Move to Location CTRL+L  L 

Move Again CTRL+ ALT+L OPTION+ L 

Sort Again CTRL+ALT+; OPTION+ ; 

Invert Sort Order CTRL+; (semicolon)  ; 

 

Make menu Windows Macintosh 

Run Slide Show CTRL+R  R 

Slide Show Options CTRL+ALT+R OPTION+ R 

 

Other Windows Macintosh 

Assign star rating ALT+0-5 CTRL+0-5 

Assign color label 1-9; 0 to remove 1-9; 0 to remove 

Hide Microsoft Expression Media   H 

Hide Others  OPTION+  H 

 

Window menu Windows Macintosh 

Show/Hide Toolbar CTRL+T   T 

Switch Views  CTRL+1, CTRL+2, CTRL+3   1,  2,   3 
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Window menu Windows Macintosh 

(List, Thumbnail, Media) 

Show/Hide Panels 

(Info, Organize) 

CTRL+4,  CTRL+5   4,   5 

Show/Hide View Options CTRL+J  J 

Show/Hide Image Editor CTRL+ALT+J OPTION+   J 

Show/Hide Notepad CTRL+SHIFT+J SHIFT+ J 

 

Action menu  Windows Macintosh 

Rebuild Item CTRL+B  B 

Sync Annotations CTRL+ALT+B OPTION+B 

Clear Annotations CTRL+SHIFT+B SHIFT+ B 

Batch Rename CTRL+SHIFT+Z  Y 

Move to Recycle Bin (Trash) CTRL+DELETE   DELETE 

 

Light Table shortcuts 

Keyboard shortcuts 

Light Table function  Windows Macintosh 

Launch Light Table ALT+ENTER  / 

Exit Light Table ESC, Double-click ESC, Double-click or  

+PERIOD 

Previous image LEFT ARROW LEFT ARROW 

Next image RIGHT ARROW RIGHT ARROW 

Previous/Next group of images UP ARROW/DOWN ARROW  

PAGE UP/PAGE DOWN 

UP ARROW/DOWN 

ARROW  PAGE 

UP/PAGE DOWN 

Move active cell under the mouse 

to first or last visible catalog item 

HOME, END key HOME, END key 

Add/Remove panel to Light Table 

(up to 6 panels) 

CTRL+ PLUS key; CTRL– 

(MINUS key) 

CTRL + (PLUS key); 

CTRL – (MINUS key) 

Assign color label 1 - 9; 0 to remove label 1 - 9; 0 to remove label 

Assign star rating ALT+1-5; 0 to remove rating CTRL+1-5; 0 to remove 

rating 

Zoom in to the next available size 

option 

+ (PLUS key) Increase + (PLUS key) Increase 

Zoom out to the previous 

available size option 

– (MINUS key) Decrease – (MINUS key) 

Decrease 

Set Orientation: 90º Clockwise 

(this is a soft rotation) 

CTRL+]  ] 

Set Orientation: 90º Counter-

Clockwise (this is a soft rotation) 

CTRL+[  [ 

Move displayed item to 

Trash/Recycle Bin 

CTRL + DELETE  DELETE 
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Light Table function  Windows Macintosh 

Remove displayed item from 

Catalog 

DELETE DELETE 

Histogram - Toggle display H H 

Exposure Warnings - Toggle 

display 

W W 

Tools - Toggle display T, ENTER, RETURN T, ENTER, RETURN 

Magnifier - Toggle display M M 

Scroll Lock (simultaneous 

scrolling of all images) 

S S 

Layout: Grid G G 

Layout: Landscape L L 

Layout: Portrait P P 

 

Mouse shortcuts 
 

Light Table function Windows Macintosh 

Click to position image. Use 

SCROLL LOCK to position 

images simultaneously. 

Click (Normal mode) Click (Normal mode) 

Display settings menu Right-click, F1- Help/Shortcuts CTRL + Click; Right-

click 

 

Slide Show shortcuts 

Keyboard shortcuts 
 

Slide Show function Windows Macintosh 

Launch slide show CTRL+R  R 

Exit slide show ESC ESC 

Show/Hide slide show controller 

When the controller is hidden, 

the mouse cursor is also hidden. 

ENTER or RETURN ENTER or RETURN 

Start/Stop slide show SPACEBAR SPACEBAR 

Display the next media file. 

The next media file is always 

displayed, even in Random 

mode.  

RIGHT or DOWN ARROW RIGHT or DOWN 

ARROW 

Display the previous media file.  

The previous media file is 

always displayed, even in 

Random mode.  

LEFT or UP ARROW LEFT or UP  ARROW 

Move to next frame of a movie. CTRL + RIGHT or DOWN OPTION+ RIGHT or 
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Step through frames while slide 

show is paused.  

ARROW DOWN ARROW 

Move to previous frame. Step 

through movie frames while 

slide show is paused.  

CTRL + LEFT or UP ARROW OPTION+ + LEFT or UP 

ARROW 

Jump to the last frame of the 

movie. 

SHIFT+CTRL+RIGHT/DOWN 

ARROW 

SHIFT+ 

OPTION+RIGHT/DOWN 

ARROW 

Jump to the first frame of the 

movie. 

SHIFT+ +CTRL + LEFT or UP 

ARROW 

SHIFT+ OPTION + 

LEFT or UP ARROW 

Zoom in to the next available 

size option. 

+ (PLUS key) Increase + (PLUS key) Increase 

Zoom out to the previous 

available size option. 

– (MINUS key) Decrease – (MINUS key) Decrease 

Toggle scale of images between 

Scale to fit and Actual Size. 

CTRL+0  0 

Change display to the next 

available grid option. 

d d 

Change display to the previous 

available grid option. 

SHIFT + D SHIFT+ D 

Set/Unset Slide Show to 

Interactive mode. If slide show 

is in interactive mode, you can 

use the arrow keys or mouse to 

move forward or backward. 

I or i  (case insensitive) I or i  (case insensitive) 

Set/unset slide show to 

Continuous (Loop) mode. 

L or l  (case insensitive) L or l  (case insensitive) 

Set/unset slide show to Random 

mode. Random mode uses all 

available media items once 

before repeating media. 

R or r (case insensitive) R or r (case insensitive) 

Turn multi-sound mode on or 

off. This is useful when playing 

multiple movies at once. When 

it is off, you will hear audio 

from the active movie only. 

M or m (case insensitive) M or m (case insensitive) 

Change the active media item to 

the next item in the grid (Multi-

grid mode). It will reset the slide 

show audio and swap 

information displayed in the info 

panel. Changing the active item 

also changes the order at which 

items are loaded. 

TAB TAB 

Assign a color label to active 

media item. This label will 

Number keys 1-9 

0 (zero) to Remove 

Number keys 1-9 

0 (zero) to Remove 
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apply to all views in the catalog. 

Use the slide show controller to 

check/show/hide labeled items. 

Assign a star rating to active 

media item 

ALT+1-5; 0 (zero) to remove CTRL+1-5; 0 (zero) to 

remove 

 

Mouse shortcuts 
 

Slide Show function Windows Macintosh 

Run/Pause slide show. Click (Continuous mode) Click (Continuous 

mode) 

Load next slide. Click (Interactive mode) Click (Interactive mode) 

Load previous slide. SHIFT + Click 

(Interactive mode) 

SHIFT + Click 

(Interactive mode) 

Drag media in grid cell.  This 

takes effect only if the displayed 

media is clipped, (i.e. larger than 

the grid cell size). 

ALT + Click OPTION+ Click 

Exit slide show. Double-click Double-click 
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Appendix B: Supported File Formats 
 

Image File Formats 

File format Extension Windows Macintosh 

Adobe Photoshop  8BPS, PSD   

Alias Pix † ALS, APIX   

AppleWorks ‡ CWPT, CWGR   

BMP  BMP, BMPf, 

BMPp, DIB 

  

Canon Raw  CRW, CR2   

Corel Draw  CRD   

Digital Negative Raw †* DNG   

FlashPix Image  FPX, FPix   

Fractal Design Painter ‡ RIFF   

Fuji Raw † RAF   

GE Medical CRI  CRI   

Genuine Fractals ‡ BIN, STN, STNG   

JacqCAD  Expn   

JPEG  JPEG, .JPG, .JPE   

JPEG 2000  JP2, .jp2   

Kodak PhotoCD  kpcd, PCDI, PCD   

Kodak Raw  DCR   

Leaf Valeo Raw † MOS   

Leica/Panaonic Raw † RAW   

Live Picture ‡ FIT2   

Macintosh icon  ICN, ICNS, Icon   

Macintosh Paint  MACINTOSH, 

PNTG 

  

Minolta Raw †* MRW   

Nikon Raw  NEF   

Olympus Raw †* ORF   

Pentax Raw † PEF   

Picture  PCT, PIC, PICT   

Picture Clipping  clpp   

PNG  PNG, PNGf   

QuickTime Image  QIF, QTI, QTIF   

Seattle Filmworks  SFWI, SFW   

SGI  SGI   

Sigma Raw † X3F   

Sinar/Mamiya Raw † STI   

Sony Raw †* SRF   
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File format Extension Windows Macintosh 

Startup Screen  SCRN   

TGA  TGA, TPIC   

TIFF  TIF, TIFF, DCB, 

FAX, RICH 

  

Windows Icon  ICO   

 

† Importer renders preview only 

†* Can be fully rendered on Macintosh OS 10.4.2 and higher 

‡ User-defined importer 

Image Export formats  SGI, Photoshop, BMP, JPEG, JPEG 2000 (Macintosh), Macintosh 

Paint, PICT, PNG, QuickTime Image, TGA, TIFF 

Audio File Formats (Import) 

File format Extension Windows Macintosh 

AIFC AIFC   

AIFF AIF, AIFF   

AMF Movie Importer M4A, M4B, M4P, 

M4V 

  

AMR AMR   

AU AU, SND, ULAW, 

ULW 

  

Audio Data Transport Stream ACC, ADTS   

CAF (CoreAudio File) CAF, caff   

Compact Disc Audio 

(AIFF) 

CDDA   

 

File format Extension Windows Macintosh 

GSM Audio GSM   

MP3 MP3, MPG3, MPA, 

PLAY, SWA, SwaT 

  

Sound Designer II SD2, Sd2f   

Standard MIDI MID, Midi, SMF   

System Sound sfil   

Wave BWF, WAV, WAVE   

Windows Media Audio WMA  * 

 

*Supported using Flip4Macintosh QuickTime plug-in 

Audio Export formats: AIFF, AU, Wave 
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Video file formats (Import) 

File format Extension Windows Macintosh 

MPEG MPG, MPEG, 

MPG1, MPG2, 

M1V, M2V, 

MP2, MP2V, 

MPE, MPV2 

  

MPEG-4 MP4, mpg4   

Ogg Vorbis Media File OGM   

Quartz Composer QTZ   

QuickTime Movie MOV, MooV   

Standard MIDI KAR, MID, 

MIDI, SMF 

  

Windows Media AV WM   

Windows Media ASF   

Windows Media Video WMV, WMP  * 

3GP2 3G2, 3gp2   

3GPP Movie 3GP, 3gpp, SDV   

AMC AMC   

AMF movie importer M4V   

Animated GIF GIF, GIFF   

AutoDesk Animator CEL, FLC, FLI   

AVI VFW   

DivX Movie AVI, DAVI, 

DIVX 

  

DV DIF, DV, dvc!   

DVD Video Movie File VOB   

 * Requires Flip4Macintosh QuickTime plug-in 

 + Requires Xiph QuickTime plug-in  

Video Export formats: 3G, AVI, DV Stream, FLC, Image Sequence, MPEG-4, QuickTime 

Movie 

 

DTP file formats (Import) 
 

File format Extension Windows Macintosh 

Adobe Acrobat  PDF   

Adobe PageMaker ‡ ALB6, AB65   

AppleWorks † CWWP   

Microsoft Excel † XLS, XLT   

Microsoft PowerPoint † PPT, POT   

Microsoft Word † DOC, DOT, W8BN, 

DOCX 

  

MultiAd Creator † Crtr, CRTR   
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File format Extension Windows Macintosh 

RTF (Rich Text Format)  RTF, RTFD   

WordPerfect ‡ WPD   

† Importer renders preview only  

‡ User-defined importer 

Text, font, and Web file formats (Import) 
 

File format Extension Windows Macintosh 

Text TEXT, TXT, ttro   

Text Clipping clpt   

Font - True Type FFIL, TFIL, TTF, TTC, SFNT   

Font - Open Type OTF   

Font - Suitcase Font DFNT   

Active Server Page ASP   

HTML Document HTML, HTM   

HTML Archive MHT   

PHP Document PHP   

Web Archive AWEB   

XML Document XML   

 

Illustration file formats (Import) 
File format Extension Windows Macintosh 

Adobe Illustrator 

(version 8 only) 

 AI   

AppleWorks ‡ CWGR   

Canvas ‡ drwX, drw9, drw8, drw7, drw6, drw5, 

CNV, CVX 

  

CorelDRAW † CDR*   

Macintosh Adobe  

Freehand 

† AG*, FH*   

Microsoft Expression 

Design 

 DESIGN   

Postscript  EPSF, EPSP, EPS, PS   

PowerCADD ‡ Pd%4   

Windows Metafile  EMF, WMF   

†  Importer renders preview only 

‡  User-defined importer 

 

Note: The capacity of Expression Media to import certain file types is dependent on your having 

the most current version of Apple QuickTime installed on your computer. 
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Appendix C: Annotation Mapping 
 

Expression Media supports a set of pre-defined fields for annotating your media files. This set 

(also known as the IPTC/XMP Core) enables you to define metadata for your media files, such 

as Creator, Date Created, Location, and Copyright. 

 

These annotation standards have been defined by the International Press and 

Telecommunications Council (IPTC) and the Newspaper Association of America (NAA). Adobe 

uses this standard, in part to define the XMP metadata standard.  

 

Expression Media also supports metadata defined by Apple QuickTime. To simplify annotating 

media, and prevent multiple sets of annotations for each standard, Expression Media has mapped 

the QuickTime annotation fields to the IPTC fields. 

 

The following table lists the field names used by Expression Media, along with their 

corresponding names in the IPTC and QuickTime standards, as well as in Photoshop. Because 

the names of each annotation are not integrated into the data, other applications might refer to an 

annotation by a different name.  

 

In Expression Media, you can choose which field names to display in the Info and Organize 

panels. In the General Preferences dialog box, choose from either the official IPTC Core names, 

those names used in Expression Media or those used in Photoshop. 

 

Expression 

Media 

Photoshop CS 

& CS2 

IPTC/XMP 

Core 

QuickTime Aperture 

Label  Urgency Label - - 

Title Headline Headline Title | Song 

Name (mp3) 

Headline 

Product Document Title Title Product | Album 

(mp3) 

Object Name 

Genre Category People - Category 

Intellectual 

Genre 

Intellectual 

Genre 

Intellectual 

Genre 

Genre - 

Event Event + Event Description Fixture Identifier 

Event Date Date Created Date Created Creation Date Date Created 

Author Author Creator Author / 

Original Artist / 

Artist (mp3) 

Byline 

Credit  Credit Provider Producer Credit 

Source Source Source Original Source Source 

Copyright Copyright  Copyright  Copyright Copyright  

Transmission Transmission 

Reference 

Job Identifier - Original Transmission 

Reference 
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Expression 

Media 

Photoshop CS 

& CS2 

IPTC/XMP 

Core 

QuickTime Aperture 

Rights Usage 

Terms 

Rights Usage 

Terms 

Rights Usage 

Terms 

Warning - 

URL Copyright Info 

URL 

URL URL Link - 

Location  Location Location - Sublocation 

City City City  - City 

State State/Province State/Province - State/Province 

Country Country Country - Country / 

PrimaryLocationName 

ISO Country 

Code 

ISO Country 

Code 

ISO Country 

Code 

- - 

Instructions Instructions Instructions Playback 

Requirements 

Special Instructions 

Status  Status + Status Disclaimer Edit Status 

Writer Description 

Writer 

Description 

Writer 

Writer Writer/Editor 

People *  People + People * Performers Contact 

Categories * Supplemental 

Categories * 

Supplemental 

Categories * 

- Supplemental Category 

Keywords * Keywords * Keyword * Keywords Keywords 

Scenes * Scenes * Scenes * - - 

Subject Codes 

* 

Subject Codes * Subject Codes * - - 

Caption Description Description  Comment Caption 

 

* Supports multiple entries in field; + Supported in Photoshop CS & CS2 through plug-ins 

For additional information about IPTC/XMP metadata, refer to the official IPTC Web site. 

 

IPTC annotation definitions 

Below are the official definitions for IPTC Core annotation fields. For additional information 

about the IPTC metadata standard, refer to the IPTC Web site. 

 

Headline  A publishable entry providing a synopsis of the contents of the item. Headline is not 

the same as Title. 

 

Title  A shorthand reference for the item. While a technical identifier goes to an identifier 

element, Title holds a short verbal and human readable name. Title is not the same as Headline. 

 

Intellectual Genre  Describes the nature, intellectual, or journalistic characteristic of an item, 

not specifically its content. 
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Date Created  Designates the date and optionally the time the intellectual content of the item 

was created rather than the date of the creation of the physical representation. If no time is given, 

the value should default to 00:00:00. 

 

Creator  Contains preferably the name of the person who created the content of this item, a 

photographer for photographs, a graphic artist for graphics, or a writer for textual news. If it is 

not appropriate to add the name of a person, the name of a company or organization could be 

applied as well. 

 

Provider  Identifies the provider of the item, who is not necessarily the owner/creator. 

 

Source  Identifies the original owner of the copyright for the intellectual content of the item. 

This could be an agency, a member of an agency, or an individual. Source could be different 

from Creator and from the entities in the Copyright. 

 

Copyright Notice  Contains any necessary copyright notice for claiming the intellectual property 

for this item and should identify the current owner of the copyright for the item. Other entities, 

such as the creator of the item may be added. Notes on usage rights should be provided in 

―Rights Usage Terms.‖ 

 

Job Identifier  Number or identifier for the purpose of improved workflow handling. This 

identifier should be added by the creator or provider for transmission and routing purposes only, 

and should have no significance for archiving. 

Rights Usage Terms  Free text instructions on how this item can be used legally. 

 

Location  Name of a location on which the content is focusing–either the location shown in 

visual media or referenced by text or audio media. This location name could either be the name 

of a sub-location of a city or the name of a well known location or (natural) monument outside a 

city. In the sense of a sub-location to a city, this element is at the fourth level of a top-down 

geographical hierarchy. 

 

City  Name of the city on which the content is focusing on–either the place shown in visual 

media or referenced by text or audio media. This element is at the third level of a top-down 

geographical hierarchy. 

 

Province/State  Name of the subregion of a country–either called province or state–on which is 

the content focusing–either the subregion shown in visual media or referenced by text or audio 

media. This element is at the second level of a top-down geographical hierarchy. 

 

Country  Full name of the country on which the content is focusing–either the country shown in 

visual media or referenced in text or audio media. This element is at the top/first level of a top-

down geographical hierarchy. The full name should be expressed as a verbal name and not as a 

code. A code should go to the element ―Country Code.‖ 

 

Country Code  Code of the country on which the content is focused–either the country shown in 

visual media or referenced in text or audio media. This element is at the top/first level of a top-
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down geographical hierarchy. The code should be taken from ISO 3166 two or three letter code. 

The full name of a country should go to the ―Country‖ element. 

 

Instructions  Any of a number of instructions from the provider or creator to the receiver of the 

news object that might include any of the following: embargoes (NewsMagazines OUT) and 

other restrictions not covered by the ―Rights Usage Terms‖ field; information regarding the 

original means of capture (scanning notes, colourspace info) or other specific text information 

that the user might need for accurate reproduction; additional permissions or credits required 

when publishing. 

 

Description writer  Identifier or the name of the person involved in writing, editing, or 

correcting the description of the item. 

 

Keywords  Keywords to express the subject of the content. Keywords may be free text and do 

not need to be taken from a controlled vocabulary. Values from the controlled vocabulary IPTC 

Subject Codes must go to the ―Subject Code‖ element. 

 

Scenes  Describes the scene of a photo content. Specifies one or more terms from the IPTC 

―Scene-NewsCodes.‖ Each Scene is represented as a string of 6 digits in an unordered list. 

 

Subject Codes  Specifies one or more Subjects from the IPTC ―Subject-News Codes‖ taxonomy 

to categorize the content. Each Subject is represented as a string of 8 digits in an unordered list. 

 

Description  A textual description, including captions, of the item’s content, particularly used 

where the object is not text. 
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Appendix D:  Camera Raw Formats 

 
Supported 

Raw Formats 

File 

Extension 

Rendering Engines Display 

Previews3 

Embed 

Metadata 
Apple1  Manuf.2 

Canon CRW, CR2, TIF    7 

Digital Negative DNG     

Fuji RAF     

Kodak DCR     

Leaf Valeo MOS     

Leica/Panasonic RAW   6  

Minolta  MRW     

Nikon NEF     

Olympus ORF  4 4  

Pentax PEF     

Sigma X3F   5  

Sinar/Mamiya STI     

Sony SRF     

 

1 The Apple engine is available only on Macintosh OS 10.4.2 or higher. 

2 The manufacturer rendering engine is automatically used on Windows and all Macintosh (prior to 10.4.2) operating systems. 

3 Preview size depends on the make and model of the camera. 

4 Preview or Raw image is used depending on the model of the Olympus camera. For older models, where the Raw image is 

shown, colors might vary. We recommend using the trial period of Expression Media to assess the results for your camera. 

5 Thumbnail only. 

6  Rendered with open source DCRaw engine. 

7 CR2 format only. 

Special notes on Expression Media’s handling and support of Raw file formats: 

Rendering Preferences  Most Raw image files can contain a large preview that is suitable for 

viewing and renders much faster than decoding the raw data. If you select the Use embedded 

preview option, this will speed up import and media rendering of Raw files.  

Otherwise, Expression Media will need to decode the Raw data in order to display the Raw files.  

Image File Conversion  Despite which Raw format you start with, if you choose the Convert 

Image Files command (Action menu), Expression Media will convert the embedded JPEG 

preview, and not the Raw file. For example, if you convert a Nikon Raw image (NEF), 

Expression Media will convert the embedded JPEG preview to your new specifications. 

Metadata support  Expression Media can import metadata for all Raw formats, even files with 

XMP sidecars. However, Expression Media can embed/write metadata into these Raw formats: 

Nikon, Kodak, DNG, and Canon CR2 files. Expression Media will not write annotations in other 

Raw formats. 
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Appendix E: Troubleshooting 

Basic troubleshooting 

Make sure that you have installed the following software: 

 The latest version of Expression Media from our site: 

http://go.microsoft.com/fwlink/?LinkID=82546 

To check for updates, choose Welcome Screen on the Help menu. If an update is 

available, a link will be provided for you to download it. On the Macintosh, Check for 

Updates is located in Application menu in About Expression Media. 

 The latest version of QuickTime from Apple’s Web site. 

 Windows users should keep up to date with the latest service packs and drivers for their 

operating system. Use the Windows Update command on the Start menu to download 

and install the latest updates. 

  If you are working in Version 3 with catalogs created by older versions of Expression 

Media (such as 1.x or 2.x) and Expression Media starts behaving in odd ways, such as 

functions stop working, try this: 

a. Copy all of your files into a new catalog.  

b. Select all of the items in the catalog, and on the Edit menu, click Select All.  

c. On the View menu, click Move to New Catalog.  

This creates a new catalog with all the media items and metadata.  

d. Save the catalog, and then test the problematic function.  

 Macintosh users can solve problems by deleting the Expression Media preferences in the 

system’s Preferences folder (~User/Library/Preferences/Expression Media Settings).  

Note: Expression Media should not be running while this is being done. 

By default, Expression Media imports thumbnails that have been embedded into the file by other 

programs or devices. This makes Expression Media very fast when importing media, but 

embedded thumbnails might look blurry or pixilated. To improve thumbnail quality, select the 

item, and then, on the Action menu, choose Rebuild Item. 

Transition effects do not appear to work in slide shows exported as a QuickTime 
movie. 

If you are using video compression, make sure that your frame rate is higher than 1 frame per 

second (fps). If there is no value in the QuickTime Compression Settings dialog box, fps 

defaults to 1, and you not get any effect because the effect lasts for only one second. 

 

Photoshop troubleshooting 

Why can’t I use Photoshop CS as a Helper application? (Macintosh) 

http://go.microsoft.com/fwlink/?LinkID=82546
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There can be a problem with any application, including Microsoft Expression Media, which tries 

to use Photoshop CS as a Helper application. Photoshop CS will start, but the selected images 

will not open. The solution is to reinstall Photoshop. You might find other answers by searching 

Adobe’s support Web site. 

This layered Photoshop file was not saved with a composite image. 

If an imported Photoshop image displays this message in Expression Media, ―This layered 

Photoshop file was not saved with a composite image,‖ the PSD file was not saved with 

Maximize Compatibility selected. This can be fixed in the following two ways: 

 When saving files in Photoshop, make sure the Maximize Compatibility option is 

selected. 

 To save PSD files automatically with maximum compatibility, in Photoshop’s File 

Handling dialog box on the Preferences menu, set the Maximize PSD File 

Compatibility menu to Always. 

Alpha channel in Photoshop file incorrectly displayed (typically yellow). 

Some Photoshop documents with alpha channels can be incorrectly displayed. Expression Media 

sometimes interprets the alpha channel as a transparent layer. Expression Media displays 

transparencies as a specific color and by default this is yellow. 

 

To correct this problem, select the Use Alpha Channel setting by clicking the Edit menu, 

pointing to Preferences, clicking Media Rendering, and then clicking the Images tab. 

All newly imported Photoshop files will be displayed properly. To correct existing thumbnail 

images, select them and choose Rebuild Item from the Action menu. 

Common Error Messages 

No importer found  This error message appears when Expression Media cannot display or 

render a particular file type. Try upgrading to the latest version of QuickTime. 

  

Volume not mounted  Expression Media needs access to the actual file in order to display it on 

the screen in Media View or Slide Shows. This error is displayed when Expression Media cannot 

find the media storage device or disk on which the file is stored. Mounting the disk should solve 

the problem. 

  

Web resources 

Customer Support  If you have additional questions, make sure you check the documentation 

and the community forum. If you still can’t find an answer, see our online Web site at 

http://go.microsoft.com/fwlink/?LinkID=82546 

 

http://go.microsoft.com/fwlink/?LinkID=82546

